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Introduction

Metalogix Archive Manager for Exchange provides the most flexible and effective way to collect,
archive, search and secure all you organization’s email from one central location. You can control
the retention policy of archived emails by moving emails to inexpensive locations as their
relevance changes with the option to delete old messages unless they are on legal hold. With
robust version control, any previous version of an archived email can be restored at any time
along with its attachments. Metalogix Archive Manager for Exchange also offers online
management of archived emails, as well as mobile and offline email access to users on the road.

The primary features of Metalogix Archive Manager for Exchange and HSM are as follows:

¢ Archive Manager for Exchange - email archiving engine that includes the windows services and
the Archive Manager for Exchange Administration Center (AMAC). Archive Manager for
Exchange has the following components:

o Application Server - contains the core functionality of the Archive manager for Exchange.

o Administrative tool - installs the Archive Manager for Exchange Administration Center
(AMAC). The AMAC can be installed as a standalone application on other computers as well
and allows several administrators to manage Metalogix Archive Manager for Exchange
deployment.

o PST Importer - installer files for the PST Importer feature which import and archives emails
from PST files. PST Importer can be set up to work with the PST Gatherer feature that runs
either as an application or a service. It assists users with gathering PST files that are stored in
distributed locations like network shares in addition to local drives.

o Forms Installer - installer files and template which are used to publish Archive Manager forms
to the Organizational Forms Library or the Personal Forms Library. It can only be used on a
computer where Outlook is running.

o Auditing - allows administrators to log defined user actions in the email archive like
archiving, retrieving, restoring and search history that were initiated from Outlook or
ArchiveWeb. This feature can be installed on the Archive Manager for Exchange server or on
a separate machine.

o Monitoring service - Monitors other Archive Manager services and alerts the administrator via
notification email if necessary. Notification emails are sent only if an error occurs.

o Documentation - Offline documentation about the product.

e Hierarchical Storage Manager (HSM) - a data storage system for managing your email archive
store as well as all company data on one or more file-servers. HSM ensures that files with
identical content are stored only once regardless of where the original file is located.

The following optional features are integrated with the Metalogix Archive Manager for Exchange
product installer:
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e Archive Manager Search - full text search engine capable of searching archived emails.

e Archive Manager ArchiveWeb - online archive interface with advanced search and reporting
functionality.

The following optional features are included as separate installers in the download package:

o Archive Manager for Exchange OWA Extension - feature that is installed on the Microsoft
Exchange Server to provide Outlook Web Access (OWA) for archived emails to end-users.

o Archive Manager Universal Access - allows mobile users, Mac users and Linux users to work
with archived emails.

e Archive Manager SMTP Service - enables processing of messages from an external email server
(0365, Gmail, Exchange, etc.) into Metalogix Archive Manager for Exchange.

e Archive Manager Outlook Addin - gives authorized users the ability to archive and restore
emails with the Outlook desktop client.

e Archive Manager PST Gatherer Setup - automated extension to PST importer.

This advanced install guide describes the installation of the primary features of Metalogix
Archive Manager for Exchange in a distributed environment. To enable load balancing and
redundancy for large email volumes, Metalogix Archive Manager provides you with the ability to
configure several Archive Manager servers. You can add additional features as required.

About the email archive and retrieval process

When emails are archived, Metalogix Archive Manager for Exchange uses shortcuts to replace
archived emails in the on-premise or online Microsoft Exchange mailboxes. Email shortcuts
require very little space, reducing your email storage by up to 80% and email backup time by 50%.
Messages remain available to end-users who can work with them as usual. This helps your end-
users access all their data while reducing the need to set mailbox quotas and removing the
dependency on PST files.

When a user clicks a shortcut to an archived email, Archive Manager for Exchange passes the
information from the shortcut to HSM which restores the email from the store.

HSM uses the Single-instance storage (SIS) service that takes multiple copies of the content and
replaces them with a single shared copy. It enables version control, eliminates data duplication,
and increases storage and retrieval efficiency.
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System Requirements

The requirements described below are applicable for installing the Metalogix Archive Manager
for Exchange application components, and are compatible with the following Microsoft Exchange
servers:

e Microsoft Exchange Server 2013
e Microsoft Exchange Server 2016
e Microsoft Exchange Server 2019

e Microsoft Office365 (Exchange Online)

1 | NOTE: System requirements for optional components of the Metalogix Archive Manager
for Exchange are described in the corresponding document for each optional component.

Hardware

Component Minimum specification Recommended specification
Number of Processor Cores 4 8

Main Memory 4GB 12GB

Hard Disk 10GB 10GB

NOTE: The application, log files and cache folders require 10 GB of HDD space. If the
Archive Manager for Exchange server includes the database, and is used as a local storage
for archived messages as well, then the the Hard Disk size must be revised upwards to add
more space for the database and the file store.

Operating System
e Windows Server 2012

e Windows Server 2012 R2
e Windows Server 2016

e Windows Server 2019

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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1 | NOTE: Latest updates and service packs for servers are recommended.

Windows Server Roles
e Web Server (I1S)
o Web Server >Common HTTP Features >HTTP Redirection
o Web Server > Performance > Dynamic Content Compression
o Web Server > Security > Basic Authentication
o Web Server > Security > Windows Authentication
o Web Server > Application Development
= NET Extensibility 3.5
= NET Extensibility 4.5 or later
= ASP.NET 3.5
= ASP.NET 4.5 or later
o Management Tools > 1IS 6 Management Console
o Management Tools > 1IS 6 Management Compatibility > IIS 6 Metabase Compatibility

o Management Tools > Management Service
Windows Features

e Remote Server Administration Tools

o Role Administration Tools >AD DS and AD LDS Tool > Active Directory module for Windows
PowerShell

1 | NOTE: Ensure that PowerShell can communicate between the Archive Manager server
and the Exchange server and between the Archive Manager server and the domain
controller

o .NET Framework 3.5 Features

For Windows Server 2012 and 2012 R2

e .NET Framework 4.5 Features >.NET Framework 4.5

o .NET Framework 4.5 Features > ASP.NET 4.5

e NET Framework 4.5 Features > WCF Services (all checkboxes under this item)
For Windows Server 2016

e .NET Framework 4.6 Features >.NET Framework 4.6

e .NET Framework 4.6 Features > ASP.NET 4.6
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e NET Framework 4.6 Features > WCF Services (all checkboxes under this item)
For Windows Server 2019

o .NET Framework 4.7 Features > .NET Framework 4.7

o .NET Framework 4.7 Features > ASP.NET 4.7

e NET Framework 4.7 Features > WCF Services (all checkboxes under this item)

Redistributable packages
o Microsoft Visual C++ 2017 Redistributable Package (x64)

e Microsoft Visual C++ 2017 Redistributable Package (x86)

Microsoft Outlook

The table below identifies the mail clients that are supported for use together with each version
of Exchange. Supported clients are identified by a check mark (v')

Client Exchange 2019 Exchange 2016 Exchange 2013 SP1
and later
Office 365 v v v
Outlook 2019 (32-bit) v v v
Outlook 2016 (32-bit) vl vl ¥
Outlook 2013 (32-bit) 7 vl v

1 | NOTE: 1- Supported with the latest Office service pack and public updates.

Database Servers and Drivers

e Microsoft SQL Server 2012 to Microsoft SQL Server 2019
o Microsoft OLE DB Driver 18 for SQL Server, or newer

e Oracle 12cto Oracle 19¢c

o Oracle client (x86 or x64)

Web Browsers

Web browsers are required for ArchiveWeb and is included here because this optional
component is installed automatically if Express installation is considered.
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Microsoft Internet Explorer 10 or higher

Microsoft Edge

Mozilla Firefox 16 or higher

Chrome 33 or higher

Opera 12 or higher

Additional Information

o Installation of Metalogix Archive Manager application components on a Microsoft Exchange
Server or Domain Controller are not supported.

e The software installs web applications in the Default Web Site. This could cause conflict with
other applications like Microsoft CRM or Microsoft SharePoint. To change the installation
website, manual changes are required after the installation. Please contact Technical support
in such cases.

e Metalogix Archive Manager for Exchange is fully supported in a virtualized environment.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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Deployment Plan

The advanced installation of Metalogix Archive Manager for Exchange is used by large
organizations that deploy a distributed server topology to increase the efficiency and throughput
of email archival and retrieval. In the illustration below, a conceptual distributed deployment
planis presented in a single domain called democorp.com that is managed by a domain controller
labeled AMXDC.

In this domain, there is a singled on-premise Microsoft Exchange server labeled AMXEXCH that
manages the communication for all users and groups in the domain. Users have access to an
online Exchange server (0365) as well, labeled democorp.onmicrosoft.com that has a separate
active directory which may or may not be integrated with the on-premise active directory. An
optional feature called Archive Manager for OWA Extension can be installed on the on-premise
Exchange server so that users can view regular and archived emails online.

The servers that comprise the distributed topology of Metalogix Archive Manager for Exchange
are labeled for ease of reference, and will be used throughout this guide to describe the
preparation, installation, configuration, and verification of the deployment.

DEMOCORP.COM

Archive Manager for Exchange
[Archive Server)
AMYSERVER-A

Archive Manager Databaze

On-premise Exchange AMXDB

Domain Controller Server = Application Server
AMXDC AMXEXCH * PSTImporter ] MAMAUDIT
= Administrative Tocls . ] MAMEXCH
_ = FormsInstaller ] MAMHSM
* Auditing - ] MAMINDEX
= Monitoring ] MAMSEARCH
A = Documentation [ MAMUSER
_,r'.. ._\..
I A
\
Active Directory
* Application Server Archive Manager Search
* Administrative Tools N
HEM
USER — .
%. semmmmEs * HDD or Network Share
EEEEEEERESR

= SAN, NAS
= MNetipp, Jukebox, etc.

AMXSERVER-R
Archive Manager for Exchange
(Retrisve Server)

ANMXHIM
H5M and Search server

B

Online Exchange Server (0365
DEMOCORP.ONMICROSOFT.COM

Figure 1. Topology for a distributed deployment of Metalogix Archive Manager for Exchange
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The roles of the different servers are explained below:

AMXDB

This is a dedicated database server that hosts the various databases that are used by the
Metalogix Archive Manager for Exchange features to manage the archival and retrieval of emails.
A single database server can host all the databases used by Metalogix Archive Manager for
Exchange. Organizations that have email volumes in excess of one million, are advised to
distribute the databases across dedicated database servers as follows: MAMEXCH for the Archive
Manager for Exchange feature, MAMAUDIT for the Auditing feature of Archive Manager for
Exchange, and MAMHSM, MAMINDEX and MAMSEARCH for the HSM and Archive Manager Search
features.

AMXHSM

This server hosts two features of the Metalogix Archive Manager for Exchange: the Hierarchical
Storage Manager (HSM) and Archive Manager Search.

HSMis a data storage system for managing archived emails and files. HSM can manage a larger
network of servers in organizations that use dedicated file servers. When the Archive Manager
for Exchange server (AMXSVR-A) sends emails to HSM, they are immediately compressed and
archived. When a user requests an archived email, HSM immediately decompresses the archived
email and returns it to the Exchange server where the request originated, through the Archive
Manager for Exchange server (AMXSVR-R). The Exchange server returns the email to the user.

Archive Manager Search is a full text search engine capable of searching archived emails and files.
To increase the search efficiency archived emails are indexed. Users can search emails in their
mailboxes and folders. Users can search the mailboxes and folders of other users as well if they
have the requisite permissions.

AMXSVR-A

This server hosts the Archive Manager for Exchange application server with the Archive Server
role that defines the dedicated archival function of this server. This serveris commonly called the
Archive server.

AMXSVR-R

This server hosts the Archive Manager for Exchange application server with the Retrieve Server
role that defines the dedicated retrieval function of this server. This serveris commonly called
the Retrieve server.
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About User Accounts

Before you begin installing Metalogix Archive Manager for Exchange, you must identify or setup
three types of user accounts to ensure a successful installation and usage experience of the
Metalogix Archive Manager for Exchange.

Installer account - Enterprise user account that has administrator access to the various servers and
is used to install the application features.

Superuser account - Domain user account that is used to run the windows services, and
administer the application. The superuser account needs additional privileges and configuration
to be able to communicate with the Microsoft Exchange Server. The advanced installation wizard
manages all the setup and configuration steps that are required, but if you choose to do a manual
installation, see Manual Installation for a summary of steps to setup a superuser.

Database user account - For Oracle database authentication or SQL Server authentication on
Microsoft SQL Server. Does not have to be a domain user account but this user account needs
elevated privileges to setup and access the databases . You don't have to setup this account if you
plan to use Windows authentication with a Microsoft SQL Server.

Considerations for the database user

Metalogix Archive Manager for Exchange supports either the Microsoft SQL Server or the Oracle
database. The database user considerations for each database is also dependent on the
authentication mode as described below.

For SQL Server
Windows Authentication

The domain user that is selected must be added to the database with the sysadmin role. This user
will be automatically assigned the dbo user account by SQL Server. You can then use dbo as the
username for database connection credentials which is preferred.

1 | NOTE: For Windows authentication, we recommend the superuser account be added to the
database with the sysadmin role. Descriptions in this guide use dbo as a sample login and
assumes it is the superuser account.

When a user connects through a Windows user account, SQL Server validates the account name
and password using the Windows principal token in the operating system. This means that the
useridentity is confirmed by Windows. SQL Server does not ask for the password, and does not
perform the identity validation. Windows Authentication is more secure than SQL Server
Authentication.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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SQL Server Authentication
You must create a database userin SQL Server to access the database with the sysadmin role.

When using SQL Server Authentication, logins are created in SQL Server that are not based on
Windows user accounts. Both the user name and the password are created by using SQL Server
and stored in SQL Server. When using SQL Server Authentication, you must set strong passwords
for all SQL Server accounts.

For Oracle

Metalogix Archive Manager for Exchange does not support Windows Authentication for Oracle
database servers. You can use the credentials of any existing user with the sysdba role or create a
database user with the sysdba role.
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Advanced Installation

Advanced installation uses the installation wizard to install Metalogix Archive Manager for
Exchange and associated features on dedicated servers as described in the Deployment Plan. The
installation wizard guides you through the installation of each feature on the various servers. In
addition to the installation of the features, the installer wizard also helps you to verify, install
and set up the prerequisites and accounts that you would have to do manually to prepare the
environments for the installations.

i | NOTE: Some organizations prefer a more granular control on the installation process. You can
choose to install all the features manually. For more information about the manual
installation process, see the chapter Manual Installation.

In this chapter:

e Setup the Superuser Account

e Prepare the Application Servers

o Steps to download the install media

o Steps to install the prerequisites

o Steps to install Microsoft Qutlook

e Install the Application Features

o Install HSM and Archive Manager Search

o Install Archive Manager for Exchange (Archive server)

o Install Archive Manager for Exchange (Retrieve server)

For next steps after you complete the advanced installation, see Application Configuration.

Setup the Superuser Account

A superuser account is a windows account with administrator privileges to work with Metalogix
Archive Manager for Exchange administration tools, run services, manage databases, manage
extensions. It also has elevated privileges to interact with the on-premise or online Microsoft
Exchange servers.

In this topic:

1. Steps to create the superuser account

2. Steps to add the superuser to the Administrators group of the servers

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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3. Stepsto add the superuser as a database user with sysadmin role (for Windows authentication

only)

NOTE: There are more configuration steps necessary to grant elevated permissions to the
superuser. When you use the Advanced Installation option from the Metalogix Archive
Manager for Exchange installation wizard, all the other configurations are automatically
completed for you. For the complete set of configuration steps, see Setup the Superuser
Account in the manual installation chapter of this guide.

Steps to create a superuser account

1
2.

Login to the domain controller.

Navigate to Start > Windows Administrative Tools > Active Directory Users and Computers.
From the Console Tree, expand the domain node.

Click the Users container. The list of users opens in the right-hand pane.

Click the Action menu and select New > User. The New Object - User window opens.

MNew Object - User d
J Create in:  democom .com//Users
b
First name: |I'\"IAM | Initials: I:l
Last name: |Administlatnr |
Full name: ||'\"|A|"!'| Administrator |

User logon name:

|marnadmin | @democomp.com e

User logon name {pre-Windows 2000):
|DEMOCOHP\ | |mamadmin

< Back Mext = Cancel

Verify that Create in title indicates the appropriate domain name and container, and then
enter the details of the superuser. For example:

a. Full name: MAM Administrator
b. Userlogon name: mamadmin@democorp.com
Click Next.

Enter the password and confirm it. Then select Password never expires. Uncheck all other
check boxes.

Click Next.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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MNew Object - User d

J Create in:  democom .com//Users

Ui

When you click Finish, the following object will be created:

Full name: MAM Administrator
User logon name: mamadmin@democorp.com

The password never expires.

< Back Cancel

10. Verify the information and click Finish.

Steps to add the superuser to the Administrators
group of the servers

The superuser must be able to run windows services and accomplish tasks that require
administrator privileges on the Metalogix Archive Manager for Exchange feature servers. Follow
the steps described below to grant administrator privilege to the superuser on each feature
server.

1
2.

Login to each server with its local administrator credentials.
Navigate to Start > Windows Administrative Tools > Computer Management

From the Console Tree, navigate to the System Tools > Local Users and Groups > Groups
container.

From the list of groups in the right-hand pane, right-click Administrators and select Properties
from the context menu. The Administrators Properties window opens.

Click Add.

In the Enter the object name to select field, enter the user logon name of the super user. For
example, enter sales\mamadmin

Click Check Names to verify the logon name.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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Select Users, Computers, Service Accounts, or Groups >

Select this object type:
|Users. Service Accounts, or Groups | Object Types...

From this location:

|demncnrp.comﬁ_lsers | Locations...

Enter the object names to select (examples):
MAM Administrator (mamadmin@democorp. com) Check Names

Advanced... 0K Cancel

Click OK to add the superuser to the Administrator group.
In the Administrators Properties window, click Apply and OK to complete the process.

TIP: Log out of the server and log in again with the superuser's credentials to quickly verify
that the superuser can access the server.

Steps to add the superuser as a database user with
sysadmin role

If you plan to use Windows authentication with a Microsoft SQL Server database, follow the steps
described below:

1
2.

> W

Log in to the database server with your database administrator credentials.

Open the SQL Server Management Studio on your SQL server database server.

Login to the serverinstance for Metalogix Archive Manager for Exchange databases.
Open the Security folder.

Right-click on the Logins folder and select New Login. The Login - New user properties window
appears.

If you want to assign rights to a Windows account, select Windows authentication.

Provide the login name in the text box. You can use the Browse button to select an existing
account if you chose Windows authentication (eg. democorp\mamadmin)

In the user properties window, click Server Roles from the Select a page panel and select the
check box Sysadmin.

Click OK to create the account.

NOTE: Follow the above steps to add the installer account (eg. democorp\domadmin) with
the Sysadmin role.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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Prepare the Application Servers

For the Archive Manager Database server (AMXDB)

See the System Requirements and About User Accounts chapters for preparing database servers.

For the HSM and Search server (AMXHSM)

e Steps toinstall the prerequisites

e Steps to download the install media

For the Archive server (AMXSERVER-A)

e Stepstoinstall the prerequisites

e Steps to install Microsoft Outlook

e Steps to download the install media

For the Retrieve server (AMXSERVER-R)

e Stepstoinstall the prerequisites

e Steps to install Microsoft Outlook

e Steps to download the install media

Steps to install the prerequisites

These steps are optional and are included if you want to install them yourself. The installer
verifies prerequisites.

1. Login with the credentials of the local administrator.
2. Open PowerShell as an Administrator.

3. Toinstall the recommended windows roles and features for individual components that may
be distributed across other servers run the following PowerShell commands:

Archive Manager for Exchange (for Archive and Retrieve servers)

Install-WindowsFeature -Name Web-Server, Web-Http-Redirect, Web-Dyn-
Compression, Web-Windows-Auth, Web-Basic-Auth, Web-Metabase, Web-Mgmt-
Service, RSAT-AD-PowerShell, NET-Framework-45-Features, NET-Framework-
45-ASPNET, Web-Net-Ext45, Web-Asp-Netd4d5, NET-WCF-Services45, Web-Asp-Net

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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HSM

Install-WindowsFeature -Name Web-Server, NET-Framework-Features

Search
Install-WindowsFeature -Name NET-Framework-Features
i | NOTE: These PowerShell commands are compatible with a Window 2016 operating

system. Please refer to the System Requirements chapter to modify the script for other
supported Windows operating systems or install them manually.

4. Install the database drivers. For Microsoft SQL Server, the database driver is available in the
folder<installation folder>\Archive Manager Installation Package\Install.

5. Install the redistributable packages required for your operating system. These files are
available in the folder <installation folder>\Archive Manager Installation
Package\Install

Steps to install Microsoft Outlook

The Metalogix Archive Manager Server communicates with on-premise and online Microsoft
Exchange servers via MAPI. To provide your Archive Manager server with a MAPI subsystem,
install Outlook with full Unicode compatibility. See System Requirements for version
compatibility with your Microsoft Exchange servers.

Steps to download the install media

1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

2. From your browser, navigate to the https://www.quest.com/products/metalogix-archive-
manager-for-exchange page

or

navigate to the http://www.quest.com/trials page. Locate the product Metalogix Archive
Manager for Exchange.

3. Click the Download Free Trial button.

4. Fill the Download Your Free Trial registration form and click Download Trial. The file download
page appears.

5. Download the install media zip file.
6. The the trial license key is specified in the email that is sent to you.

7. Ensure that the files are available locally on the computer on which you are planning to install
the Metalogix Archive Manager for Exchange features.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS
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Install the Application Features

For HSM and Search server (AMXHSM)

The installations steps described in this topicincludes the the installation of the Archive Manager
Post-processing feature.

Install HSM and Archive Manager Search

For Archive server (AMXSERVER-A)
The installations steps described in this topicincludes the the installation of all sub-features.

Install the Archive server

For Retrieve server (AMXSERVER-R)

Install the Retrieve server

Install HSM and Archive Manager Search

In this topic:

e Worksheet for this installation

e Steps toinstall HSM and Archive Manager Search

e Steps to verify the installation

Worksheet for this installation

The following information will be required through the installation process. Sample values are
provided here as a guidance.

Item Description Example
HSM server The server where the HSM and AMXHSM
Archive Manager Search will be
installed.
Installer account Windows account that is used to | username:
install the application. This is democorp\domadmin

usually the enterprise

L assword: 3k 3k sk 3k >k 5k >k %k 5k %k %k k %k k
administrator. P
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Superuser account

Media Folder

Installation folder

HSM Store folder

Store name

Schema name

Database Authentication
method

UserLogin

Password

Database server

Windows account that is used to
install the application and run
the Archive Manager for
Exchange services.

Full path of the folder where the
media files are extracted

Full path of the folder where the
application files will be installed

Full path of the folder that will
contain the archived files.

Name of the media store on a
hard drive. With the Advanced
Installation option of the
installer wizard, only a local hard
drive can be setup as a media
store.

Name of aschemain a hard
drive media store.

Type of database
authentication: Integrated
Windows Authentication or SQL
Authentication

Username if SQL Authentication
is selected

Database password if SQL
Authentication is selected

The database server instance
name where the databases for
Archive Manager for Files will be
installed.

username:
democorp\mamadmin

passvvord.**************

C:\Metalogix
C:\Program Files (x86)
\Metalogix

C:\HSM

The local hard drive folder is
used as the default media store.
Use of other media storage
systems are described in the
Media Store Administration
Guide.

FilesStore

FilesSchema

Integrated Windows
Authentication

dbadmin

3k 3k 3k ok ok sk ok sk ok sk ok skok sk

AMXDB



Steps to install HSM and Archive Manager Search

1. Logintothe server with the credentials of the enterprise administrator (eg.
democorp\domadmin).

2. Run the Metalogix Archive Manager Installation Package to extract the files to a local folder.

3. Iftheinstaller does not start immediately, run the MAMinstaller.exe from your install media
folder. The Welcome window opens.

@ Archive Manager Installation Package X
WELCOME The Industry’s Most Trusted Collaboration Tools Today...
PLANNING
INSTALLATION Archive Migrator Archive Manager StoragePoint
TOOLS & = .
5 %i = s BB
SETUPS S e
MIGRATE THIRD PARTY EMAIL, FILE & SHAREPOINT STORAGE OPTIMIZATION &
ARCHIVES ARCHIVING PERFORMANCE

Exchange [ Office 365 B> SharePoint

Metalogix
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4. From the navigation panel on the left, click PLANNING. The Planning window opens.

@ArchiveManagerlnstallation Package X

WELCOME Planning Help
PLANNING
INSTALLATION

Hardware and software requirements

View the hardware and software requirements for this product

TOOLS

Release notes

SETUPS View the latest information about this release

Visit our homepage

Ly A

Find information about product online

Metalogix

Review the requirements and release notes. If necessary, visit the Quest website for more
information.

5. From the navigation panel on the left, click INSTALLATION. The Server Installation window
opens.

eArchivaManagerln:tallation Package X

WELCOME Server Installation Help

PLANNING
INSTALLATION Software Transaction Agreement ol

= PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY DOWHLOADING, INSTALLING OR USING
TOOLS THIS PRODUCT, YOU ACCEPT AND AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR ORDERS PLACED
- _ ‘OUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO http:lquest.comlleqalista.aspx TO VIEW THE APPLICABLE
SETUPS VERSION OF THIS AGREEMENT FOR YOUR REGION. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS
AGREEMENT OR THE APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION, DO NOT DOVUNLOAD, INSTALL OR
USE THIS PRODUCT. IF YOU HAVE A SIGNED AGREEMENT WITH PROVIDER THAT IS SPECIFICALLY REFERENCED IN AN
'ORDER THAT 15 EXECUTED BETWEEN YOU AND PROVIDER, THEN THAT SIGNED AGREEMENT WILL SUPERSEDE THIS
AGREEMENT.

This Software Transaction Agreement (the “Agreement™) is made between you, the Customer (*Customer” or “You™) and the
Provider, as defined below

1. Definitions. Capitalized terms not defined in context shall have the meanings assigned to them below:

(a}) “Affiliate™ means any legal entity controlling, controlled by, or under common control with a party to this Agreement, for so
long as such control relationship exists.

(b) “Appliance” means a computer hardware product upon which the Software is pre-installed and delivered.

(c} “Documentation” means the user manuale and documentation that Provider makes available for the Software, and all
copies of the foregoing.

(d) “eStore" means Provider's online Software ordering system located at hitp.iguest. com/shopl.

(8} “License Entitlements” means the cuantties and versions of Products licensed to Customer. the new versions and ¥

[¥l | accept the terms of the license agreement.

Metalogix ] e

Read the Software Transaction Agreement. If you wish to proceed, select the | accept the
terms of the license agreement check box.
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6. Click Next. The Installation Mode window opens. Select the Advanced installation option.

@ArchiveManagerlnstallation Package X

WELCOME Installation Mode Help

PLANNING

INSTALLATION Please select which type of installation would like to un

TOOLS

SETUPS () Express installation

(®) Advanced installation

Upgrade

Metalogix =] T o

7. Click Next. The Installation Components window opens.

@ Archive Manager Installation Wizard X
WELCOME Installation Components Help
PLANNING
INSTALLATION Co Setup Installed

mponent p ;
version version
TOOLS
. HSM 220167
SETUPS
[1 | Archive Manager for Files 8.2.0.167
[ | Archive Managerfor Exchange 820167
Archive Manager Search 220167
[ | ArchiveWeb 8.2.0.167

Product description:
ArchiveWeb offers an intutive interface to access archived data and provides search templates, advanced search filters, tagaing and
categorization abilities, legal hold, full auditing, 3rd party export and collaborative eDiscovery review capabilities.

Installation folder:  [C:\Program Files (<86)\Metalogix Browse

Metalogix =] [ [

Select HSM and Archive Manager Search.
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8. Click Next. The Database Engine selection window opens.

@ Archive Manager Installation Wizard X

WELCOME Database Engine Help
PLANNING

INSTALLATION Archive Manager and its related ications can store in various engines.
Please select the database engine you would like to use.
TOOLS

SETUPS
(®) Microsoft SQL Server

Azure SQL Server

(O Oracle

Metalogix ] [ [

Select either Microsoft SQL Server or Oracle.

9. Click Next. The Checking Prerequisites window opens with database-specific prerequisites.

@ Archive Manager Installation Wizard X

WELCOME Checking Prerequisites

PLANNING
Microsoft Data Access Components

INSTALLATION Version 10.0 of MDAC was detected. @,

TOOLS
SETUPS OLE DB Driver for 5QL Server @
OLE DB Driver for SQL Server is missing from the computer. Please install the required driver: OLE DB
Driver 18 for SQL Server

Install Installation Successful
Visual C++ Redistributable Packages @,
Some required packages are missing from the computer. Please install the required version of

Redistributable Packages: 2005 SP1 %86, 2017 x64, 2017 %86, 2010 86, 2010 SP1 x64

Install Installation Successful

Metalogix =] [ [

If one or more prerequisites are missing, the Next button is disabled. Click Install to install
each prerequisite.

10. Click Next. The Superuser Account window opens.
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@ArchlveManagerlnstallatmn Wizard X

WELCOME Superuser Account Help
PLANNING
INSTALLATION It is important to specify an account under which Metalogix services will be running. k must be a local administrator and must

have admin rights on Archive Manager's databases and Exchange server. f you have more than one Exchange serverin
TOOLS the domain, then this user should exist on the server with the newer version of Exchange. Please specify the credentials for

this account.
SETUPS

Superuser name (domain'\user): | DEMOCORP mamadmin ‘

Password | ‘

Retype password: |"‘"“""“"“ ‘

Metalogix ) ] [

Specify the Superuser name and Password. Enter the password again in the Retype password
field.

If the superuser does not exist, the wizard will request permission to create the superuser
account in the Active Directory and grant the necessary permissions on this server to work
with the installed features. If the superuser exists, the dialog shown below does not appear.
If the permissions dialog appears, click Yes.

Question

The entered user account does not exist. Would you like to create it and
continue?

Yes MNe

11. Click Next. The Database Server Connection window opens.
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12. From the Component column, select HSM.

!a Archive Manager Installation Wizard X

WELCOME Database Server Connection Help

PLANNING

Please fill in all values which will be used to create a connection to your Database Server.

INSTALLATION

TOOLS Component DB Server
SETUPS

Archive Manager Search MS5QL

Archive Manager Post-Processing MSSQL

==

v Authentication
Authentication Integrated Windows Authentication
UserLogin
Password

v Server instance
TableOwner dbo
ServerName AMXDB
DatabaseMame MAMHSM
Provider MSOLEDBSGL

ServerName

Database instance server name

>
Metalogix o [N ] [ ot

1 | NOTE: If you selected Oracle as your database engine, then the the Database Server
Connection window for Oracle opens.

Enter the database parameter values described below:

For Microsoft SQL Server

a. Authentication - database authentication method.

b. Userlogin - Username if SQL Authentication or Oracle client is selected. Otherwise this
field is disabled.

c. Password - Database password if SQL Authentication or Oracle client is selected. Otherwise
this field is disabled.

d. TableOwner - Username of the installer account without the domain prefix. For example
dbo.

e. ServerName - The name of the server where you are installing the HSM and Archive
Manager Search.

f. DatabaseName - The name of the database that will contain the HSM metadata. The
default name is MAMHSM.

g. Provider - The SQL Server database communication library. The choices for the provider
are:

For SQL Server

e MSOLEDBSQL - Microsoft OLE DB Driver for SQL Server recommended by Microsoft. This
is the default provider.
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e SQLOLEDB - Microsoft OLE DB Driver for SQL Server for backward compatibility.

e SQLNCLI - SQL Server Native Client OLE DB provider for backward compatibility.

e SQLNCLI10- SQL Server Native Client OLE DB provider for backward compatibility.

e SQLNCLI11-SQL Server Native Client OLE DB provider for backward compatibility.

For Oracle

a. Oracle net name - net service name that describes the network address of the database
serverinyour tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.

¢. User name - database login user name.

d. Password - password of the database user.

e. Provider - The Oracle database communication library (eg. OraOLEDB Oracle).

13. From the Component column, select Archive Manager Search and verify the database

parameter values.

14. From the Component column, select Archive Manager Post-Processing and verify the database

parameter values.

NOTE: When you specify the HSM database parameter values, they are carried over to the

database specification for each feature in the list. While the features will be installed on the
same server, the database to host the metadata for each feature can be on a different server
and the database specifications section for each feature can be customized accordingly.

15. Click Next. The Hierarchical Storage Manager Settings window opens.

!} Archive Manager Installation Wizard

WELCOME
PLANNING
INSTALLATION
TOOLS

SETUPS

Metalogix

Hierarchical Storage Manager Settings

The Hierarchical Storage Manager (HSM) stores the archived content of files The HSM also manages
the Single Instance Function so that indentical files are stored only once no matter how many times they
accur in the file system.

Local HSM installation
H5M server: AMXHSM

Store name: ‘FilesStore Schema name: |FilesSchema

Please select a location for the HSM folder which is large enough to handle all of the content you wish to archive.

Store folder: ‘C:\HSM Browse

< Back MNeadt =

Cancel
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16. Specify the parameter values as described below:
a. Store name - Name of the media store. The default value is FilesStore.
b. Schema name - name of a schema in the media store. The default value is FilesSchema.

17. Click Next. The Please select the type of installation window opens.

@ Archive Manager Installation Wizard X
WELCOME Archive Manager Search Settings Help
PLANNING
INSTALLATION Search server: |AMXHSM
TOOLS
" - Search index folder:

SETUPS
To keep the default folder dick Next. To specify a different folder dick Browse.
For emails: |C.\Prug|T—.|m Files (86} \Metalogix\MAMSearch’\Index'\Mail | Browse
For fies: | C:\Program Files (<86)\Metzlogix\MAMSearchIndex\File || Bowse
>
Metalogix m ] (e | [

Specify the parameter values as described below:

a. Search server - name of the server where the Archive Manager Search feature is installed.
For example AMXHSM.
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18. Click Next. The Firewall Settings window opens.

e Archive Manager Installation Wizard

WELCOME Firewall Settings
PLANNING

Help

INSTALLATION

_ AMlow programs to communicate through Windows Firewall
TOOLS

SETUPS

MNead = Cancel

Metalogix

Select the Allow installation package to change the firewall settings check box. Metalogix

Archive Manager for Exchange features will be then able to communicate through the
firewall.

19. Click Next. The Summary Installation window opens. The installation summary displays
settings you have specified in previous steps.

@ Archive Manager Installation Wizard

WELCOME Summary Installation
PLANNING

This is the installation summary.

INSTALLATION
TOOLS

= = Product name: HSM Version: 8.3.0.165%
SETUPS HSM schema name: FlesSchema
H5M store name: FilesStore

HSM store path: CAHSM

Companerts to be installed:

Product name: Archive Manager Search Version: 8.3.0.16%
Search provider: PAMSEARCH

Search index folder (AM for Exchange): C:\Program Files (86} MetalogocMAM Search IndexMail
Search index folder (AM for Files): C:\Program Files {<B6)\Metalogix.MAMSearch'Index\File

Installation folder: C:'Program Files &86)Metalogix

Metalogix

Install > Cancel
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20. Click Install to start the installation.

e Archive Manager Installation Wizard X
WELCOME Installation Help
PLANNING
INSTALLATION DCOM zccess and launch permissions © Completed N
TS HSM installation O comperd v
SETUPS Archive Manager Search installation ° Complefed W

Archive Manager Post-P © Completed N
Starting services © comperd v

Metalogix

21.The installer proceeds to install all the features. If a feature installation fails or completes
with a warning, expand the row to view and address the problem.

22. Click Finish to complete the installation step.

Steps to verify the installation

1. Open Start > Metalogix > Archive Manager Configuration. The Configuration wizard opens.

¥ Configuration

Configuration

.—'. HEM Installed products

-
p § search HSM
Flugin path: C:\Program Files (x86)Common FilesiPAMIPAMConfigiPluginsiHSMPamConfig, HIM. dil
Status: Loaded
— 0
p ' PosLProCEE oY
Search
Flugin path: C:\Program Files {x86)\Comman Files\PAMIPAMConfigiPlugins\FullText\PamConfig. PAMSearch.dl
Status: Loaded

Post Processing
Flugin path: C:\Program Files (x86)Common FilesiPAMIPAMConfighPluginsPostProcessingiPamConfig. PostProcessing. dll
Status: Loaded

Select the product to configure on the left side.
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2. From the navigation panel, click HSM. The Configure HSM widow opens and the Database tab

is displayed by default.

7% Configuration

Configure HSM
Database
—————
Provider: Microsoft SQL Server
el
P J ) search Server name: AMXDB
—i Initial catalog: MAMHSM
POEEPIOLESEINT
2 Table owner: dbo
User name: (Windows Authentication)
SCHPLS —_—
Databaseversion:  8.2.0.37
Scripts version: 8.2.0.37
v ‘ €4 our database is up to date, ‘
/ Execute scripks...

Verify that the values are as expected.

3. Click the Stores tab to display information about the media store.

7% Configuration

Configure HSM

—
P ¥ Search

el
P | | Hosiiroe=ssig

N

Idl MName | Server | Mirror ofl State

1 FILESSTORE

£

AMXHSM

B3 New store = [ Setup... [ Delete | Primary | E§ Manage.. - B4 Refresh

F—

——————————

d I Name

[ store

|Server

Force Store | Encryption Key | Compression | Task

1

FilesSchema FILESSTORE AMXHSM

yes

£ >
Create... a Edit... m Delete Test.. Refresh

Verify that the values in the Stores and Schemas sections are as expected.
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4. From the navigation panel, click Search. The Configure Search window opens.

¥ Configuration

Configure Search
Database

@ § M

@ Search

Provider: Microsoft SQL Server

Server name: AMXDB
fr— . Initial catalog: MAMSEARCH
o [ | Huze Hinesssing Table ouner dbo
User name: (Windows Authentication)

Database version: 8.2.0.3

Scripts version: 8.20.3

SCHIPLS ———

‘ g ‘Your database is up to date,
: / Execute scripks...

Verify that the values are as expected.

5. From the navigation panel, click Post-Processing. The Configure Search window opens.
¥ Configuration

Configure Post Processing
Database

@ § M

Provider: Microsoft SQL Server

—
P § ) =earch Server name: AMXDB

e Initial catalog: MAMINDEX
@ Post Processing 3
Table owner: dbo
User name: (Windows Authentication)

Database version: 8.2.0.12

Scripts version: 8.2.0.12

SCHIPLS ———

‘ g ‘Your database is up to date,
: / Execute scripks...

Verify that the values are as expected.
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6. Close the Configuration wizard. If the Incomplete configuration dialog opens, click Yes to
dismiss the window and close the wizard.

Configuration

Incomplete configuration

Mot properly configured plugins were found:

Search
» There are no search scopes defined.

Do you really wantto guit the configuration?

- - -

7. Open Start > Windows Administrative Tools > Computer Management. The Computer
Management console opens.

8. From the Console Tree, expand Local Users and Groups.

9. Click the Groups node to display the list of groups.

> (®) Performance
: Device Manager
v & Storage
> @ Windows Server Backup

%‘J Event Log Readers

%'J Guests

éﬁi Hyper-V Administrators
SIS USRS

@Storage Replica Admi...
éﬁi System Managed Acc...

%—l Users

& Computer Management - [m} >
File  Action View Help
e @ XE = H
(& Computer Management (Local) Name Description Actions
hd 'ﬁé Syﬁ:ka:?:sd | *‘-‘Acces; Control Assist...  Members of this group can remotely query authorizatior|| Groups -
’ g Eas t:’ cauier dministrators Administraters have complete and unrestricted acc Mare Actions N
; & S::I:ed :T:;rs ackup Operators Backup Operators can override security restrictions for th
- %I Local Users and Groups *J Certificate Service DC...  Members of this group are allowed to connect to Certifi¢ | Administrators _~
] Users *J Cryptographic Operat.. Members are authorized te perform cryptographic opere More Actions »
| Groups %J Distributed COM Users  Members are allowed to launch, activate and use Distrib

Members of this group can read event logs from local m
Guests have the same access as members of the Users gr
Members of this group have complete and unrestricted |
Built-in group used by Internet Information Services.

= Disk Management @Network(onfiguratio.‘. Members in this group can have some administrative pri
> i-g Services and Applications éki Performance Log Users  Members of this group may schedule logging of perforn
%J Performance Menitor ... Members of this group can access performance counter
%IJ Power Users Power Users are included for backwards compatibility ar|
@Prlnt Operators Members can administer printers installed on domain cc
*'J RDS Endpoint Servers  Servers in this group run virtual machines and host sessii
%IJ RDS Management Ser...  Servers in this group can perferm routine administrative
*‘J RDS Remote Access 5. Servers in this group enable users of RemoteApp progray
*'J Remote Desktop Users  Members in this group are granted the right to logon rer
@ Remote Management... Members of this group can access WMI rescurces over n
%‘J Replicater Supports file replication in a domain

Members of this group have complete and unrestricted i
Members of this group are managed by the system.
Users are prevented from making accidental or intention
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10. Right-click Administrators and select Properties from the context menu. The Administrators
Properties window opens.

Administrators Properties ? d
General
% Administrators
Description: Administrators have complete and unrestricted access

to the computer/domain

Members:
& DEMOCORP domadmin
52, DEMOCORP \Domain Admins

& DEMOCORF \mamadmin
A domadmin

Changes to a user's group membership
Add... BRemove are not effective until the next time the
user logs on.

Cancel Apply Help

Verify that the superuser account is listed in the Members panel. For example,
DEMOCORP\mamadmin

11. Click OK to close the properties window, and then close the Computer Management console.
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Install the Archive server

In this topic:

e Worksheet for this installation

e Steps to install Metalogix Archive Manager for Exchange

e Steps to configure and verify the Archive server

Worksheet for this installation

The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item

License Key

Archive Manager for
Exchange server

Installer account

Superuser account

Media Folder

Installation folder

Database Authentication
method

Description

The license key that you
received from Quest. If you
don't have alicense key, contact
your Quest representative.

The server where the Archive
Manager for Exchange will be
installed.

Windows account that is used to
install the application. This is
usually the enterprise
administrator.

Windows account that is used to
run the application and run the
Archive Manager for Exchange
services.

Full path of the folder where the
media files are extracted

Full path of the folder where the
application files will be installed

Type of database
authentication: Integrated
Windows Authentication or SQL
Authentication

Example

894K5-3M448-M544E-AS594A-
7K8Z7 (Sample only. This key is
neither an active nor an expired
license key)

AMXSERVER-A

username:
democorp\domadmin

password. 3k 3k 3k 3k >k 5k >k 3k %k 5k k %k k ok

username:
democorp\mamadmin

password- 3k 3k 3k 3k >k 5k >k 3k %k 3k k %k k ok

C:\Metalogix
C:\Program Files (x86)
\Metalogix

Integrated Windows
Authentication
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UserlLogin

Password

Database server

HSM server

Search server

Username if SQL Authentication
is selected

Database password if SQL
Authentication is selected

The database server instance
name where the databases for
Archive Manager for Files will be
installed.

The server where HSMis
installed.

The server where the Archive
Manager Search is installed.

dbadmin

%k 3k 3k 3k 3k 3k 3k 3k 3k 3k %k %k %k %k

AMXDB

AMXHSM

AMXHSM

Steps to install Metalogix Archive Manager for Exchange

1

Login to the server with the credentials of the enterprise administrator (eg.
democorp\domadmin).

Run the Metalogix Archive Manager Installation Package to extract the files to a local folder.

If the installer does not start immediately, run the MAMiInstaller.exe from your install media
folder. The Welcome window opens.

@ Archive Manager Installation Package

WELCOME
PLANNING
INSTALLATION
TOOLS
SETUPS

Metalogix

The Industry’s Most Trusted Collaboration Tools Today...

Archive Migrator Archive Manager
S
M — o
=% E" 2w B4
MIGRATE THIRD PARTY EMAIL, FILE & SHAREPOINT
ARCHIVES ARCHIVING

StoragePoint

1\ s EER

STORAGE OPTIMIZATION &
PERFORMANCE

MSEnchange omy [ Windemstiesscr

£

2

=
el

WINNER g;l;% WINNER
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4. From the navigation panel on the left, click PLANNING. The Planning window opens.

@ArchiveManagerlnstallation Package X

WELCOME Planning Help
PLANNING
INSTALLATION

Hardware and software requirements

View the hardware and software requirements for this product

TOOLS

Release notes

SETUPS View the latest information about this release

Visit our homepage

Ly A

Find information about product online

Metalogix

Review the requirements and release notes. If necessary, visit the Quest website for more
information.

5. From the navigation panel on the left, click INSTALLATION. The Server Installation window
opens.

eArchivaManagerln:tallation Package X

WELCOME Server Installation Help

PLANNING
INSTALLATION Software Transaction Agreement ol

= PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY DOWHLOADING, INSTALLING OR USING
TOOLS THIS PRODUCT, YOU ACCEPT AND AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR ORDERS PLACED
- _ ‘OUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO http:lquest.comlleqalista.aspx TO VIEW THE APPLICABLE
SETUPS VERSION OF THIS AGREEMENT FOR YOUR REGION. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS
AGREEMENT OR THE APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION, DO NOT DOVUNLOAD, INSTALL OR
USE THIS PRODUCT. IF YOU HAVE A SIGNED AGREEMENT WITH PROVIDER THAT IS SPECIFICALLY REFERENCED IN AN
'ORDER THAT 15 EXECUTED BETWEEN YOU AND PROVIDER, THEN THAT SIGNED AGREEMENT WILL SUPERSEDE THIS
AGREEMENT.

This Software Transaction Agreement (the “Agreement™) is made between you, the Customer (*Customer” or “You™) and the
Provider, as defined below

1. Definitions. Capitalized terms not defined in context shall have the meanings assigned to them below:

(a}) “Affiliate™ means any legal entity controlling, controlled by, or under common control with a party to this Agreement, for so
long as such control relationship exists.

(b) “Appliance” means a computer hardware product upon which the Software is pre-installed and delivered.

(c} “Documentation” means the user manuale and documentation that Provider makes available for the Software, and all
copies of the foregoing.

(d) “eStore" means Provider's online Software ordering system located at hitp.iguest. com/shopl.

(8} “License Entitlements” means the cuantties and versions of Products licensed to Customer. the new versions and ¥

[¥l | accept the terms of the license agreement.

Metalogix ] e

Read the Software Transaction Agreement. If you wish to proceed, select the | accept the
terms of the license agreement check box.
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6. Click Next. The Installation Mode window opens. Select the Advanced installation option

@ArchiveManagerlnstallation Package X

WELCOME Installation Mode Help

PLANNING

INSTALLATION Please select which type of installation would like to un
TOOLS

SETUPS () Express installation

(®) Advanced installation

Upgrade

Metalogix =] T o

7. Click Next. The Installation Components window opens.

@ Archive Manager Installation Wizard X
WELCOME Installation Components Help
PLANNING
INSTALLATION Co Setup Installed

mponent . A
version version
TOOLS
[ 'Hsm 8.3.0158
SETUPS
[ | Archive Managerfor Files 2.3.0158
Archive Managerfor Exchange 823.0158
[ | Archive Manager Search 83071388
[ | ArchiveVWeb 8.3.0198
Product description:
Reduce the storage footprint of your email archives without the complexity.
Archive parallel messages in real time, as needed, to on-premises, hybrid or cloud locations.
Users can search through archived emails and restore them in one-click.
Installation folder:  [C:\Program Files (x86)\Metalogix Browse
»
Metalogix casc | [k | [

Select Archive Manager for Exchange.
i | NOTE:

Archive Manager for Files could be installed on the same server. Installation of Archive
Manager for Files is described in the Metalogix® Archive Manager for Files Advanced
Installation Guide.
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ArchiveWeb is an enhancement. Installation of ArchiveWeb is described in the
Metalogix® Archive Manager for Exchange ArchiveWeb Manual.

8. Click Next. The Database Engine selection window opens.

e Archive Manager Installation Wizard X

WELCOME Database Engine Help
PLANNING

INSTALLATION Archive Manager and its related applications can store ata in various datat engines.
Please select the database engine you would like to use.
TOOLS

SETUPS

(®) Microsoft SQL Server

Azure 5QL Server

() Oracle

Metalogix ] ] o

Select either Microsoft SQL Server or Oracle.

9. Click Next. The Checking Prerequisites window opens.

@ArchivaManagerlnstallation Package ot
WELCOME Checking Prerequisites Help
PLANNING

NET Framework ? ~
INSTALLATION JMET Framework 3.5 S5P1 was detected,
TOOLS
SETUPS Microsoft Data Access Components @
Version 10.0 of MDAC was detected.
MAPT @
MAPT subsystem found. Microsoft Cutlook is installed.
Microsoft Windows Features And Roles @
Missing features: Web Server, HTTP Redirection, Dynamic Content Compression, Windows
Authentication, Basic Authentication, 1S 6 Metabase, Management Service, ASP.MET 4.5, .MNET
Extensibility 4.5, ASP.NET 4.5, ASP.NET 3.5, WCF HTTP activation, Static Content
Install
OLE DB Driver for SQL Server @
OLE DB Driver for SQL Server is missing from the computer. Please install the required driver: OLE DB
Driver 18 for SQL Server
Install v
»
Metalogix = O O
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If one or more prerequisites are missing, the Next button will appear disabled. Click Install for

each prerequisite to install the missing features. Scroll down to expose and install all the
prerequisites.

Scroll down to the bottom of the window. Click Validate your license. The Activate License Key
dialog opens.

Activate License Key o

Q.)) Enter license key and select the activation method
%

License key:
| | | || || |

Activation mode:

(®) Online activation (requires online internet connection)

(") Offline activation

Set proxy ...

< Back || Mesxk = | | Close |

If you are connected to the internet, select Online activation or see License Activation for
more options. Click Next. When your license is activated, you will see a confirmation message
and the license details. Click Finish to close the Activate License Key dialog.

10. In the Checking Prerequisites window, click Next. The Superuser Account window opens.

@ Archive Manager Installation Wizard X
WELCOME Superuser Account Help
PLANNING
INSTALLATION It is impartant to specify an account under which Metalogix services will be running. it must be a local administrator and must

have admin rights on Archive Manager's databases and Exchange server. f you have more than one Exchange serverin
TOOLS the domain, then this user should exist on the server with the newer version of Exchange. Please specify the credentials for
this account.
SETUPS
Superuser name {domain‘user): |DEMOCOF{F dmin ‘
Fassword | ‘
Retype password: |‘“““““‘ ‘
»
Metalogix casc | [k | [

Specify the Superuser name and Password. Enter the password again in the Retype password
field.
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11. Click Next. The Database Server Connection window opens.

@ArchiveManagerlnstallation Wizard X

WELCOME Database Server Connection Help

PLANNING
INSTALLATION

Please fill in all values which will be used to create a connection to your Database Server.

TOOLS Component DB Server
SETUPS Archive Manager for Exchange MSSQL
Archive Manager Multitenant MSSaL

Archive Manager Audting MSSaL

==

v Authentication
Authentication Integrated Windows Authertication
UserLogin
Password

v Server instance
TableOwner dbo
ServerName AMXDB
DatabaseMName MAMEXCH
Provider MSOLEDBSGL

ServerName

Database instance server name

»
Metalogix oo e ] [ ot

1 | NOTE: If you selected Oracle as your database engine, then the the Database Server
Connection window for Oracle opens.

Enter the database parameter values described below:

For Microsoft SQL Server

a. Authentication - database authentication method.

b. Userlogin - Username if SQL Authentication or Oracle client is selected. Otherwise this
field is disabled.

c. Password - Database password if SQL Authentication or Oracle client is selected. Otherwise
this field is disabled.

d. TableOwner - Username of the installer account without the domain prefix. For example
dbo.

e. ServerName - The name of the server where you are installing the HSM and Archive
Manager Search.

f. DatabaseName - The name of the database that will contain the HSM metadata. The
default name is MAMHSM.

g. Provider - The SQL or Oracle database communication library. The choices for the provider
are:

For SQL Server

e MSOLEDBSQL - Microsoft OLE DB Driver for SQL Server recommended by Microsoft. This
is the default provider.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

Advanced Installation



e SQLOLEDB - Microsoft OLE DB Driver for SQL Server for backward compatibility.

e SQLNCLI - SQL Server Native Client OLE DB provider for backward compatibility.

e SQLNCLI10- SQL Server Native Client OLE DB provider for backward compatibility.

e SQLNCLI11-SQL Server Native Client OLE DB provider for backward compatibility.
For Oracle

a. Oracle net name - net service name that describes the network address of the database
serverinyour tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.

¢. User name - database login user name.

d. Password - password of the database user.

e. Provider - The Oracle database communication library (eg. OraOLEDB Oracle).

12. Click Next. The Hierarchical Storage Manager Settings window opens.

@ Archive Manager Installation Wizard X
WELCOME Hierarchical Storage Manager Settings Help
PLANNING
INSTALLATION The Hierarchical Storage Manager (HSM) stores the archived content of files. The HSM also manages

the Single Instance Function so that indentical files are stored only once no matter how many times they
TOOLS accur in the file system.
HSM settings for installed components
SETUPS
Component HSM server name
Archive Manager for Exchange AMXHSM
>
Metalogix ] ] [

In the HSM server name field enter the name of the server where the HSM application feature
isinstalled. For example AMXHSM.
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13. Click Next. The Please select the type of installation window opens.

e Archive Manager Installation Wizard X

WELCOME Archive Manager Search Settings Help
PLANNING
INSTALLATION
TOOLS

Search server: [AMXHSM

SETUPS

Metalogix ] ] [

In the Search server field enter the name of the server where the Archive Manager Search
feature is installed. For example AMXHSM.

14. Click Next. The Firewall Settings window opens.

@ Archive Manager Installation Wizard X

WELCOME Firewall Settings Help
PLANNING

INSTALLATION

TOOLS

SETUPS

AMllow programs to communicate through Windows Firewall

Metalogix ] [ [

Select the Allow programs to communicate through Windows Firewall check box. Metalogix
Archive Manager for Exchange features will be then able to communicate through the
firewall.
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15. Click Next. The Summary Installation window opens. The installation summary displays
settings you have specified in previous steps.

@ Archive Manager Installation Wizard

WELCOME
PLANNING
INSTALLATION
TOOLS

SETUPS

Summary Installation

Thig is the installation summary.

Components to be installed:

Product name: Archive Manager for Exchange Version: 8.3.0.158

Installation folder: C:'Program Files 86)\Metalogix

Manage the Organizational Forms Librany

Start Metalogix Archive Manager for Exchange

Metalogix

< Back Install > Cancel

a. Select Manage the Organizational Forms Library if your organization uses this public folder

to share email templates. Otherwise, clear the check box.

b. Select the check box Start Metalogix Archive Manager for Exchange to open the Archive
Manager for Exchange Administration Center (AMAC) when the installation completes.

16. Click Install to start the installation.

17. When the installer starts installing the Archive Manager for Exchange feature, the Select
Features window of the Archive Manager for Exchange opens.

Archive Manager for Exchange

Select Features
Select the features setup will install.

‘3

x

; Application Server
[~1PST Imparter
Administrative tools
[+]Forms Installer
[+]auditing
[+/IMonitoring service

432,87 MB of space required on the C drive
112388.02 MB of space available on the C drive

Select the features you want to install, and deselect the features you do not want to install.

Description

Application server contains
the core services for an
Archive or Retrieve Server. It
is not recommended to install
the Application services on
the Exchange Server, For
maore information please read
the Installation guide.

Cancel

Mandatory features
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e Application Server
e Administrative tool
Optional features

e Auditing

e Monitoring service
Optional resources

e PSTImporter

e Forms Installer

e Documentation

Keep the default selections to experience the full range of features. Then click Next to install
the features.

18. Click Next to continue the installation. If a feature installation fails or completes with a
warning, expand the row to view and address the problem.

Archive Manager Installation Wizard X
2 9
WELCOME Installation Help
PLANNING
INSTALLATION DCOM access and launch permissions o Complefed N
TOOLS Archive Manager for Exchange o Complefed N/
SETUPS Archive Manager Multitenant o Complefed v/
Archive Manager Auditing © Completed
Starting services o Complefed W
»
Metalogix

19. Click Finish to complete the installation step.

20. The Archive Manager for Exchange Administration Center (AMAC) should open automatically
if the check box Start Metalogix Archive Manager for Exchange was checked in the Summary
Installation step of the installation wizard.

21.The Address Book Setup wizard opens automatically for a new installation. Click Close to exit
the wizard. Then close the Address Book Manager window that opens. For advanced
installation, Address Book setup can be done at a later step. For more information see Setup
the Address Book.
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Steps to configure and verify the Archive server
1. If the AMAC s not already open, click Start > Archive Manager for Exchange. The AMAC opens.

Archive Manager for Exchange =E e
Session  View Tools Help
FRRRX e e s
Groups "Settings ][PublicFoIders ][Jobs ][Retention "Locations ]
Set filker | | Clear filker |
Group name Alias Property Value
i— @ISewel Role: Archive Sen.rerl Loaded FullAccess Manager

On the status bar at the bottom of the window, verify that the Server Role is set to Archive
Server.

2. Open Start > Metalogix > Archive Manager Configuration. The Configuration wizard opens.

" Configuration

Configuration

E.i Auditing Installed products

— o
= § Users Auditing
Flugin path: C:\Program Files {x86)\Common FilesiPAMIPAMConfigPlugins\PAMAuditinglPamConfig. Auditing. dll

Status: Loaded

o1 EXCHange
] ' BrEYE

Users
Plugin path: C:\Program Files {x86)\Common FilesiPaMiPamConfigiPlugins\MultiTenantiPamConfig. MultiTenant . dil

Status: Loaded

Exchange Archive
Flugin path: C:\Program Files {x86)\Common FilesiPAMIPamConfigiPlugins\PAM4ExchangePamConfig. ExchangeParn.dIl

Status: Loaded

Select the product to configure on the |eft side.

#

3. From the navigation panel, click Auditing. The Configure Auditing window opens and the
Database tab is displayed by default.
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[l |
il
3

¥ Configuration

s - .. \ -. |
Configure Auditing - mm&xﬂ : =
Auditing P “&,ﬁ/

Provider: Microsoft SQL Server
—
(] ¥ UEere Server name: AMXDB
Initial catalog: MAMAUDIT
‘, Exchange) g
- Archie Table owner: dbo
User name: (Windows Authentication)

ﬁﬁﬁ__ S

Database version: 8.3.0.27

Scripts version: 8.3.0.27

‘ €4 our database is up to date, ‘

d ]
N\ _/
3 Execute scripts...

Verify that the values are as expected.

4. From the navigation panel, click Users. The Configure Users window opens and the Database
tab is displayed by default.

=

EE——

% Configuration

- X
Configure Users “ A’
Database TP Co

Provider: Microsoft SQL Server
Server name: AMXDB
Initial catalog: MAMUSER
-' ExChiange s
- Archie Table owner: dbo
User name: (Windows Authentication)

%__ e ——

Database version: 8.3.0.32

Scripts version: 83.0.32

‘ @ ‘Your database is up to date. ‘

Execute scripks...

Verify that the values are as expected.
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5.

From the navigation panel, click Exchange Archive. The Configure Exchange Archive window
opens and the Database tab is displayed by default.

Configuration

Configure Exchange Archive

Database

Provider: Microsoft SQL Server
Server name: AMXDB
— Initial catalog: MAMEXCH
w Enchange
Archive Table owner: dbo
User name: (Windows Authentication)

Database version: 8.3.0.173

Scripts version: 8.3.0.173

/_ €4 Your database is up to date.

Execute scripks...

Verify that the values are as expected.
Close the Configuration wizard.

Open Start > Windows Administrative Tools > Computer Management. The Computer
Management console opens.

From the Console Tree, expand Local Users and Groups.

Click the Groups node to display the list of groups.

& Computer Management — [m] x
File Action View Help

e nm XE =B

& Computer Management (Local) || Name Description bEITS

v {f} system Taols 5 Access Control Assist
5 (2 Task Scheduler

Members of this group can remotely query authorizatior| | Groups a

’ g E:ant:::au‘f:r %‘ Backup Operators Backup Operators can override security restrictions for tH More Actiens
:’ g Loi: u;:r; ::d Groups @ Certificate Service DC... Members of this group are allowed to connect to Certifi | Administrators -~
= Users I Cryptographic Operat.. Members are authorized to perform cryptographic operz Maore Actions »
" Groups %J Distributed COM Users  Members are allowed to launch, activate and use Distribi
s (@ Performance &/ Event Log Readers Members of this group can read event lags from local m|
& Device Manager O Guests Guests have the same access as members of the Users g1
v E Storage @Hypar—VAdmmlstrators Members of this group have complete and unrestricted i
> w ‘Windows Server Backup %JHS_\USRS Built-in group used by Internet Information Services,
= Disk Management I Network Configuratio... Members in this group can have some administrative pri
5 F4 Services and Applications & Performance Log Users  Members of this group may schedule logging of perforn
4 Performance Monitor ... Members of this group can access performance counter
%‘ Power Users Power Users are included for backwards compatibility ar|
@ Print Operators Members can administer printers installed on demain cc|

%JRDS Endpoint Servers  Servers in this group run virtual machines and host sessiy
4 RDS Management Ser... Servers in this group can perform routine administrative
5 RDS Remote Access 5. Servers in this group enable users of RemoteApp prograr
4% Remote Desktop Users  Members in this group are granted the right to logon rer
@ Remote Management.. Members of this group can access WMI resources over n|
@Rep\icator Supports file replication in a domain

8 Storage Replica Admi.. Members of this group have complete and unrestricted
4 System Managed Acc.. Members of this group are managed by the system.

A Users Users are prevented from making accidental or intention|
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10. Right-click Administrators and select Properties from the context menu. The Administrators
Properties window opens.

Administrators Properties ? d
General
% Administrators
Description: Administrators have complete and unrestricted access

to the computer/domain

Members:
& DEMOCORP domadmin
52, DEMOCORP \Domain Admins

& DEMOCORF \mamadmin
A domadmin

Changes to a user's group membership
Add... BRemove are not effective until the next time the
user logs on.

Cancel Apply Help

Verify that the superuser account is listed in the Members panel. For example,
DEMOCORP\mamadmin

11. Click OK to close the properties window, and then close the Computer Management console.

Install the Retrieve server

In this topic:

e Worksheet for this installation

e Steps to install Metalogix Archive Manager for Exchange

e Steps to configure and verify the Retrieve server

Worksheet for this installation

The following information will be required through the installation process. Sample values are
provided here as a guidance.

Item Description Example
License Key The license key that you 894K5-3M448-M544E-A594A-
received from Quest. If you 7K8Z7 (Sample only. This key is
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Archive manager for
Exchange server

Installer account

Superuser account

Media Folder

Installation folder

Database Authentication
method

UserlLogin

Password

Database server

HSMserver

Search server

don't have alicense key, contact
your Quest representative.

The server where the Archive
Manager for Exchange will be
installed with the Retrieve role.

Windows account that is used to
install the application. This is
usually the enterprise
administrator.

Windows account that is used to
install the application and run
the Archive Manager for
Exchange services.

Full path of the folder where the
media files are extracted

Full path of the folder where the
application files will be installed

Type of database
authentication: Integrated
Windows Authentication or SQL
Authentication

Username if SQL Authentication
is selected

Database password if SQL
Authentication is selected

The database server instance
name where the databases for
Archive Manager for Files will be
installed.

The server where HSMis
installed.

The server where the Archive
Manager Search is installed.

neither an active nor an expired
license key)

AMXSERVER-R

username:
democorp\domadmin

password. 3k 3k 3k ok 3k ok sk sk ks ksk ok k

username:
democorp\mamadmin

password. 3k 3k 3k 3k >k 3k 3k 3k %k >k %k 5k %k *k

C:\Metalogix
C:\Program Files (x86)
\Metalogix

Integrated Windows
Authentication

dbadmin

3k 3k 3k 3k >k 3k >k 3k %k %k k %k k k

AMXDB

AMXHSM

AMXHSM



Steps to install Metalogix Archive Manager for Exchange

1. Logintothe server with the credentials of the enterprise administrator (eg.
democorp\domadmin).

2. Run the Metalogix Archive Manager Installation Package to extract the files to a local folder.

3. Iftheinstaller does not start immediately, run the MAMinstaller.exe from your install media
folder. The Welcome window opens.

e Archive Manager Installation Package X

WELCOME The Industry’s Most Trusted Collaboration Tools Today...

PLANNING

INSTALLATION Archive Migrator Archive Manager StoragePoint

TOOLS 7 ==
= Ak 8o 28089

SETUPS

MIGRATE THIRD PARTY EMAIL, FILE & SHAREPOINT STORAGE OPTIMIZATION &
ARCHIVES ARCHIVING PERFORMANCE

Exchange ] Office 365 B> SharePoint

@ArchiveManagerlnstallation Package X

WELCOME Planning Helo
PLANNING
INSTALLATION
TOOLS

& Hardware and software requirements
Wiew the hardware and software requirements for this product

Release notes

SETUPS View the |atest information about this release

Wisit our homepage

“ @

Find information about product anline

Metalogix

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

Advanced Installation



Review the requirements and release notes. If necessary, visit the Quest website for more
information.

5. From the navigation panel on the left, click INSTALLATION. The Server Installation window
opens.

@ArchlveManagerlnstallatmn Package X

WELCOME Server Installation Help

PLANNING
INSTALLATION Software Transaction Agreement "

c PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY DOWHLOADING, INSTALLING OR USING
TOOLS THIS PRODUCT, YOU ACCEPT AND AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR ORDERS PLACED
- _ ‘OUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO http:ilquest.comlleqalista.aspx TO VIEW THE APPLICABLE
SETUPS VERSION OF THIS AGREEMENT FOR YOUR REGION. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS
AGREEMENT OR THE APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION, DO NOT DOVWNLOAD, INSTALL OR
USE THIS PRODUCT. IF YOU HAVE A SIGNED AGREEMENT WITH PROVIDER THAT IS SPECIFICALLY REFERENCED IN AN
'ORDER THAT 15 EXECUTED BETWEEN YOU AND PROVIDER, THEN THAT SIGNED AGREEMENT WILL SUPERSEDE THIS
AGREEMENT.

This Software Transaction Agreement (the “Agreement”) is made between you, the Customer (*Customer” or *You™) and the
Provider, as defined below

1. Definitions. Capitalized terms not defined in context shall have the meanings assigned to them below:

(a) “Affiliate™ means any legal entity controlling, controlled by, or under common control with a party to this Agreement, for so
long as such control relationship exists.

(b} “Appliance” means a computer hardware product upen which the Software is pre-installed and delivered.

(c) “Documentation” means the user manuale and documentation that Provider makes available for the Software, and all
copies of the foregoing.

(d} “eStore”means Provider's online Software ordering system located at hitp:iguest. com/shopi.

(g} “License Entitlements” means the cuantties and versions of Products licensed to Customer. the new versions and ¥

[¥l | accept the terms of the license agreement.

Mesdt > Cancel

Read the Software Transaction Agreement. If you wish to proceed, select the | accept the
terms of the license agreement check box.
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6. Click Next. The Installation Mode window opens. Select the Advanced installation option

@ArchiveManagerlnstallation Package X

WELCOME Installation Mode Help

PLANNING

INSTALLATION Please select which type of installation would like to un

TOOLS

SETUPS () Express installation

(®) Advanced installation

Upgrade

Metalogix =] T o

7. Click Next. The Installation Components window opens.

@ Archive Manager Installation Wizard X
WELCOME Installation Components Help
PLANNING
INSTALLATION Co Setup Installed

mponent . A
version version
TOOLS
[ 'Hsm 8.3.0158
SETUPS
[ | Archive Managerfor Files 2.3.0158
Archive Managerfor Exchange 823.0158
[ | Archive Manager Search 83071388
[ | ArchiveVWeb 8.3.0198
Product description:
Reduce the storage footprint of your email archives without the complexity.
Archive parallel messages in real time, as needed, to on-premises, hybrid or cloud locations.
Users can search through archived emails and restore them in one-click.
Installation folder:  [C:\Program Files (x86)\Metalogix Browse
»
Metalogix casc | [k | [

Select Archive Manager for Exchange.
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8. Click Next. The Database Engine selection window opens.

@ Archive Manager Installation Wizard X

WELCOME Database Engine Help

PLANNING

INSTALLATION Archive Manager and its related ications can store in various engines.
Please select the database engine you would like to use.
TOOLS

SETUPS
(®) Microsoft SQL Server

Azure SQL Server

(O Oracle

Metalogix ] [ [

Select either Microsoft SQL Server or Oracle.

9. Click Next. The Checking Prerequisites window opens.

@ArchiveManagerlnstallation Package X

WELCOME Checking Prerequisites Help
PLANNING

NET Framework
INSTALLATION MET Framework 3.5 51 was detected.

TOOLS

SETUPS Microsoft Data Access Components
Version 10.0 of MDAC was detected.

MAPI
MAPI subsystem found. Microsoft Outlook is installed.

Microsoft Windows Features And Roles

©Q § § §®

Missing features: Web Server, HTTP Redirection, Dynamic Content Compression, Windows
Authentication, Basic Authentication, II5 6 Metabase, Management Service, ASP.MET 4.5, .MET
Extensibility 4.5, ASP.NET 4.5, ASP.NET 3.5, WCF HTTP activation, Static Content

Install

OLE DB Driver for SQL Server

Q

OLE DB Driver for SQL Server is missing from the computer. Please install the required driver: OLE DB
Driver 18 for SQL Server

Install

Metalogix = CEe [

If one or more prerequisites are missing, the Next button will appear disabled. Click Install for
each prerequisite to install the missing features. Scroll down to expose and install all the
prerequisites.

Scroll down to the bottom of the window. Click Validate your license. The Activate License Key
dialog opens.
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Activate License Key =

Q_)% Enter license key and select the activation method

License key:
| I I || || |

Activation mode:

(®) Online activation (requires online internet connection)

(") Offline activation

Set proxy ...

e

If you are connected to the internet, select Online activation or see License Activation for
more options. Click Next. When your license is activated, you will see a confirmation message
and the license details. Click Finish to close the Activate License Key dialog.

10. In the Checking Prerequisites window, click Next. The Superuser Account window opens.

@ Archive Manager Installation Wizard X
WELCOME Superuser Account Help
PLANNING
INSTALLATION It is important to specify an account under which Metalogix services will be running. k must be a local administrator and must

have admin rights on Archive Manager's databases and Exchange server. f you have more than one Exchange serverin
TOOLS the domain, then this user should exist on the server with the newer version of Exchange. Please specify the credentials for
this account.
SETUPS
Superuser name (domain'\wuser): |DEMOCOF{F in ‘
Password | ‘
Reype password: |‘“““““‘ ‘

Metalogix =] [ [

Specify the Superuser name and Password. Enter the password again in the Retype password
field.
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11. Click Next. The Database Server Connection window opens.

@ArchiveManagerlnstallation Wizard X

WELCOME Database Server Connection Help

PLANNING
INSTALLATION

Please fill in all values which will be used to create a connection to your Database Server.

TOOLS Component DB Server
SETUPS Archive Manager for Exchange MSSQL
Archive Manager Multitenant MSSaL

Archive Manager Audting MSSaL

==

v Authentication
Authentication Integrated Windows Authertication
UserLogin
Password

v Server instance
TableOwner dbo
ServerName AMXDB
DatabaseMName MAMEXCH
Provider MSOLEDBSGL

ServerName

Database instance server name

»
Metalogix oo e ] [ ot

1 | NOTE: If you selected Oracle as your database engine, then the the Database Server
Connection window for Oracle opens.

Enter the database parameter values described below;

For Microsoft SQL Server

a. Authentication - database authentication method.

b. Userlogin - Username if SQL Authentication or Oracle client is selected. Otherwise this
field is disabled.

c. Password - Database password if SQL Authentication or Oracle client is selected. Otherwise
this field is disabled.

d. TableOwner - Username of the installer account without the domain prefix. For example
dbo.

e. ServerName - The name of the server where you are installing the HSM and Archive
Manager Search.

f. DatabaseName - The name of the database that will contain the HSM metadata. The
default name is MAMHSM.

g. Provider - The SQL or Oracle database communication library. The choices for the provider
are:

For SQL Server

e MSOLEDBSQL - Microsoft OLE DB Driver for SQL Server recommended by Microsoft. This
is the default provider.
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e SQLOLEDB - Microsoft OLE DB Driver for SQL Server for backward compatibility.

e SQLNCLI - SQL Server Native Client OLE DB provider for backward compatibility.

e SQLNCLI10- SQL Server Native Client OLE DB provider for backward compatibility.

e SQLNCLI11-SQL Server Native Client OLE DB provider for backward compatibility.
For Oracle

a. Oracle net name - net service name that describes the network address of the database
serverinyour tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.

¢. User name - database login user name.

d. Password - password of the database user.

e. Provider - The Oracle database communication library (eg. OraOLEDB Oracle).

12. Click Next. The Hierarchical Storage Manager Settings window opens.

@ Archive Manager Installation Wizard X
WELCOME Hierarchical Storage Manager Settings Help
PLANNING
INSTALLATION The Hierarchical Storage Manager (HSM) stores the archived content of files. The HSM also manages

the Single Instance Function so that indentical files are stored only once no matter how many times they
TOOLS accur in the file system.
HSM settings for installed components
SETUPS
Component HSM server name
Archive Manager for Exchange AMXHSM
>
Metalogix ] ] [

Specify the parameter values as described below:

a. HSM server name - name of the server where the HSM and Archive manager Search
features are installed. For example AMXHSM.
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13. Click Next. The Please select the type of installation window opens.

e Archive Manager Installation Wizard

WELCOME Archive Manager Search Settings
PLANNING

Help

INSTALLATION
TOOLS

Search server: [AMXHSM

SETUPS

Metalogix

MNead = Cancel

Specify the parameter values as described below:

a. Search server - name of the server where the Archive Manager Search feature is installed.
For example AMXHSM.

14. Click Next. The Firewall Settings window opens.

e Archive Manager Installation Wizard

WELCOME Firewall Settings
PLANNING
INSTALLATION
TOOLS

SETUPS

Allow programs to communicate through Windows Firewall

Metalogix

Mead Cancel

Select the Allow installation package to change the firewall settings check box. Metalogix

Archive Manager for Exchange features will be then able to communicate through the
firewall.
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15. Click Next. The Summary Installation window opens. The installation summary displays
settings you have specified in previous steps.

@ Archive Manager Installation Wizard

WELCOME Summary Installation
PLANNING

Thig is the installation summary.

INSTALLATION

Components to be installed:
TOOLS

SETUPS Product name: Archive Manager for Exchange Version: 8.3.0.158

Installation folder: C:'Program Files 86)\Metalogix

Metalogix

Manage the Organizational Forms Librany
Start Metalogix Archive Manager for Exchange

< Back Install > Cancel

a. Select Manage the Organizational Forms Library if your organization uses this public folder
to share email templates. Otherwise, clear the check box.

b. Select the check box Start Metalogix Archive Manager for Exchange to open the Archive
Manager for Exchange Administration Center (AMAC) when the installation completes.

16. Click Install to start the installation.

17. When the installer starts installing the Archive Manager for Exchange feature, the Select
Features window of the Archive Manager for Exchange opens.

Archive Manager for Exchange

Select Features
Select the features setup will install.

x

‘3

- [] Application Server
[]PST Imparter

[+] Administrative toal
[JForms Installer
[+]auditing

- [ Monitoring service
=-[|Documentation

0.00 MB of space required on the C drive
109207.08 MB of space available on the C drive

Select the features you want to install, and deselect the features you want to uninstall,

Description

Application server contains
the core services for an
Archive or Retrieve Server. It
is not recommended to install
the Application services on
the Exchange Server, For
maore information please read
the Installation guide.

< Back

Only the following features are required
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e Application Server

e Administrative tool

e Auditing

Click Next to install the features.

18. Click Next to continue the installation. If a feature installation fails or completes with a
warning, expand the row to view and address the problem.

Archive Manager Installation Wizard >
2 9
WELCOME Installation Help
PLANNING
INSTALLATION DCOM access and launch permissions o Complefed W
TEEE Archive for B ®© complersd v
SETUPS Archive Manager Multitenant installation ° Complefed N
Archive Manager Auditing installation o Complefed
Starting services ° Complefed
»
Metalogix

19. Click Finish to complete the installation step.

20. The Archive Manager for Exchange Administration Center (AMAC) should open automatically
if the check box Start Metalogix Archive Manager for Exchange was checked in the Summary
Installation step of the installation wizard.

21.The Address Book Setup wizard opens automatically for a new installation. Click Close to exit
the wizard. Then close the Address Book Manager window that opens.
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Steps to configure and verify the Retrieve server
1. If the AMAC s not already open, click Start > Archive Manager for Exchange. The AMAC opens.

2. From the Tools menu select Options. The Options window opens.

s Options

Options

Server Role

PublicFolders  Auditing

Server role
E; Server settings Select the server role:
Retrieve Server e
il o =
N ALINVINUSELLiTgE Selecting the server role defines which tasks can be performed on the given

server, For example a retrieve server will never run scheduled tasks or
address book synchronization. It is important to note that two archive
m MESEaUER HesEs servers are not allowed in the same location.

zap fan=s

gply

3. Fromthe Select the serverrole drop down list, select Retrieve Server.
4. Click OKto set the server role and close the window.

Archive Manager for Exchange

Session  View  Tools  Help
FlRRXDSS D2 En
Groups "Settings " PublicFolders "Jobs "Retention " Locations ]
Set filker | | Clear filker |
Group name Alias Property Value
‘. ﬂlSewel Role: Retrieve Sewell Loaded FullAccess Manager

On the status bar at the bottom of the AMAC window, verify that the Server Role is set to
Retrieve Server.
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5. Open Start > Metalogix > Archive Manager Configuration. The Configuration wizard opens.

% Configuration

Configuration

:i Users Installed products

LU sireinge Flugin path: CiProgram Files (x86)\Camman FilesiPaMiPamConfighPluginsiMultTenantParmConfig, MUETenant ., dil

= chante Users
Status: Loaded

Exchange Archive
Plugin path: C:\Program Files {x86)\Common FilesiPAM\PamCanfigiPluginsiPAM4E:xchange\PamCanfig.ExchangePam. dll
Status: Loaded

Select the product to canfigure on the left side.

6. From the navigation panel, click Users. The Configure Users window opens and the Database
tab is displayed by default.

% Configuration

Configure Users

Database

Provider: Microsoft SQL Server
1 Exchange
[ ] ' ArChive Server name: AMXDB
Initial catalog: MAMUSER
Table owner: dbo
User name: (Windows Authentication)
LIPS —

Database version: 8.2.0.30

Scripts version: 8.2.0.30

‘ @ ‘Your database is up to date.
\ / Execute scripks...

Verify that the values are as expected.
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7. From the navigation panel, click Exchange Archive. The Configure Exchange Archive window
opens and the Database tab is displayed by default.

Configuration

Configure Exchange Archive

Database

COTITECTION ==

- Provider: Microsoft SQL Server
Enchange
w Archive Server name: AMXDB
Initial catalog: MAMEXCH
Table owner: dbo
User name: (Windows Authentication)
[ L — ————————
Databaseversion:  8.2.0.140
Scripts version: 8.2.0.140

€4 Your database is up to date.

Execute scripts. .,

Verify that the values are as expected.
8. Close the Configuration wizard.

9. Open Start > Windows Administrative Tools > Computer Management. The Computer
Management console opens.

10. From the Console Tree, expand Local Users and Groups.

11. Click the Groups node to display the list of groups.

> @ Performance
ﬁ Device Manager

%-i Event Log Readers

@Gue;ts

*-iStDragE Replica Admi...
%'Sy;tam Managed Acc...

%J Users

Members of this group can read event logs from local m
Guests have the same access as members of the Users gr

v E Storage *-iHyper-V Administrators  Members of this group have complete and unrestricted
> @ Windows Server Backup %HIS_\USRS Built-in group used by Internet Information Services.
& Disk Management %JNetwork Configuratio... Membersin this group can have serme administrative pri
> ?ﬁ Services and Applications %J Performance Log Users  Members of this group may schedule logging of perforn
%i Perfermance Meniter .. Members of this group can access performance counter
*-l Power Users Power Users are included for backwards compatibility ar
%-i Print Operators Members can administer printers installed on domain cc
%JRDS Endpeint Servers  Servers in this group run virtual machines and host sessii
%-i RDS Management Ser... Servers in this group can perform routine administrative
%i RDS Remote Access 5. Servers in this group enable users of RemoteApp prograr
%J Remote Desktop Users  Members in this group are granted the right to logon rer
%-i Remote Management... Members of this group can access WMI resources over n
%-i Replicator Supports file replication in a demain

Members of this group have complete and unrestricted §
Members of this group are managed by the system.

Users are prevented from making accidental or intention

& Computer Management - m] K
File Action View Help
e aFm XE = B
& Computer Management (Local] || Name Description Actions
v W Syst;kaSD::sd | %‘Acce;s Contrel Assist.. Members of this group can remotely query authorizatior| | Groups -
’ gé? Eas t;_ Eauler Administrators Administrators have complete and unrestricted ace More Actions »
; & S:en d :‘T:r %J Backup Operators Backup Operators can override security restrictions for th
> ared Folders 3 -
o @ Local Users and Groups @Certlflcata Service DC...  Members of this group are allowed to connect to Certifi¢ | Administrators -
] Users %' Cryptographic Operat... Members are authorized te perform cryptographic operz More Actions »
| Groups %JDistnbuted COM Users  Members are allowed to launch, activate and use Distrib
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12. Right-click Administrators and select Properties from the context menu. The Administrators
Properties window opens.

Administrators Properties ? d
General
% Administrators
Description: Administrators have complete and unrestricted access

to the computer/domain

Members:
& DEMOCORP domadmin
52, DEMOCORP \Domain Admins

& DEMOCORF \mamadmin
A domadmin

Changes to a user's group membership
Add... BRemove are not effective until the next time the
user logs on.

Cancel Apply Help

Verify that the superuser account is listed in the Members panel. For example,
DEMOCORP\mamadmin

13. Click OK to close the properties window, and then close the Computer Management console.
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6

Manual Installation

Manual installation gives you a more granular control over the installation process. Manual
installation does not use the integrated installer wizard that was used to demonstrate Express
installation in the Quick Start Guide or the Advanced installation described in the Advanced
Installation chapter in this guide. This chapter describes in detail the manual steps required to
prepare the servers, install the Metalogix Archive Manager for Exchange features by using the
individual installers for each feature, and the manual steps to setup the databases and configure
the features to communicate with each other as described in the Deployment Plan.

In this chapter:

e Setup the Superuser Account

e Modify the Exchange server throttling policy

e Setup the Organizational Forms Library

e Prepare the Metalogix Archive Manager for Exchange Servers

o Steps to download the install media

o Steps to install the prerequisites

o Steps to assign DCOM access and launch permissions

o Steps to install Microsoft Qutlook

e Install Metalogix Archive Manager for Exchange

o Install HSM

o Install Archive Manager Search

o Install the Archive server

o Install the Retrieve server

i | NOTE: The installation and configuration of optional features are described in detail in the
guides published for each feature.

For next steps after you complete the manual installation, see Application Configuration.

Setup the Superuser Account

A superuser account is a windows account with administrator privileges to work with Metalogix
Archive Manager for Exchange administration tools, run services, manage databases, manage
extensions. It also has elevated privileges to interact with the on-premise or online Microsoft
Exchange servers.
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In this topic:

1. Steps to create the superuser account

2. Steps to grant the superuser read permission for the Container node in the domain controller

3. Steps to add the superuser to the Administrators group in feature servers

4. Stepsto add the superuser as a database user with sysadmin role (for Windows authentication
only)

5. Steps to create a mailbox for the superuserin the Exchange server

6. Steps to grant the superuser elevated roles and permissions in the Exchange server

7. Steps to grant the superuser impersonation rights in the Exchange server (for OWA)

Steps to create a superuser account

1. Logintothe domain controller.

2. Navigate to Start > Windows Administrative Tools > Active Directory Users and Computers.
3. Fromthe Console Tree, expand the domain node.

4. Click the Users container. The list of users opens in the right-hand pane.

5. Click the Action menu and select New > User. The New Object - User window opens.

MNew Object - User d

; Create in:  democom .com//Users

Ui

First name: |I'\"IAM | Inttials: I:l
Last name: |Administlatnr |
Full name: ||'\"|A|"!'| Administrator |

User logon name:

|marnadmin | @democomp.com e

User logon name {pre-Windows 2000):
|DEMOCOHP\ | |mamadmin

< Back Mext = Cancel

6. Verify that Create in title indicates the appropriate domain name and container, and then
enter the details of the superuser. For example:

a. Full name: MAM Administrator
b. Userlogon name: mamadmin@democorp.com
7. Click Next.

8. Enterthe password and confirm it. Then select Password never expires. Uncheck all other
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check boxes.

9. Click Next.

New Object - User X

Createin.  democorp.com/Users
2

When you click Finish, the following object will be created:

Full name: MAM Administrator
User logon name: mamadmin@democomp .com

The password never expires.

< corce

10. Verify the information and click Finish.

Steps to grant the superuser read permission for the
Container node in the domain controller

Microsoft Exchange servers and other information stores are created as child nodes under the
CN=Services,CN=Configuration,DC=<root domain>node in the domain controller. The superuser
needs sufficient permissions to read the list of Exchange servers and information stores of the
organization. A read permission must be granted to the superuser to be able to access the object
and all its descendant objects.

1. Login to the domain controller.
2. Navigate to Start > Windows Administrative Tools > ADSI Edit.

3. Click the Action menu, and then click Connect to. The Connection Settings window opens.
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Connection Settings >

Mame: | Configuration |

Path: |LDAP:,.',.'AM:!{DC.sales.democorp.comﬂ:onﬁguraﬁon |

Connection Point
() Select or type a Distinguished Name or Maming Context:

| > |

(®) Select a well known Naming Context:

Configuration e

Computer

(") select or type a domain or server: (Server | Domain [:port])

| St

(®) Default (Domain or server that you logged in to)
[JUse 55L-based Encryption

Advanced. .. Cancel

4. Inthe Connection Point frame, choose Select a well known Naming Context. From the drop
down list select Configuration.

5. Click OK. The Configuration context appears in the ADSI editor.

6. Expand or select the Configuration context to display the node (begins with
CN=Configuration).

7. Right-click the node and select Properties.
8. Inthe properties window, click the Security tab, and then click Add.

9. Inthe Enter the object name to select field, enter the user logon name of the super user. For
example, enter democorp\mamadmin.

10. Click Check Names to verify the logon name.

Select Users, Computers, Service Accounts, or Groups >

Select this object type:
|User5, Service Accounts, or Groups | Object Types...

From this location:

|democorp.com,ﬂ.]sers | Locations...

Erter the object names to select (examples):

MAM Administrator (mamadmin@democorp. com) Check Names
Advanced... QK Cancel

11. Click OK to add the superuser to the Administrator group.
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CN=Configuration DC=sales,DC=democorp,DC=com Pro... ? >

Atribute Editor  Security

Group or user names:

42 Domain Admins (SALES'Domain Admins) ~
42 Enterprise Admins (SALES"Enterprise Admins)

4R Administrators (SALES'Administrators)

4% ENTERFPRISE DOMAIN CONTROLLERS

x MAM Administrator (mamadmin @democorp. com)
v

Add.. Remave

Pemissions for MAM Administrator

&
=

>

Full cortrol

Read

Wite

Create all child objects
Delete all child objects

OOOE %

RN

<

For special permissions or advanced settings, click Advanced
Advanced. -

Cancel Boply Help

12. Click Advanced. The Advanced Security Settings for Configuration window opens.

13. From the Permissions tab, select the superuser, and then click Edit. The Permission Entry for
Configuration window opens.

14.In the Applies To drop down select This object and all descendant objects.
15. Click OK, and then click OK in each parent window to close all the windows.

16. Close the ADSI editor.

Steps to add the superuser to the Administrators
group in feature servers

The superuser must be able to run windows services and accomplish tasks that require
administrator privileges on the Metalogix Archive Manager for Exchange feature servers. Follow
the steps described below to grant administrator privilege to the superuser on each feature
server.

1. Loginto each server with its local administrator credentials.
2. Navigate to Start > Windows Administrative Tools > Computer Management

3. From the Console Tree, navigate to the System Tools > Local Users and Groups > Groups
container.

4. From the list of groups in the right-hand pane, right-click Administrators and select Properties
from the context menu. The Administrators Properties window opens.

5. Click Add.

6. Inthe Enter the object name to select field, enter the user logon name of the super user. For
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7.

example, enter sales\mamadmin

Click Check Names to verify the logon name.

Select Users, Computers, Service Accounts, or Groups >

Select this object type:
|Users, Service Accounts, or Groups | Object Types...

From this location:

|demncnrp.comﬁ_lsers | Locations...

Enter the object names to select (examples):

MAM Administrator (mamadmin@democorp. com) Check Mames
Advanced... 0K Cancel

Click OK to add the superuser to the Administrator group.
In the Administrators Properties window, click Apply and OK to complete the process.

TIP: Log out of the server and log in again with the superuser's credentials to quickly verify
that the superuser can access the server.

Steps to add the superuser as a database user with
sysadmin role

If you plan to use Windows authentication with a Microsoft SQL Server database, follow the steps
described below:

1
2.

Login to the database server with your database administrator credentials.

Open the SQL Server Management Studio on your SQL server database server.

Login to the serverinstance for Metalogix Archive Manager for Exchange databases.
Open the Security folder.

Right-click on the Logins folder and select New Login. The Login - New user properties window
appears.

If you want to assign rights to a Windows account, select Windows authentication.

Provide the login name in the text box. You can use the Browse button to select an existing
account if you chose Windows authentication (eg. democorp\mamadmin)

In the user properties window, click Server Roles from the Select a page panel and select the
check box Sysadmin.

Click OK to create the account.

NOTE: Follow the above steps to add the installer account (eg. democorp\domadmin) with
the Sysadmin role.
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Steps to create a mailbox for the superuser in the
Exchange server

1. Open the Exchange Administrative Center (EAC) with your exchange administrator credentials.
2. Navigate to recipients > mailboxes

3. Click +and select the User mailbox option from the menu. The new user mailbox page opens.
4. Select Existing user and then click Browse. The Select User - Entire Forest page opens.

5. If you don't see the superuserin the list, search for the name. Select the superuser and click
OK.

= User Mailbox - Google Chrome I;Ii-

@ amxexch/ecp/UsersGroups/NewMailboxOnPremises.aspx?pwmcid=118...

new user mailbox

Alias:

®) Existing user

MAM Administrator X

MNew user

First name:

Initials:

Last name:

*Display name:

*Mame:

Crganizational unit:

Browse...

Save Cancel

6. Click Save. The superuser mailbox appears in the mailboxes list.
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[J Enterprise  Office 365

Exchange admin center

o]

recipients mailboxes groups resources contacts shared migration

permissions

compliance management + - STPE -
I DISPLAY NAME & | MAILBOX TYPE EMAIL ADDRESS
Aman Ali User amanali@democorp.com
protection David Webb User davidwebb@demccorp.com
_ Devika Sharma User devikasharma@democorp.com
mail fio Domain Administrator User domadmin@democorp.com
mabil Ishna Mehan User ishnamohan@democorp.com
Juan Christie User Jjuanchristie@democorp.com
public folders Karl Jardan User karljordan@democorp.com
Miki Portman User nikiportman@democorp.com
unified messaging Nina Tanaka User ninatanaka@democorp.com
Pablo Neruda User pabloneruda@democorp.com
SErvers Tim Ashford User timashford@democorp.com
hvbrid MAM Administrator User mamadmin@democorp.com

1 selected of 12 total

Steps to grant the superuser elevated roles and
permissions in the Exchange server

Archive Manager for Exchange requires that the super-user be granted some administrative
permissions and access to the mailboxes which will be archived. The steps described below use
Powershell scripts to grant the roles and permissions to the superuser. To grant roles and
permissions to the superuser, follow the steps described below:

1. In Exchange Server, open the Exchange Management Shell.

2. Grant the roles and to ensures that the mailboxes and public folders can be accessed using the
required administrative privileges.

a. Grant the Organization Management role

Add-RoleGroupMember —-Identity "Organization Management" -Member
"mamadmin@democorp.com"

b. Grant the View-Only Organization Management role.

Add-RoleGroupMember -Identity "View-Only Organization Management" -
Member "mamadmin@democorp.com"

¢. Grant the Public Folder Management role.

Add-RoleGroupMember -Identity "Public Folder Management" -Member
"mamadmin@democorp.com"

d. Grant Receive-As permissions to all mailboxes
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Get-MailboxDatabase | Add-ADPermission -User "mamadmin@democorp.com" -
AccessRights ExtendedRight -ExtendedRights Receive-As, ms-Exch-Store-
Admin -InheritanceType "All"

Steps to grant the superuser impersonation rights in
the Exchange server

This step is required if you plan to access archived emails through OWA.

1 | NOTE: To install and configure the OWA extension for Metalogix Archive Manager for
Exchange, you must run the Archive Manager OWA Extension Setup on Exchange Server. For
more information see the OWA Installation Guide.

1. In Exchange Server, open the Exchange Management Shell.
2. Grant the Impersonation permission

New-ManagementRoleAssignment —-Name "Impersonation-MAM4Exchange" -Role
"ApplicationImpersonation” -User "srv_ exchange"

Modify the Exchange server throttling policy

Exchange Server uses client throttling policies to track the bandwidth that each user consumes
and enforces bandwidth limits as necessary. Metalogix Archive Manager for Exchange needs
more resources than the allowed limit, so the throttling policy must be changed for the
superuser.

To change the throttling policy in the Exchange server (for example, AMXEXCH), open the
Exchange Management Shell and run the following commands:

New-ThrottlingPolicy AMXEXCH

Set-ThrottlingPolicy AMXEXCH -EwsCutoffBalance Unlimited -EwsMaxBurst
Unlimited -EwsMaxConcurrency Unlimited -EwsMaxSubscriptions Unlimited -
EwsRechargeRate Unlimited -RcaMaxConcurrency Unlimited -RcaCutoffBalance
Unlimited -RcaMaxBurst Unlimited -RcaRechargeRate Unlimited -
CpaMaxConcurrency Unlimited -CpaCutoffBalance Unlimited -CpaMaxBurst
Unlimited -CpaRechargeRate Unlimited

Set-Mailbox "mamadmin@democorp.com" -ThrottlingPolicy AMXEXCH

Setup the Organizational Forms Library

Metalogix Archive Manager for Exchange stores email templates in a system folder called the
Organizational Forms Library. The templates are used to display archived emails to end users.
Before you can create the Organizational Forms Library folder in your Exchange server, you must
first create a public folder mailbox. Public folder mailboxes contain the hierarchy information as
well as the content for public folders. The first public folder mailbox that you create in the
organization is the primary hierarchy mailbox, which automatically sets up two folders: the

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

Manual Installation



IPM_SUBTREE and the NON_IPM_SUBTREE. An Organizational Forms Library is a system folder that
is stored in the public folder called the EFORMS REGISTRY which is a sub-folder of the
NON_IPM_SUBTREE system folder. There can be several forms libraries, one for each language.

In this topic:

e Steps to create a public folder mailbox

e Steps to create the public folder Organization Forms Library

e Steps to add the superuser as the owner of the Organizational Forms Library

e Verify that the superuser has access to the Organizational Forms Library

Steps to create a public folder mailbox

i | NOTE: This must be a primary hierarchy mailbox which is the first public folder mailbox in the
organization and hosts the primary hierarchy. The primary hierarchy is the only writable copy
of the hierarchy.

1. Open the Exchange Administrative Center (EAC) with your exchange administrator credentials.

2. Navigate to Public folders > Public folder mailboxes, and then click the new public folder

mailbox icon +

2 Public Folder Mailbox - Internet Explorer = [ = -

new public folder mailbox

The first public folder mailbox created will contain the writable copy of the public
folder hierarchy.

*MName:

PFMBX-DEMOCORP

Organizational unit:

democorp.com x Browse...

Mailbox database:

Mailbox Database 0748581819 x Browse...

Save Cancel

#1008 -

3. In the new public folder mailbox window that opens, enter the following information:

a. Name: Enter the name for the public folder mailbox. For example, enter PFMBX-
DEMOCORP

b. Organizational unit: Click Browse to select the location in the Active Directory where the
mailbox object is created. If you don't select an organizational unit, the public folder
mailbox will be created in the default container for mailboxes.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

Manual Installation



¢. Mailbox database: Click Browse to select the mailbox database where the mailbox is
created. If you don't select a mailbox database, it will be automatically assigned.

4, Click Save.

5. Verify that the mailbox appears in the public folder mailbox list.

Steps to create the public folder Organization Forms
Library

1. In Exchange Server, open the Exchange Management Shell.

2. Tocreate a new publicfolderin the NON_IPM_SUBTREE directory that's named Organizational
Forms Library, run the following command:

New-PublicFolder -Path "\NON_IPM_SUBTREE\EFORMS REGISTRY" -Name
"Organizational Forms Library"

3. Tosetthe locale ID on the folder that you created, run the following command:

Set-PublicFolder "\NON IPM SUBTREE\EFORMS REGISTRY\Organizational Forms
Library" -EformsLocaleID EN-US

4, To determine the correctlocale ID to use, see Languagecode Field.

Steps to add the superuser as the owner of the
Organizational Forms Library

1. In Exchange Server, open the Exchange Management Shell.

2. To add the superuser as the owner of the Organizational Forms Library folder so that the
superuser ca publish or create forms in the library, run the following command:

3. Add-PublicFolderClientPermission "\NON_ IPM SUBTREE\EFORMS
REGISTRY\Organizational Forms Library" -User mamadmin@democorp.com -
AccessRights Owner

1 | NOTE: If you're not sure about the name of the Organizational forms library in your
company, the following command can be used. It will owner rights to the child objects
under EFORMS REGISTRY:

Get-PublicFolder -Identity "\NON_IPM_SUBTREE\EFORMS REGISTRY" -
GetChildren | Add-PublicFolderClientPermission -User
mamadmin@democorp.com -AccessRights Owner

4. Wait some time for replication to occur until the super-user is assigned owner rights to the
Organizational Forms library.
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Verify that the superuser has access to the
Organizational Forms Library

1. Open Outlook with the superuser account.
2. Click Home / New Items / More Items / Choose Form.

3. Inthe Look in down-drop box verify that the Organizational Forms Library exists.

Prepare the Application Servers

In this topic:

For the Archive Manager Database server (AMXDB)

See the System Requirements and About User Accounts chapters for preparing database servers.

For the HSM and Search server (AMXHSM)

e Steps to download the install media

e Stepstoinstall the prerequisites

For the Archive server (AMXSERVER-A)

e Stepsto download the install media

e Steps toinstall the prerequisites

e Steps to assigh DCOM access and launch permissions

e Steps to install Microsoft Outlook

For Retrieve server (AMXSERVER-R)

e Steps to download the install media

e Stepstoinstall the prerequisites

e Steps to assign DCOM access and launch permissions

e Steps to install Microsoft Outlook

TIP: We recommend completing all these tasks using the installer account.
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Steps to install the prerequisites

These steps are optional and are included if you want to install them yourself. The installer
verifies prerequisites.

1. Login with the credentials of the local administrator.
2. Open PowerShell as an Administrator.

3. Toinstall the recommended windows roles and features for individual components that may
be distributed across other servers run the following PowerShell commands:

Archive Manager for Exchange (for Archive and Retrieve servers)

Install-WindowsFeature -Name Web-Server, Web-Http-Redirect, Web-Dyn-
Compression, Web-Windows-Auth, Web-Basic-Auth, Web-Metabase, Web-Mgmt-
Service, RSAT-AD-PowerShell, NET-Framework-45-Features, NET-Framework-
45-ASPNET, Web-Net-Ext45, Web-Asp-Netd45, NET-WCF-Services45, Web-Asp-Net

HSM

Install-WindowsFeature -Name Web-Server, NET-Framework-Features

Search
Install-WindowsFeature -Name NET-Framework-Features

i | NOTE: These PowerShell commands are compatible with a Window 2016 operating
system. Please refer to the System Requirements chapter to modify the script for other
supported Windows operating systems or install them manually.

4, Install the database drivers. For Microsoft SQL Server, the database driver is available in the
folder<installation folder>\Archive Manager Installation Package\Install.

5. Install the redistributable packages required for your operating system. These files are
available in the folder <installation folder>\Archive Manager Installation
Package\Install

Steps to assign DCOM access and launch
permissions

Add the superuser to the Distributed COM Users group
1. Right-click Start > Computer Management.
2. From the Console Tree, go to System tools > Local Users and Groups > Groups.

3. Fromthe Groups list, select an double-click Distributed COM Users. The Distributed COM
Users Properties window opens.

4, From the Generaltab click Add.
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5. Inthe Enter the object name to select field, enter the user logon name of the superuser. For
example, enter democorp\mamadmin.

Select Users, Computers, Service Accounts, or Groups >

Select this object type:

|Users. Service Accounts, or Groups | Object Types...

From this location:

|democorp.com,ﬂ.]sers | Locations...

Enter the object names to select (examples):
MAM Administrator (mamadmin@democorp. com) Check Names

Advanced... 0K Cancel

6. Click Check Names to verify the logon name and then click OK to add the superuser to the
members list.

7. Click OK to close the Distributed COM Users Properties window, and then close the Computer
Management console.

Grant Access and Launch Permissions
1. Open Start > Windows Administrative Tools > Component Services.
2. From the Console Tree, go to Component Service > Computers > My Computer.

3. Right-click My Computer and select Properties from the context menu. The My Computer
Properties window opens.

My Computer Properties ? *
General Cptions Default Properties
Default Protocols COM Security MSDTC

Access Pemissions

You may edit who is allowed default access to applications. You may
also set limits on applications that determine their own permissions.

Caution: Modifying access pemissions can affect the ability
! of applications to start, connect, function and.for run
securely.

Edit Limits... Edit Default...

Launch and Activation Pemissions

You may edit who is allowed by default to launch applications or
activate objects. You may also set imits on applications that
determine their own permissions.

Caution: Maodifying launch and activation pemmissions can
! affect the ability of applications to start, connect, function
and/ar nun securghy.

Edit Limits... Edit Default...

Leam mare about setting these properties.

oK Cancel Apply
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4. Open the COM Security tab and click Edit Default. The Access Permissions window open.

5. Click Add. The Select users or Groups window opens.

6. Click Locations and select the Archive Manager server (for example, AMXSERVER-A)

7. Search and add the following:
a. Distributed COM Users

b. NETWORK SERVICE

8. Select Distributed COM Users from the list.

9. Inthe Permissions for Distributed COM Users section, select Allow for both Local Access and

Remote Access.

10. Select NETWORK SERVICE from the list.

11. In the Permissions for Distributed COM Users section, select Allow for Local Access only.

Access Permission ?

Default Security

Group or user names:

>

SR SELF

SR SYSTEM

H® NETWORK SERVICE

SR Administrators (AMXSERVER-X\Administrators)

A Distributed COM Users (AMXSERVER-X\Distributed COM U...

Add... RBemove
Pemissions for Distributed COM
Users Allow Deny
Local Access [
Remote fccess [l
Cancel

Access Permission ? *

Default Security

Group or user names:

BB SELF

HE SYSTEM

2 Administrators {AMXSERVER-C Administrators)

SR Distributed COM Users (AM¥SERVER-X\Distibuted COM 1J...

Add... Bemove
Permissions for NETWORK
SERVICE Allow Deny
Local Access |
Remote Access O |
Cancel

12. Click OK to close the Access Permissions window.

13. Keep the My Computer Properties window open and continue with the instructions below.
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Grant Launch and Activation Permissions to the Distributed COM Users
group
1. From the My Computer Properties window verify that the COM Security tab is opened.

My Computer Properties ? >
General Options Default Properties
Default Protocaols COM Security MSDTC

Access Pemissions

You may edit who is allowed default access to applications. You may
also set limits on applications that determine their own permissions.

Caution: Modifying access pemissions can affect the ability
of applications to start, connect, function and.for run
securely.

Edit Limits... Edit Default...

Launch and Activation Pemissions

You may edit who is allowed by default to launch applications or
activate objects. You may also set imits on applications that
determine their own permissions.

Caution: Maodifying launch and activation pemmissions can
affect the ability of applications to start, connect, function
and.for un securely.

Edit Limits... Edit Default...

Leam mare about setting these properties.

oK Cancel Apply

2. Click Edit Default. The Access Permissions window open.
3. Click Add. The Select users or Groups window opens.
4. Click Locations and select the Archive Manager server (for example, AMXSERVER-A)
5. Search and add the following:
a. Distributed COM Users
b. NETWORK SERVICE

6. Select Distributed COM Users from the list.

7. Inthe Permissions for Distributed COM Users section, select Allow for Local Launch, Remote

Launch, Local Activation and Remote Activation.

8. Select NETWORK SERVICE from the list.

9. Inthe Permissions for Distributed COM Users section, select Allow for Local Launch and Local

Activation only.
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Launch and Activation Permission ? * Launch and Activation Permission ? *

Default Security Default Security
Group or user Names: Group or User names:
SR SYSTEM SR 5YSTEM
SR Administrators (AMXSERVER-X\Administrators) SR Administrators (AMXSERVER-C Administrators)
| Diistributed COM Users (AMXSERVER-\Distributed COM U... ER Distributed COM Users (AMXSERVER-X\Distibuted COM ...
SR INTERACTIVE SR INTERACTIVE
S8 NETWORK SERVICE INETWORK SERVICE
Add... Remove Add. . Remove
Pemissions for Distibuted COM Pemissions for NETWORK
Users Allow Dery SERVICE Allow Deny
Local Launch [l Local Lsunch |
Remote Launch [ Remate Launch J 1
Local Activation [l Local Activation |
Remote Activation [l Remate Activation O |
== ==

10. Click OK to close the Access Permissions window.

11. Close the Component Services console.

Steps to install Microsoft Outlook

The Metalogix Archive Manager Server communicates with on-premise and online Microsoft
Exchange servers via MAPI. To provide your Archive Manager server with a MAPI subsystem,
install Outlook with full Unicode compatibility. See System Requirements for version
compatibility with your Microsoft Exchange servers.

Steps to download the install media

1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

2. From your browser, navigate to the https://www.quest.com/products/metalogix-archive-
manager-for-exchange page

or

navigate to the http://www.quest.com/trials page. Locate the product Metalogix Archive
Manager for Exchange.

3. Click the Download Free Trial button.

4. Fill the Download Your Free Trial registration form and click Download Trial. The file download
page appears.
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5. Download the install media zip file.
6. The the trial license key is specified in the email that is sent to you.

7. Ensure that the files are available locally on the computer on which you are planning to install
the Metalogix Archive Manager for Exchange features.

Install the Application Features

This topic describes the manual installation steps for each feature and feature that comprises a
single-server installation.

In this topic:
e [nstall HSM

e Install Archive Manager Search (with Post-processing)

e Install the Archive server

e Install the Retrieve server

Install HSM

In this topic:

e Worksheet for this installation

e Stepstoinstall HSM

e Steps to configure the HSM database connection

e Steps to install the HSM database

e Steps to configure the HSM stores and schemas

Worksheet for this installation

The following information will be required through the installation process. Sample values are
provided here as a guidance.

Item Description Example
HSM server The server where the HSM and AMXHSM
Archive Manager Search will be
installed.
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Superuser account

Media folder

Installation folder

HSM Store folder

Store name

Schema name

Database Authentication
method

UserLogin

Password

Database server

Windows account that is used to
install the application and run
the Archive Manager for
Exchange services.

Full path of the folder where the
media files are extracted

Full path of the folder where the
application files will be installed

Full path of the folder that will
contain the archived files.

Name of the media store on a
hard drive. With the Advanced
Installation option of the
installer wizard, only a local hard
drive can be setup as a media
store.

Name of aschemain a hard
drive media store.

Type of database
authentication: Integrated
Windows Authentication or SQL
Authentication

Username if SQL Authentication
is selected

Database password if SQL
Authentication is selected

The database server instance
name where the databases for
Archive Manager for Files will be
installed.

username:
democorp\mamadmin

password. ok ok ok ok ok ok ok ok ok Kok ok

C:\Metalogix
C:\Program Files (x86)
\Metalogix

C:\HSM

The local hard drive folder s
used as the default media store.
Use of other media storage
systems are described in the
Media Store Administration
Guide.

FILESTORE

FILESCHEMA

Integrated Windows
Authentication

dbadmin

3k 3k 3k 5k 3k sk sk sk sk sk ok sk ok k
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Steps to install the application

1. Logintothe server (eg. AMXHSM) with the credentials of the superuser (eg.
democorp\mamadmin)

2. Download the installation media. For more information see Steps to download the install
media.

3. Run the Metalogix Archive Manager Installation Package to extract the files to a local folder.
4. Close the integrated installer wizard which starts automatically.

5. Runthe HSMsetup from <Media folder>\Archive Manager Installation
Package\HSM\HSM Setup.exe

6. A prerequisite check occurs and missing requirements if any are displayed. Click Install to
ensure all missing requirements are installed.

7. The Welcome window of the HSMinstaller opens.

HsM x

Welcome to the InstallShield Wizard for HSM

The InstallShield Wizard will install HSM on your computer,
To continue, dick Mext.

8. Click Next. The Logon Information window opens.
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HS5M

Specify the user account to be used by this application. User accounts must be in the format
DOMAINWsername,

User name:

| democorpmamadmin |

Password:

Confirm password:

Logon Information ‘
Spedfy a user account and password, >

Enter the information as described below:

a. Username - logon name of the superuser (for example, democorp\mamadmin)

b. Password - logon password of the superuser
c. Confirm password - same as the Password.

9. Click Next. The Firewall Settings window opens.

HSM

Allow programs to communicate through Windows Firewall

Firewall Settings “
>

Select Allow programs to communicate through Windows Firewall.

10. Click Next. The Ready to install the Program window opens.
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HSM x
Ready to Install the Program “
The wizard is ready to begin installation. F"’

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

11. Click Install. The installation starts and the progress is displayed on the Setup Status window.

When the installation completes, the InstallShield Wizard Complete window opens.

HS5M

Installshield Wizard Complete

The InstallShield Wizard has successfully installed HSM.  Click
Finish to exit the wizard.

12. Click Finish to close the installer.

Steps to configure the HSM database connection

1. When the installation completes, the Configuration wizard opens. If it does not open
automatically, click Start > Metalogix > Archive Manager Configuration.

2. Fromthe feature panel on the left, click HSM and select the Database tab.

3. Click Configure. The Database Connection Wizard opens.
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Database configuration

Database Connection Wizard

The Database Connection Wizard will help you to set up your server. It allows you to specify the
database provider and describe the database connection parameters.

Flease selectthe database provideryou wantto use:

f* Microsoft SQL Server

" Oracle

Thefollowing page will letyou specify the database connection parameters.

_  ewosles

Select either Microsoft SQL Server or Oracle and click Next. If you choose Microsost SQL
Server, the Database Connection window opens for the Microsoft SQL Server connection
information.

Database configuration

Database Connection Wizard

Set up your Microsoft SQL Server connection.

Flease enter parameters which will be used to create a connection to your Microsoft SQL Server.
Server name: |AMXDB |
Initial catalog: |MAMH5|'“'| |
Schema name: |dbo |
Authentication: | Windows Authentication < |
User name: | |
Password: | |

For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMHSM which is the default name of the
HSM database)

¢. Schemaname - name of the SQL Schema (e.g. dbo)

d. Authentication — authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

e. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.
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5.

6.

For Oracle

a. Oracle net name - net service name that describes the network address of the database
serverinyour tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.
¢. User name - database login user name.
d. Password - password of the database user.

Click Next and then click Yes on the confirmation dialog that opens.

Database configuration

@ Database does not exists on the server. Shall wetry to create it?

| Yes | | Mo |

If the database connection is setup successfully, the configuration completion window opens.

Database configuration

Database Connection Wizard

You have successfully finished the Database Connection Wizard!

Click on Finish to save your database connection parameters and update configfiles.

If you have not done so already, you can execute the database soripts to create the necessary
database objects.

7. Click Finish to close the Database Connection wizard.

Steps to install the HSM database

1. From the feature panel on the left in the Configuration wizard, click HSM and select the

Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

scriptinstaller wizard opens.
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Database configuration

Set up the database

& Specify the user under which to execute database scripts.
Please specify user under which to execute database soripts. The user must be allowed
to create or modify tables and procedures in the database.

f+ sethe default credentials

" Usedifferentcredentials

Authentication: |'I.“J'i|‘IdDWS Authentication - |

Database user: | |

Password: | |

 emesies

Select Use the default credentials to use the information displayed in the Database
connections section. If you select Use different credentials, enter the following information:

a. Authentication - authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

a. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

b. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

Click Next.

Database configuration

Set up the database

', Select the method for setting up the database.
[ ]

Flease select the way you want to set up the H5M database:

{+ Execute the database scripts by this wizard

(" Get the database scripts and execute them manually

s

In the Select the method for setting up the database step, choose one of the following
options:

a. Run the database scripts by this wizard - the installer will automatically run the scripts to
create the tables and procedures required for the database.
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b. Getthe database scripts and run them manually - you get the option to either save the
scripts or copy it to clipboard and paste it elsewhere.

Click Next. Depending on your selection, one of the following windows open:
For Run the database scripts by this wizard

Database configuration

Set up the database

V Select the database objects you want to create.

Flease select database scripts you want to execute.

% [wl Create tables

“43 I Create procedures

 eaaosiecs

Select both check boxes: Create tables and Create procedures.

For Get the database scripts and run them manually

Database configuration

Set up the database

ra Get the database scripts you want to execute manually.

Get the selected scripts and execute them manually in an external application.

% Tables Qﬁ Procedures
Save the seript... Save the script...
Copytodipboard Copytoclipboard

 eaaosiecs

You must run both the scripts for a successful database installation.

Click Next. Depending on your selection in step 4, one of the following windows open

a. If you chose Run the database scripts by this wizard, and the installation is successful, a
confirmation dialog opens. Click OK to close the dialog.

b. If you chose Get the database scripts and run them manually, you must run the scripts
immediately because a confirmation dialog will verify whether you ran the scripts.
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Confirm

]

7 Please confirm that you have successfully executed
thefollowing database scripts:

[w] Tables
[w] Procedures

Select both check boxes after you run scripts and click OK.

7. If the installation is successful, the confirmation dialog opens. Click OK to close the dialog. The
database setup completion window opens.

Database configuration

Set up the database

\. Database setup wizard has finished.

The database scripts were executed successfully.

e

8. Click Finish to close the script installer. The Scripts section of the Configuration wizard displays
the status and version of the scripts(the version of the scripts you install may differ from the
version shown in the image below).

= Configuration
Configure HSM
Database
— et DaSE COneCT S—
O S
Provider: Microsoft SQL Server
Server name: AMXDB
Initial catalog: MAMHSM
Table owner: dbo
User name: (Windows Authentication)
SCrIpES ———
Database version: 8.3.0.39
Scripts version: 8.3.0.39
‘ €4 Your database is up to date, ‘
Execute scripks...
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9. Keep the Configuration wizard open for next steps.

Steps to configure the HSM stores and schemas

1. From the feature panel on the left of the Configuration wizard, click HSM and select the Stores
tab.

2. From the Stores section click New Store. The Create a new media Store window opens.

Media Store Administration Wizard

Create a new Media Store

Choose a name and type for the Media Store.

Media Skare type: | Jukebox, Harddisk, Netwaork Share - |

Marme of the new Media Stare: |FILESTDRE |

I

3. Click Next. The location information window opens.

Media Store Administration Wizard

ox, Harddisk, Network Share

Choose a location where the archived files should be saved.
Use asupported storage provider forthis Media Stare.

Storage provider : | Hard disk, UNC Path -~ |

Path for the Media Store: |CI1I|HSM Browse...
Allow multiple saving: O

Path for multiple saving: | | Browse...
Path for fast file access: | vl

Retention time suppoart: | <MNone = = |

e

Enter the information as described below;

a. Storage Provider - select Hardisk, UNC Path because we are going to setup a media store in
folder on the local hard drive.
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b. Path for the media store - Browse and create the folder if it does not exist (eg. C:\HSM).
You could specify a UNC path to a shared folder as well.

4. Keep clicking Next to accept the default settings on each window until you reach the HSM
server connection information window. Every media store must provide this information so
the HSM server can connect to it. For more information about various media stores see the
Archive Manager for Exchange - Media Store Administration Guide.

Media Store Administration Wizard

Jukebox, Harddisk, Network Share

D Please choose the PamServers where the Media Store should connect to:
Please choose how long the Media Stores pauses before it tries to connect to

the PamSarvers. This gives the Pam3erver the possibility to start completly

before the Media Store tries to connect to this PamServer the first time.

HSM Servers where the Media Store should connect to:

AMYXHSM{HSM)

Add Server B

Add--- Specify the server where this store should connect.

Connection interval between the Media

o

Server type: |HSM Server -

Server name: |AMXHSM |

| o4 || Zancel |

5. Click Add. The Add Server window opens. Enter the following information:
a. Servertype - select HSM Server
b. Server name - name of the server where HSMis installed (eg. AMXHSM)
6. Click OKto close the window and add the the HSM Server to the list.

7. Click Next. The final configuration window appears.
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Media Store Administration Wizard

Jukebox, Harddisk, Network Share

The wizard has finished collecting the information needed to create the Media
Store.

Relative speed of the store:

Use HSM Cache for read operations: O
Write protection {(mark as read-only): [

Re-create service for this Media Store: [

I

8. Accept the defaults and click Finish. The Service Restart window opens.

Restart service

Service restart needed

To apply the changes you have made, the following services should be

restarted:
Marne | Status |
DMAM H5M Base Operations Running

[w]mMamM HSM Asynchronous Operations  Stopped

Do youwant to restart the selected services?

- - -

Select one or more check boxes where the Status indicates Stopped. Click Yes to restart the
service so that the HSM service is aware of the media store configuration.

9. Verify that the media store information appears in the Stores tab of the Configuration wizard.

10. From the Schemas section in the Stores tab of the the Configuration wizard, click New Schema.
The Create new schema window opens.
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HSM Schema

Create new schema

Store: | FILESTORE@AMXHSM M |

Schema name: |F1|-E5CHEI'“'IA |

Enforce store: O

Encryption: | <none = M
Task: | <none > -
Compression: O

Exclude files: |.gz;.zipj.rarj.jpg |

Use ;" as separator and include the "." in extensions.
Example: .zip;.jpa;.rar

Packer: | <none T |

e

Enter the following information:

a. Store field - verify that it indicates the media store you just created.
b. Schemaname - enter a name for the schema (eg. FILESCHEMA)

11. Click OK to save the schema information. In the Service Restart window opens, select one or
more check boxes where the Status indicates Stopped. Click Yes to restart the service so that
the HSM service is aware of the schema information.

12. Verify that the schema information appears in the Schemas section of the Stores tab in the
Configuration wizard.

T.: Configuration

Configure HSM

& Stores

Id I Name | Server | Mirror cfl State
1 FILESTORE AMXHSM Running

New;tore = [ Setup... |3 Delete nPrimary Manage.‘. vREfrE;h

h T
Id I Name | Store Server | Force Store | Encryption Key | Compression I Task

1 FILESCHEMA FILESTORE AMXHSM

Create... g Edit... [ Delete Test... Refresh

13. Close the Configuration wizard.

1 | NOTE: The steps to create a local media store described above with default values completes
the HSMinstallation. HSM offers more capabilities that can be configured. Configuration of
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HSM s described in detail in the HSM Installation and Configuration Guide. A large selection
of media store types that are supported by Metalogix Archive Manager for Exchange are
described in the Media Store Administration Guide.

Steps to test the HSM and Media Store connectivity
1. Open the Configuration wizard and select HSM from the feature panel.

2. Click the Stores tab. Then click Test from the Schemas section. The HSM Test window opens.

HSM Test i
H5M Server: AMFHSM. demaocorp. com
File identifier:

Mame to Fileld...
Identifier type: * Hsmld { Guid

g}\rchive... ﬁRetrieve -nDeIete @Set retention... EMass actions -

Cloze

3. Click Archive. The Archive window opens.

l

Archive

Target schema: FILESCHEMA (FILESTORE) -
Retention time: (% Fixed value |0 =4 months

" Infinite

" Indefinite

% Usegenerated test files

Unique content: | 2020092723000026723376dbdad49508043 1b80d988b473f0254d

Original filename: | TestFile.txt
i~ Usea spedfictestfile
Path to test file: =

Options: ¥ Make each file unique [~ Forcecompression
[~ Useinvalid checksum [~ Forcenocompression

[~ Archive empty file [~ Enablelogging

| Archive | | Close: |

Keep the default test file settings. Copy the value in the Unique content field if you wish to
test the retrieve process.

4. Click Archive. The Result window opens.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

Manual Installation



%/ Step1l: Success
HsmId: 1
Guid: nfa
W' Step2:  Success
Hsmld: 2
Guid: nfa
Elapsed time: 00:00:00.2023647
File size: 32.0 KB (32768 bytes)

5. Verify that the result indicates success. Then click OK to close the Result window. Then close
the Archive window.

6. Inthe HSM Test window, enter the name of the file that was archived in the Media Store
during the archive test.

HSM Test i
H5M Server: AMFHSM. demaocorp. com
File identifier: 00000001

Mame to Fileld...
Identifier type: * Hsmld { Guid

g}\rchive... ﬁRetrieve -nDeIete ESE‘: retention... EMass actions -

Cloze

For example if the TestFile.txt was archived as 00000001.txt, enter 00000001 in the File
Identifier field.

7. Click Retrieve. The Result window opens.

]

Retrieve result

%/ Result: Success
Id: 1
Name: TestFile.bd
Size: 32.0 KB (32768 bytes)

Elapsed time: 00:00:00.0476363

| Save file... || oK |

8. Verify that the result indicates success. Then click OK to close the Result window. Then close
the other windows.
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Install Archive

Manager Search

The Archive Manager Search installer also installs the Post Processing service which allows a user

to run specific tasks on each archived message. Archive Manager Search can be installed on a
dedicated server, but in keeping with the topology described in the Deployment Plan we will
install the Archive Manager Search and Post Processing service on the same server where HSM

was installed (eg. AMXHSM).

In this topic:

For Archive manager Search

e Worksheet for this installation

e Steps to install Archive Manager Search (with Post Processing)

e Steps to configure the Search database connection

e Steps toinstall the Search database

e Steps to configure Search Scopes

For Post Processing

e Steps to configure the Post Processing database connection

e Stepstoinstall the Post Processing database

Worksheet for this installation

The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item

HSM server

Superuser account

Media folder

Description Example

The server where the HSM and AMXHSM
Archive Manager Search will be
installed.

Windows account that is used to | username:

install the application and run democorp\mamadmin

the Archive Manager for R ——
Exchange services.

Full path of the folder where the | C:\Metalogix
media files are extracted
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Installation folder

HSM Store folder

Store name

Schema name

Database Authentication
method

UserlLogin

Password

Database server

Full path of the folder where the
application files will be installed

Full path of the folder that will
contain the archived files.

Name of the media store on a
hard drive. With the Advanced
Installation option of the
installer wizard, only a local hard
drive can be setup as a media
store.

Name of aschemain a hard
drive media store.

Type of database
authentication: Integrated
Windows Authentication or SQL
Authentication

Username if SQL Authentication
is selected

Database password if SQL
Authentication is selected

The database server instance
name where the databases for
Archive Manager for Files will be
installed.

Steps to install Archive Manager Search

C:\Program Files (x86)
\Metalogix

C:\HSM

The local hard drive folderis
used as the default media store.
Use of other media storage
systems are described in the
Media Store Administration
Guide.

FILESTORE

FILESCHEMA

Integrated Windows
Authentication

dbadmin

3k 3k >k 3k >k 3k >k 3k %k %k k %k k k

AMXDB

1. Logintothe server where HSM was installed (eg. AMXHSM) with the credentials of the
superuser (eg. democorp\mamadmin)

2. Download the installation media. For more information see Steps to download the install

media.

3. Run the Metalogix Archive Manager Installation Package to extract the files to alocal folder.



Close the integrated installer wizard which starts automatically.

Run the Archive Manager Search setup from <Media folder>\Archive Manager
Installation Package\Archive Manager Search\Archive Manager Search

Setup.exe

6. A prerequisite check occurs and missing requirements if any are displayed. Click Install to
ensure all missing requirements are installed.

7. The Welcome window of the HSMinstaller opens.

Archive Manager Search

Welcome to the InstallShield Wizard for Archive
Manager Search

The Installshield Wizard will install Archive Manager
Search on your computer. To continue, dick Mext.

8. Click Next. The License Agreement window opens.

Archive Manager Search

X
License Agreement ‘
FPlease read the following license agreement carefully, P'

Press the PAGE DOWN key to see the rest of the agreement.

Software Transaction Agreement ~

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY
DOWNLOADING, INSTALLING OR USING THIS PRODUCT, YOU ACCEPT AND AGREE
TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR ORDERS PLACED
OUTSIDE  THE UNITED STATES OF AMERICA, PLEASE GO TO
peilq g Aspx TO VIEW THE APPLICABLE VERSION OF THIS
AGREEMENT FOR YOUR REGION. IF YOU DO HOT AGREE TO THE TERMS AND
CONDITIONS OF THIS AGREEMENT OR THE APPLICABLE VERSION OF THIS

ACMECAICMT CAN WALIN NECINA DA MOT DOAE AN IMCTALE AN NEE TUIE

Do you accept all the terms of the License Agreement? If you select Mo, Print
the setup wil dose. To install Archive Manager Search, you must accept =
this agreement.

=
=]

9. Click Yes to accept the license. The Setup Type window opens. Click Print if you wish to print
the license agreement.
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Archive Manager Search
Setup Type
Select the setup type to install,

Please select a setup type.

(® Complete

O Custom
-

advanced users,

-:S All program features will be installed. (Requires the most disk space.)

Select which program features you want installed. Recommended for

Cancel

Select Complete to include Post Processing service. If you select Custom, you can modify the
installation folder path which defaults to C:\Program Files (x86)\Metalogix\MAMSearch, and

choose to whether you want to install Archive Manager Search or Post Processing or both.

10. Click Next. The Choose Destination Location windows opens. This setting is for the Metalogix
Archive Manager for Files product and is not used by Metalogix Archive Manager for Exchange.

Archive Manager Search

Choose Destination Location

Select folder where setup will install files.

Please select the path for the file index

| C:'Program Files (x38) Metalogix\MAMSearch\Index\File

Browse...

Cancel

‘3

11. Accept the default setting and click Next
opens.

. The Choose Destination Location for the mail index

Archive Manager Search

Choose Destination Location
Select folder where setup will install files.

Please select the path for the mail index

'3

| C:'YProgram Files (x88) Metalogix\MAMSearch\IndexMail

Browse...

Cancel

12. Accept the default setting and click Next. The Logon Information window opens.
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Archive Manager Search X
Logon Information ‘
Specify a user account and password, r

Specify the user account to be used by this application. User accounts must be in the format
DOMAINUsername.

User name:

| democorpmamadmin |

Password:

Confirm password:

Enter the information as described below:

a. Username - logon name of the superuser (for example, democorp\mamadmin)
b. Password - logon password of the superuser

c. Confirm password - same as the Password.

13. Click Next. The Firewall Settings window appears.

Archive Manager Search

X
Firewall Settings ‘
‘3

Allow programs to communicate through Windows Firewall

Select the check box Allow programs to communicate through Windows Firewall.

14. Click Next. The Ready to Install the Program window opens.

Archive Manager Search X
Ready to Install the Program \
The wizard is ready to begin installation. "
Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

< Back Install Cancel
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15. Click Install. The InstallShield Wizard Complete window opens.

Archive Manager Search

InstallShield Wizard Complete

Manager Search. Click Finish to exit the wizard.

The InstallShield Wizard has successfully installed Archive

Steps to configure the Search database connection

1. When the installation completes, the Configuration wizard opens. If it does not open

automatically, click Start > Metalogix > Archive Manager Configuration.

2. From the feature panel on the left, click Search and select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

Database configuration

Database Connection Wizard

database provider and describe the database connection parameters.
Please selectthe database provideryou want to use:
f* Microsoft SQL Server

" Orade

The following page will letyou specify the database connection parameters.

The Database Connection Wizard will help you to set up your server. It allows you to specify the

_ mmeae

4, Select either Microsoft SQL Server or Oracle and click Next. The database connection
information window opens for the selected database.

Database configuration

Database Connection Wizard!

Set up your Microsoft SQL Server connection.

Flease enter parameters which will be used to create a connectionto your Microsoft SQL Server.

Server name: |AM)<DB |
Tnitial catalog: |MAM5EARCH |
Schema name: |dbo |
Authentication: | Windows Authentication @

User name: | |
Password: | |

e
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For Microsoft SQL Server

Server name - name of the SQL server (eg. AMXDB)

Initial catalog - name of the HSM database (e.g. MAMSEARCH which is the default name of
the Archive Manager Search database)

Schema name - name of the SQL Schema (e.g. dbo)

. Authentication — authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

. User name - database login user name if SQL Server authentication is the selected as the

authentication mode.

Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

For Oracle

a.

C.

d.

Oracle net name - net service name that describes the network address of the HSM
database in your tnsnames.ora file (eg. AMXDB)

. Schema - name of the HSM database (e.g. MAMSEARCH which is the default name of the

Archive Manager Search database)
User name - database login user name

Password - password of the database user

. Click Next and then click Yes on the confirmation dialog that opens.

Database configuration %

@ Database does notexists on the server. Shall we try to create it?

| Yes | | Mo |

. If the database connection is setup successfully, the configuration confirmation window
opens.
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Database configuration

Database Connection Wizard

You have successfully finished the Database Connection Wizard!

Click on Finishto save your database connection parameters and update config files.

If you have not done so already, you can execute the database soripts to create the necessary
database objects.

7. Click Finish to close the Database Connection wizard.

Steps to install the Search database

1. From the feature panel on the left in the Configuration wizard, click Search and select the
Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The
Run Scripts selection window opens.

Database configuration

Execute scripts

Select scripts to execute.

Please select SQL scripts you want to execute.

ﬂ 01_searchTahles.sql Selectall

Q 02_searchProcedures.sql
ﬂ 03_searchStandardValues.sgl

Unselect all

The following page will letyou specify the user underwhich to execute database scripts.

s

3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.
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Database configuration

Execute scripts

Specify the user under which to execute database scripts.

Please specify user under which to execute database scripts. The user must be allowed to create or
modify tables and procedures inthe database.

Authentication: | Windows Authentication v

Database user: | |

Password: | |

[w] I want to see the SQL script before execution (for advanced users)

Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

a. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

b. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

c. (optional) Check the | want to review the SQL Scripts check box to view the scripts.

5. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you
chose to view the Oracle scripts then the View Oracle scripts window opens

Database configuration

Execute scripts

View SQL scripts.

Here you can see the SQL script that will be executed.

=

MS-SQL scripts for Quest PostProcessing
DBEVERSION: 8.3.0.18
Date: August 2020
Company:  Quest Software Inc.
*f

if not exists (select * from sysobjects where id = OBIECT_ID(N'[dba]. [ATPAMDEVERSION]) and
OBJECTPROFPERTY id, NTsUserTable’) = 1)

BEGIM

CREATE TABLE [dba]. [ATPAMDBVERSION]

4
[APPLICATION] VARCHAR. (50) MOT MULL,
[MAJORVERSION]  INT NOT NULL,
[MINORVERSION]  INT NOT NULL,
[REVISIOMVERSION]  INT MNOT NULL, "

Save Script... Word wrap [l

- e

Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to
display long lines as multiple lines of text.

6. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.
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Database configuration

Execute scripts

Execute SQL scripts.

Here you can execute the selected SQL scripts to set up the database.

@ 01_searchTables sql
@ 02_searchProcedures.sql

@ 03_searchstandardvalues. sgl

Click on Next to execute scripts. 00:00

[ ]

7. Click Next. When the status changes to Scripts were run successfully, click Finish to close the
script installer. The Scripts section of the Configuration wizard displays the status and version

of the scripts.

¥ Configuration

Configure Search
Database  Search Smb@ Connectivity
Da St o —
Provider: Microsoft SQL Server
Server name: AMXDB
—_ Initial catalog: MAMSEARCH
jo) ' PORLPraEo e
Table owner: dbo
User name: (Windows Authentication)
&..("' LS E——
Datzbaseversion:  83.0.17
Scripts version: 8.3.0.17
/- €4 Your database is up to date.
. y Execute scripks...

Steps to configure the Post Processing database connection

1. When the installation completes, the Configuration wizard opens. If it does not open
automatically, click Start > Metalogix > Archive Manager Configuration.

2. From the feature panel on the left, click Post Processing and select the Database tab.

3. Click Configure. The Database Connection Wizard opens.
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Database configuration

Database Connection Wizard

The Database Connection Wizard will help you to set up vour server. It allows you to spedify the
database provider and describe the database connection parameters.

Flease select the database provideryou want to use:

f* Microsoft SQL Server

" Oracle

The following page will letyou specify the database connection parameters.

_ mmcaiew

4. Click Next. The SQL Server connection window opens.

Database configuration

Database Connection Wizard

Set up your Microsoft SQL Server connection.

Please enter parameters which will be used to create a connection to your Microsoft SQL Server.

Server name: [prxE |
Initial catalog: [MammDEX |
Schema name: [dbo |
Authentication: | Windows Authentication -]
User name: | |
Passward: | |

I

5. Click Next and then click Yes on the confirmation dialog that opens.

Database configuration

Database does not exists on the server. Shall wetry to create it?

| es | I Ma J

6. If the database connection is setup successfully, the confirmation window opens.

Database configuration

Database Connection Wizard

database objects.

You have successfully finished the Database Connection Wizard!

Click on Finishto save your database connection parameters and update config files.

If you have not done so already, you can execute the database soripts to create the necessary

Firish
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7. Click Finish to close the Database Connection wizard.

Steps to install the Post Processing database

1. From the feature panel on the left of the Configuration wizard, click Post Processing and
select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The
Run Scripts selection window opens.

Database configuration

Execute scripts

Select scripts to execute.

Please select SQL scripts you want to execute.

g 01_indexTahles.sql Selectall

g 02_indexPracedures.sgl

g 03_indexStandardValues.sgl

Unselect all

The following page will letyou specify the user under which to execute database scripts.

s

Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

3. Click Next. The run Scripts authentication window opens.

Database configuration

Execute scripts

Specify the user under which to execute database scripts.

Please specify user under which to execute database scripts. The user must be allowed to create or
modify tables and procedures inthe database.

Authentication: |Windows Authentication v |

Database user: | |

Password: | |

[l [ want to see the SQL script before execution (for advanced users)

I ] (s

Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

b. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

c. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.
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d. (optional) Check the | want to review the SQL Scripts check box to view the scripts.

4. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you
chose to view the Oracle scripts then the View Oracle scripts window opens

Database configuration

Execute scripts

View SQL scripts.

Here you can see the SQL script that will be executed.

U ~
MS-SQL scripts for Quest PostProcessing

DBVERSION: 8.3.0.15

Date: August 2020

Company:  Quest Software Inc.
I

if not exists (select * from sysobjects where id = OBIECT_ID{N'[dba]. [ATPAMDBVERSION]') and
(OBJECTPROPERTY(id, N'IsUserTable’) = 1)

BEGIM

CREATE TABLE [dba]. [ATPAMDBVERSION]

4

[APPLICATION] ~ VARCHAR (50) NOTNULL,

[MAJORVERSION]  INT NOT NULL,
[MINORVERSION]  INT NOT NULL,
[REVISIONVERSION]  INT NOT NULL, o

Save Script... Word wrap [¢]

- e

Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to
display long lines as multiple lines of text.

5. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

Database configuration

Execute scripts

Execute SQL scripts.

Here you can execute the selected SQL scripts to set up the database.

@y 01_indexTables.sql
&, 02_indexProcedures.sql

&y 03_indexStandardyalues.sql

Click an Next to execute scripts. 00:00

[ J

I

6. Click Next. When the status changes to Scripts were run successfully, click Finish to close the
scriptinstaller. The Scripts section of the Configuration wizard displays the status and version
of the scripts(the version of the scripts you install may differ from the version shown in the

image below).
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T.;’ Configuration

Configure Post Processing

I § H&h
Provider:

|t
p ' Searily Server name:

w Post Processing [

Initial catalog:

Table owner:

User name:

Database version:

Scripts version:

Database

Microsoft SQL Server
AMXDB

MAMINDEX

dbo

(Windows Authentication)

&',ﬁ.ﬂ;&:——-—

8.2.0.12

8.2.0.12

€4 Your database is up to date.

eral Settings

Exchange

Files OCR Engine

e —

Configure...

e —

Execute scripks...

IMPORTANT: You may close the Configuration wizard. Click Cancel on any warning dialogs

that may open. Additional Post Processing configuration is required but must wait until the
Archive Server installation and configuration is completed. See Install the Archive server for

next steps.

Steps to configure Search Scopes

1. From the feature panel on the left in the Configuration wizard, click Search and select the

Search Scopes tab.

Server name: AMYSERVER-A

(ﬂ Add archive server connection

Type: Exchange Archive Server

< Back ek =

Zancel

Enter the information and described below:

a. Server name - name of the primary Archive Manager for Exchange server (eg. AMXSERVER-

A) where the role will be set to Archive server.

b. Type - Select Exchange Archive Server.

2. Click Next. The Set up the Archive database connection window opens.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

113

Manual Installation



3. If the database already exists, click Import. Otherwise click Configure to setup the Archive
Manager for Files database. The Database Connection Wizard opens

Database configuration

Database Connection Wizard

The Database Connection Wizard will help you to set up your server. It allows you to specify the
database provider and describe the database connection parameters.

Flease selectthe database provideryou wantto use:

f* Microsoft SQL Server

" Oracle

Thefollowing page will letyou specify the database connection parameters.

_  ewosles

4, Select either Microsoft SQL Server or Oracle and click Next. The database connection
information window opens for the selected database.

Database configuration

Database Connection Wizard

Set up your Microsoft SQL Server connection.

Please enter parameters which will be used to create a connectionto your Microsoft SQL Server.

Server name: |AM)<DB
Initial catalog: |MAME)<CH
Schema name: |dbo

User name: |

|
|
|
Authentication: |Windcws Authentication - |
|
|

Password: |

I ) (-

For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the Archive Manager for Files database (e.g. MAMEXCH which is
the default name of the Archive Manager for Files database)

¢. Schemaname - name of the SQL Schema (e.g. dbo)

d. Authentication — authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

e. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

For Oracle
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a. Oracle net name - net service name that describes the network address of the HSM
database in your tnsnames.ora file (eg. AMFDB)

b. Schema - name of the Archive Manager for Files database (e.g. MAMEXCH which is the
default name of the Archive Manager for Files database)

c. User name - database login user name
d. Password - password of the database user

5. Click Next and then click Yes on the confirmation dialog that opens.

Database configuration

@ Database does not exists on the server. Shall wetry to create it?

| Yes | | Mo |

6. If the database connection is setup successfully, the configuration confirmation window
opens.

Database configuration

Database Connection Wizard

You have successfully finished the Database Connection Wizard!

Click on Finish to save your database connection parameters and update configfiles.

If you have not done so already, you can execute the database soripts to create the necessary
database objects.

7. Click Finish to close the Database Connection wizard. The Set up the Archive database
connection window opens.

"q;‘ Set up the Archive database connection
Provider: Microsoft SQL Server
Server name: AMXDB.democorp.com
Initial catalog: MAMEXCH
Table owner: dbo
User name: (Windows Authentication)
Impork Configure. .. < Back Mext = Cancel
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8. Click Next. The Configuration window for the Index directory opens.

w Index directory.

Index directory: C:\SEARCH Browse

| < Back, || Mexk = | | Cancel |

9. Click Browse to select or create a folder for the search index and then click Next. The Apply the
configuration changes confirmation window opens.

vf Apply the configuration changes

Click on Finish to save the configuration settings.

| < Back, | | Finish | | Cancel |

10. Click Finish. The Archive serveris added to the Manage search scopes section.

% Configuration

Configure Search -
Search Scopes Cannectivity
—
— )
P | | Fuzepruesczing
Configuration summary
Server type: Exchange Archive
Server name: AMXSERYER-A
Database: AMXDB.democorp.comMAMEXCH
| 7 Indexing database: AMXDB"MAMINDEX
Index directory: C:\SEARCH
.

11. Close the Configuration wizard.
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Install the Archive server

In this topic:

e Worksheet for this installation

e Stepstoinstall Archive Manager for Exchange

e Steps to configure the Archive Manager database

e Steps toinstall the Archive Manager database

e Steps to configure the Auditing database

e Stepstoinstall the Auditing database

e Steps to configure the User database

e Steps to install the User database

e Steps to start the Archive Manager services

e Steps to configure and verify the Archive server

Worksheet for this installation

The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description

License Key The license key that you
received from Quest. If you
don't have alicense key, contact
your Quest representative.

Archive manager for
Exchange server
installed.

Superuser account

Exchange services.

The server where the Archive
Manager for Exchange will be

Windows account that is used to
install the application and run
the Archive Manager for

Example

894K5-3M448-M544E-A594A-
7K8Z7 (Sample only. This key is
neither an active nor an expired
license key)

AMXSERVER-A

username:
democorp\mamadmin

password. 3k 3k 3k 3k 3k 5k sk 3k kosk sk k k ok
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Media folder Full path of the folder where the | C:\Metalogix

media files are extracted

Installation folder Full path of the folder where the | C:\Program Files (x86)

application files will be installed | \Metalogix

Database Authentication | Type of database Integrated Windows
method authentication: Integrated Authentication
Windows Authentication or SQL
Authentication
UserlLogin Username if SQL Authentication | dbadmin
is selected
Password Database password if SQL S

Authentication is selected

Database server The database serverinstance AMXDB

name where the databases for
Archive Manager for Files will be

installed.

HSM server The server where HSM s AMXHSM
installed.

Search server The server where the Archive AMXHSM

Manager Search is installed.

Steps to install Metalogix Archive Manager for
Exchange

1
2.
3.

Login to the server with the credentials of the superuser (eg. democorp\mamadmin)
Run the Metalogix Archive Manager Installation Package to extract the files to a local folder.
Close the integrated installer wizard which starts automatically.

Run the Archive Manager Search setup from <Media folder>\C:\Metalogix\Archive
Manager Installation Package\Exchange\Archive Manager for Exchange

Setup.exe.

A prerequisite check occurs and missing requirements if any are displayed. Click Install to
ensure all missing requirements are installed.

The Welcome window of the Archive Manager for Exchange installer opens.
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Archive Manager for Exchange

‘Welcome to the InstallShield Wizard for Archive
Manager for Exchange

The InstallShield Wizard will install Archive Manager for
Exchange on your computer. To continue, dick Next.

Click Next. The License Agreement window opens.

Archive Manager for Exchange
License Agreement ‘

Please read the following license agreement carefully.

Press the PAGE DOWN key to see the rest of the agreement.

Software Transaction Agreement

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY
DOWNLOADING, INSTALLING OR USING THIS PRODUCT, YOU ACCEPT AND AGREE
TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR ORDERS PLACED
QUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO
hitp:i/quest.com/legalista.aspx TO VIEW THE APPLICABLE VERSION OF THIS
AGREEMENT FOR YOUR REGION. IF YOU DO HOT AGREE TO THE TERMS AND
CONDITIONS OF THIS AGREEMENT OR THE APPLICABLE VERSION OF THIS

ACMECRACMT AN WAKN DSOS RO MOT Nedsfil AAn IMCTAL L AR II0E Tuie

Do you accept all the terms of the License Agreement? If you select No, Print
the setup will dose. To install Archive Manager for Exchanage, you must =

accept this agreement.

Installs

8. Click Yes to accept the license. The License Key window opens. Click Print if you wish to print
the license agreement.
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Activate License Key o

(b% Enter license key and select the activation method

License key:

Activation mode:

{®) Online activation (requires online internet connection)

(") Offline activation

Set proxy ..
bk | Nea> | | dose |

9. If you are connected to the internet, select Online activation or see License Activation for

more options. Click Next. When your license is activated, you will see a confirmation message
and the license details. Click Finish to close the Activate License Key dialog.

Archive Manager for Exchange >
Choose Destination Location

Select folder where setup will install files. ‘h'

' Install Archive Manager for Exchange to:

C:'Program Files (x86) \Metalogix

i
il
o
m
(=1

| < Back |E MNext > il Cancel |

10. Click Change to choose another installation folder or keep the default and click Next. The
Select Features window opens.
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Archive Manager for Exchange

Select Features
Select the features setup will install,

Application Server
[~1PST Imparter
Administrative tool

Auditing
[+/IMonitoring service
. [|Documentation

435,97 MB of space required on the C drive

110014.585 MB of space available on the C drive

@

Select the features you want to install, and deselect the features you do not want to install.

Description

Application server contains
the core services for an
Archive or Retrieve Server. It
is not recommended to install
the Application services on
the Exchange Server, For
maore information please read
the Installation guide.

Mandatory features
e Application Server
e Administrative tool
Optional features

e Auditing

e Monitoring service

Optional resources

e PSTImporter. For more information see the Metalogix® Archive Manager for Exchange PST

Importer Guide.
e Forms Installer

e Documentation

11. Click Next. The Archive Manager site port Information window opens.
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Archive Manager for Exchange d
Archive Manager site port Information ‘
Please define the Archive Manager site port. |2

Archive Manager site port number:

]

Mote: part number should be between 1 <-x 65535

12. Keep the default port 80 unless there are other application co-located on this server that also
use port 80. Click Next and the Select HSM server window opens.

Archive Manager for Exchange d

Select HSM server ‘
Select the HSM server ""

Type the name of the HSM server, or select it from the list of servers

HSM server
AMXHSM Browse...

Test H5M server
Test server...
Information:

The setup successfully established a connection with the HSM
server,

In the HSM server field, enter the name, FQDN or IP address of the server where the HSM
application feature was installed. You can click Browse to locate the server in the domain.

13. Click Test server to verify the connection and then click Next. The Search server window
opens.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

122

Manual Installation



Archive Manager for Exchange

Search server

Select the search server

Enable Archive Manager Search

Search server

Type the name of the search server, or select it from the list of servers

| AMXHSM

Browse...

Test Archive Manager Search server

Test server...

Check the Enable Archive Manager Search to enable search functionality from this server. In

the Search server field, enter the name, FQDN or IP address of the server where the HSM
application feature was installed. You can click Browse to locate the server in the domain.

14. Click Next. The Logon Information window opens.

Archive Manager for Exchange

Logon Information

DOMAIN\Username.

User name:

Spedfy a user account and password, ‘h

Spedfy the user account to be used by this application. User accounts must be in the format

<@

| democorpmamadmin

Password:

Confirm password:

In the User name field, specify the superuser name (eg. democorp\mamadmin)and Password.

Enter the password again

in the Confirm password field.

15. Click Next. The Firewall Settings window opens.
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Archive Manager for Exchange d

Firewall Settings “
|2

Allow programs to communicate through Windows Firewall

Select the Allow programs to communicate through Windows Firewall check box. Metalogix
Archive Manager for Exchange features will be then able to communicate through the
firewall.

16. Click Next. The Ready to Install the Program window opens.

Archive Manager for Exchange d
Ready to Install the Program ‘
The wizard is ready to begin installation. |2

<@

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

17. Click Install to start the installation. When the installation completes, the InstallShield Wizard
Complete window opens.
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Archive Manager for Exchange

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed Archive
Manager for Exchange. Click Finish to exit the wizard.

Launch Post Installation Tasks

18.Select the Launch Post Installation Tasks check box and click Finish. The Post installation Tasks
wizard opens.

m! Post installation

Post installation Tasks

Q Configuration

In order to run the archiving services you will have to configure the database
connections and configure your H5M services. This wizard will help you set up
the database connections as well s create or update the necessary database
objects and the HSM.

Launch configuration toal

Q Forms Publishing

In erder to archive and retrieve email correctly, you will need to publish the
Outlook Forms Templates. This wizard will help you configure and publish the
templates. Before publishing the forms you will need Outlook installed and Launch Forms Installer

open with the superuser account. Note: This can be run from a different
machine if needed.

O Start Services Start

This will start all of the services, allowing for archival and retrieval to begin. Start services

O Archive Manager for Exchange

Archive Manager for Exchange is the management tool for configuration and
maintenance of the entire archiving environment.

_ CIDse

Start

Start EM

Steps to configure the Archive Manager database

1. When the installation completes, the Post installation Tasks wizard opens. You can open the

the Post installation Tasks wizard from C:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to the Configuration step to open the Configuration wizard. To directly open
the Configuration wizard click Start > Metalogix > Archive Manager Configuration.

3. From the feature panel on the left, click Archive Manager and select the Database tab.

4. Click Configure. The Database Connection Wizard opens.
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Database configuration

Database Connection Wizard

The Database Connection Wizard will help you to set up your server. It allows you to specify the
database provider and describe the database connection parameters.

Flease selectthe database provideryou wantto use:

f* Microsoft SQL Server

" Oracle

Thefollowing page will letyou specify the database connection parameters.

_  ewosles

. Select either Microsoft SQL Server or Oracle and click Next. The database connection
information window opens for the selected database.

Database configuration

Database Connection Wizard

Set up your Microsoft SQL Server connection.

Flease enter parameters which will be used to create a connection to your Microsoft SQL Server.
Server name: |AM!DE |
Initial catalog: |MAME)<CH |
Schema name: |db0 |
Authentication: | Windows Authentication = |
User name: | |
Password: | |

For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMEXCH which is the default name of
the Archive Manager for Exchange database)

c. Schema name - name of the SQL Schema (e.g. dbo)

d. Authentication — authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

e. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

£. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.
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For Oracle

a. Oracle net name - net service name that describes the network address of the HSM
database in your tnsnames.ora file (eg. AMXDB)

b. Schema - name of the HSM database (e.g. MAMEXCH which is the default name of the
Archive Manager for Exchange database)

¢. Username - database login user name
d. Password - password of the database user

6. Click Next and then click Yes on the confirmation dialog that opens.

Database configuration

@ Database does notexists on the server. Shall we try to create it?

| Yes | | Mo |

7. If the database connection is setup successfully, the confirmation window opens.

Database configuration

Database Connection Wizard

You have successfully finished the Database Connection Wizard!

Click on Finish to save your database connection parameters and update configfiles.

If you have not done so already, vou can execute the database scripts to create the necessary
database objects.

8. Click Finish to close the Database Connection wizard.

Steps to install the Archive Manager database

1. From the feature panel on the left in the Configuration wizard, click Search and select the
Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The
Run Scripts selection window opens.
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Database configuration

Execute scripts

Select scripts to execute.

Flease select SQL scripts you want to execute.

g 01_exchangeTables.sql () Select All
Unselect Al
g 02_exchangeFunctions.sql
g 03_exchangeProcedures.sql
g 04_exchangeStandardvalues.sgl
g 05_exchangelUpdates.sql

g 08_ExchangePostProcessingProcedures.
v

< >

The following page will letyou specify the user underwhich to execute database scripts.

3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.

Database configuration

Execute scripts

Specify the user under which to execute database scripts.

Please specify user under which to execute database scripts. The user must be allowed to create or
maodify tables and procedures inthe database.

Authentication: | Windows Authentication 2

Database user: | |

Password: | |

[ Iwant to see the SQL script before execution (for advanced users)

e

Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

a. User name - database login user name if SQL Server authentication is the selected as the

authentication mode.

b. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

c. (optional) Check the | want to review the SQL Scripts check box to view the scripts.

5. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you
chose to view the Oracle scripts then the View Oracle scripts window opens
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Database configuration

Execute scripts

View SQL scripts.

Here you can see the SQL script that will be executed.

=
MS-SQL scripts for Archive Manager for Exchange
DEVERSION: &.2.0.140
Date: October 2019
Company:  Quest Software Inc.

x
/

IF EXISTS(SELECT TOP 1 1 FROM sys.databases WHERE database_id = DE_ID() and compatibility_level
< 100)
BEGIM

DECLARE @DBNAME NVARCHAR(128);

SET @DBNAME = DB_NAME(Q);

EXEC (ALTER DATABASE ' + @DBMAME +' SET COMPATIBILITY_LEVEL = 1007

IF EXISTS{SELECT TOP 1 1 FROM sys.databases WHERE database_id = DB_ID{) and
compatibility_level < 100)

BEGIM

o £niTi P em s a iemad i Leeenl £k

v

Save Script... Word wrap [v]

Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to
display long lines as multiple lines of text.

Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

Database configuration

Execute scripts

Execute SQL scripts.

Here you can execute the selected SQL scripts to set up the database.

01_exchangeTables,sql 2
0z_exchangeFunctions.sql

03_exchangeProcedures.sql

04_exchangestandardvalues.sgl

05_exchangelpdates.sgl

058_ExchangePostProcessingProcedures.sql

91_exchangeConversionTables.sql

&l e e e e e e e

distListCorr-55L. sl he

Click on Next to execute scripts. 00:00

[ ]

e e

Click Next. When the status changes to Scripts were run successfully, click Finish to close the
scriptinstaller. The Scripts section of the Configuration wizard displays the status and version
of the scripts (the version of the scripts you install may differ from the version shown in the
image below).
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¥ Configuration

Configure Exchange Archive

| et
= ! Auditing
Provider:

—
[ ] J§jUters Server name:

—_ Initial catalog:
w Exchange
Archive Table owmer:

User name:

Scripts version:

Database version: 8.3.0.173

(_ €4 Your database is up to date.
b 4 Execute scripts...

Database

——
Microsoft SQL Server
AMXDB
MAMEXCH
dbo
(wWindows Authentication)
——

8.3.0.173

8. Close the Configuration wi

zard.

Steps to configure the Auditing database

1. Openthe Configuration wizard if it is not already open.

2. From the feature panel on

the left, click Auditing and then select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

4, Select either Microsoft SQL Server or Oracle and click Next. The database connection
information window opens for the selected database.

Database configuration

Server name:
Initial catalog:
Schema name:
Authentication:
User name:

Password:

I ) o

For SQL Server

Database Connection Wizard

Set up your Microsoft SQL Server connection.

Please enter parameters which will be used to create a connection to your Microsoft SQL Server.

|AM>:DE

|MAMAUD1T

|dbo

|
|
|
| Windows Authentication - |
|
|

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMAUDIT which is the default name of
the Archive Manager for Exchange database)
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c. Schema name - name of the SQL schema (e.g. dbo)

d. Authentication — authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

e. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

£. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

For Oracle

e. Oracle net name - net service name that describes the network address of the database
serverinyour tnsnames.ora file (eg. AMXDB)

f. Schema - name of the Auditing schema (e.g. MAMAUDIT which is the default name of the
Archive Manager for Exchange database)

g. User name - database login user name

h. Password - password of the database user

Click Next and then click Yes on the confirmation dialog that opens.

If the database connection is setup successfully, the configuration confirmation window
opens.

7. Click Finish to close the Database Connection wizard.

Steps to install the Auditing database

1.

From the feature panel on the left in the Configuration wizard, click Auditing and select the
Database tab.

Verify that the database connection information is as expected. Then click Run Scripts. The
Run Scripts selection window opens.

Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

Click Next. The Run Scripts authentication window opens.

Enter the information as described below:

d.

Authentication - authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

. User name - database login user name if SQL Server authentication is the selected as the

authentication mode.

Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

(optional) Check the | want to review the SQL Scripts check box to view the scripts.

Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you
chose to view the Oracle scripts then the View Oracle scripts window opens



8. Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to
display long lines as multiple lines of text.

9. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

10. Click Next. When the status changes to Scripts were run successfully, click Finish to close the
script installer. The Scripts section of the Configuration wizard displays the status and version

of the scripts.

T.;’ Configuration

Configure Auditing

Database ~ Connection  Logtargets

@Il Auditing

Provider: Microsoft SQL Server
| o1
[ ] ' Uzzrs Server name: AMXDB

Initial catalog: MAMAUDIT
P' Exchange) a
= Archie Table owner: dbo

User name: (Windows Authentication)

Configure. ..

Database version: 8.3.0.27

Scripts version: 8.3.0.27
€4 Your database is up to date.

Execute scripks...

11. Close the Configuration wizard.

Steps to configure the User database

1. Openthe Configuration wizard if it is not already open.

2. From the feature panel on the left, click Users and then select the Database tab.
3. Click Configure. The Database Connection Wizard opens.
4

. Select either Microsoft SQL Server or Oracle and click Next. The database connection
information window opens for the selected database.
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Database configuration

Database Connection Wizard

Set up your Microsoft SQL Server connection.

Flease enter parameters which will be used to create a connection to your Microsoft SQL Server.

Server name: |AMXDB |
Initial catalog: |MAMUSER |
Schema name: ldbo |
Authentication: | Windows Authentication - |
e |
Password: | |

For SQL Server

a.

b.

Server name - name of the SQL server (eg. AMXDB)

Initial catalog - name of the HSM database (e.g. MAMUSER which is the default name of
the Archive Manager for Exchange database)

Schema name - name of the SQL schema (e.g. dbo)

. Authentication — authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

For Oracle

a.

C.

d.

Oracle net name - net service name that describes the network address of the database
serverinyour tnsnames.ora file (eg. AMXDB)

. Schema - name of the Auditing schema (e.g. MAMUSER which is the default name of the

Archive Manager for Exchange database)
User name - database login user name

Password - password of the database user

5. Click Next and then click Yes on the confirmation dialog that opens.

6. If the database connection is setup successfully, the configuration confirmation window
opens.

7. Click Finish to close the Database Connection wizard.
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Steps to install the User database

1.

From the feature panel on the left in the Configuration wizard, click Auditing and select the
Database tab.

Verify that the database connection information is as expected. Then click Run Scripts. The
Run Scripts selection window opens.

Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.
Click Next. The Run Scripts authentication window opens.
Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

b. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

c. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

d. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you
chose to view the Oracle scripts then the View Oracle scripts window opens

Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to
display long lines as multiple lines of text.

Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

Click Next. When the status changes to Scripts were run successfully, click Finish to close the
script installer. The Scripts section of the Configuration wizard displays the status and version
of the scripts.

T.;’ Configuration

Configure Users

Database  SMTP Configuration

5
@ Database cConnechon ——

=) ' Auditing

Provider: Microsoft SQL Server
Server name: AMXDB
Initial catalog: MAMUSER
" Erchange g
L] el Table owner: dbo
User name: (Windows Authentication)
Configure. ..
-‘ﬁ‘e'i-_-?yjp'r —
Database version: 83.0.32
Scripts version: 8.3.0.32

4 vour database is up ko date,

Execute scripks...
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10. Close the Configuration wizard.

Steps to start the Archive Manager for Exchange services

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation
Tasks wizard from C:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to step 3 to start the services. You can also start services with the batch file
available at <Installation folder> > Metalogix > MAM4Exchange > Tools > Start.bat.

1 | NOTE: To stop the services at any time you can use the batch file available at <Installation
folder> > Metalogix > MAMA4Exchange > Tools > Stop.bat.

Steps to configure and verify the Archive Server

Unless you manually change the role, every installation of the Archive Manager for Exchange will
automatically assign the Archive Server role to the installed instance. The Archive Server role
indicates that this is the primary server and all administration tasks are controlled from this
server.

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation
Tasks wizard from C:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to step 4 of the the Post installation Tasks wizard to open the AMAC. You can
also open the Archive Manager for Exchange Administration Center (AMAC) from Start >
Archive Manager for Exchange. The AMAC opens.

Archive Manager for Exchange EER
Session  View  Tools  Help

FRBRBX DL DT B

Groups || Settings | PublicFolders | Jobs Retention || Locations

| Set Filker || Clear filker |

Group name Alias Property Value

& ﬂ 5|Ser\.rer Role: Archive Serverl

Loaded FullAccess Manager
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On the status bar at the bottom of the window, verify that the Server Role is set to Archive
Server.

The Address Book Setup wizard opens automatically for a new installation. Click Close to exit
the wizard. Then close the Address Book Manager window that opens. For a manual
installation, Address Book setup can be done at a later step. For more information see Setup
the Address Book.

NOTE: Whenever an Archive Manager for Exchange server is installed, the default role
assigned is Archive Server. These servers are also identified with a MultiServerID and a
LocationID which are integers that default to 1. Large organizations with more than 3000
mailboxes use more that one Archive server. Since the MultiServerlD and LocationID of each
Archive server must be unique, you must manually change the MultiServerID and LocationID
of each extra Archive server by changing the following registry key values. For example, for a
second Archive server, set the following registry key values to 2, for a third Archive server
set the registry key values to 3, and so on.

HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Metalogix > exchangePAM >
MultiServerID

HKEY LOCAL MACHINE > SOFTWARE > Wow6432Node > Metalogix > exchangePAM >
OfflineStorage > LocationID

Install the Retrieve server

In this topic:

e Worksheet for this installation

e Steps toinstall Archive Manager for Exchange

e Steps to configure the Archive Manager database

e Stepstoinstall the Archive Manager database

e Steps to configure the User database

e Steps to install the User database

e Steps to start the Archive Manager services

e Stepsto set the Retrieve Server role

e Steps to verify the Retrieve Server role

Worksheet for this installation

The following information will be required through the installation process. Sample values are
provided here as a guidance.
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Item

License Key

Archive manager for
Exchange server

Superuser account

Media folder

Installation folder

Database Authentication
method

UserLogin

Password

Database server

HSM server

Search server

Description

The license key that you
received from Quest. If you
don't have alicense key, contact
your Quest representative.

The server where the Archive
Manager for Exchange will be
installed.

Windows account that is used to
install the application and run
the Archive Manager for
Exchange services.

Full path of the folder where the
media files are extracted

Full path of the folder where the
application files will be installed

Type of database
authentication: Integrated
Windows Authentication or SQL
Authentication

Username if SQL Authentication
is selected

Database password if SQL
Authentication is selected

The database server instance
name where the databases for
Archive Manager for Files will be
installed.

The server where HSMis
installed.

The server where the Archive
Manager Search is installed.

Example

894K5-3M448-M544E-A594A-
7K8Z7 (Sample only. This key is
neither an active nor an expired
license key)

AMXSERVER-R

username:
democorp\mamadmin

passvvord.**************

C:\Metalogix
C:\Program Files (x86)
\Metalogix

Integrated Windows
Authentication

dbadmin

3k 3k 3k 3k %k >k 3k 3k %k %k >k %k 3k *k

AMXDB

AMXHSM

AMXHSM



Steps to install Metalogix Archive Manager for
Exchange

1
2.
3.
4.

Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

Run the Metalogix Archive Manager Installation Package to extract the files to a local folder.

Close the integrated installer wizard which starts automatically.

Run the Archive Manager Search setup from <Media folder>\C:\Metalogix\Archive
Manager Installation Package\Exchange\Archive Manager for Exchange

Setup.exe.

A prerequisite check occurs and missing requirements if any are displayed. Click Install to
ensure all missing requirements are installed.

The Welcome window of the Archive Manager for Exchange installer opens.

Archive Manager for Exchange

‘Welcome to the InstallShield Wizard for Archive
Manager for Exchange

The InstallShield Wizard will install Archive Manager for
Exchange on your computer. To continue, dick Next.

7. Click Next. The License Agreement window opens.
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Archive Manager for Exchange

License Agreement “
>

Please read the following license agreement carefully.

Press the PAGE DOWN key to see the rest of the agreement.

Software Transaction Agreement

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY
DOWNLOADING, INSTALLING OR USING THIS PRODUCT, YOU ACCEPT AND AGREE
TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR ORDERS PLACED
QUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO
hitp:i/quest.com/legalista.aspx TO VIEW THE APPLICABLE VERSION OF THIS
AGREEMENT FOR YOUR REGION. IF YOU DO HOT AGREE TO THE TERMS AND
CONDITIONS OF THIS AGREEMENT OR THE APPLICABLE VERSION OF THIS

ACMECRACMT AN WAKN DSOS RO MOT Nedsfil AAn IMCTAL L AR II0E Tuie

Do you accept all the terms of the License Agreement? If you select No, Print
the setup will dose. To install Archive Manager for Exchanage, you must =

accept this agreement.

1r=talshisld

8. Click Yes to accept the license. The License Key window opens. Click Print if you wish to print

the license agreement.

(kﬁ Enter license key and select the activation method

License key:

Activation mode:

{®) Online activation (requires online internet connection)
(") Offline activation
Set proxy ..

e

9. If you are connected to the internet, select Online activation or see License Activation for
more options. Click Next. When your license is activated, you will see a confirmation message
and the license details. Click Finish to close the Activate License Key dialog.
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Archive Manager for Exchange d
Choose Destination Location ‘
Select folder where setup will install files, |2

. Install Archive Manager for Exchange to:
C:'\Program Files (xa6)\Metalogix Change...

10. Click Change to choose another installation folder or keep the default and click Next. The
Select Features window opens.

Archive Manager for Exchange d
Select Features ‘
Select the features setup will install, |2

<@

Select the features you want to install, and deselect the features you do not want to install.

-~ Application Server Description
~[PST Importer Application server contains
Administrative tool the core services for an

Archive or Retrieve Server, It
DFD”T'_S Installer is not recommended to install
[auditing the Application services on
DMonitoring service the Exchange Server, For

.. IDocumentation more information please read
[ the Installation guide.

354,22 MBE of space reguired on the C drive
107482.56 MB of space available on the C drive

Keep on the mandatory features. Uncheck all other check boxes.
e Application Server
e Administrative tool

11. Click Next. The Archive Manager site port Information window opens.
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Archive Manager for Exchange d
Archive Manager site port Information ‘
Please define the Archive Manager site port. |2

Archive Manager site port number:

]

Mote: part number should be between 1 <-x 65535

12. Keep the default port 80 unless there are other application co-located on this server that also
use port 80. Click Next and the Select HSM server window opens.

Archive Manager for Exchange d

Select HSM server ‘
Select the HSM server ""

Type the name of the HSM server, or select it from the list of servers

HSM server
AMXHSM Browse...

Test H5M server
Test server...
Information:

The setup successfully established a connection with the HSM
server,

In the HSM server field, enter the name, FQDN or IP address of the server where the HSM
application feature was installed. You can click Browse to locate the server in the domain.

13. Click Test server to verify the connection and then click Next. The Search server window
opens.
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Archive Manager for Exchange

Search server

Select the search server

Enable Archive Manager Search

Search server

Type the name of the search server, or select it from the list of servers

| AMXHSM

Browse...

Test Archive Manager Search server

Test server...

Check the Enable Archive Manager Search to enable search functionality from this server. In

the Search server field, enter the name, FQDN or IP address of the server where the HSM
application feature was installed. You can click Browse to locate the server in the domain.

14. Click Next. The Logon Information window opens.

Archive Manager for Exchange

Logon Information

DOMAIN\Username.

User name:

Spedfy a user account and password, ‘h

Spedfy the user account to be used by this application. User accounts must be in the format

<@

| democorpmamadmin

Password:

Confirm password:

In the User name field, specify the superuser name (eg. democorp\mamadmin)and Password.

Enter the password again

in the Confirm password field.

15. Click Next. The Firewall Settings window opens.
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Archive Manager for Exchange d

Firewall Settings “
|2

Allow programs to communicate through Windows Firewall

Select the Allow programs to communicate through Windows Firewall check box. Metalogix
Archive Manager for Exchange features will be then able to communicate through the
firewall.

16. Click Next. The Ready to Install the Program window opens.

Archive Manager for Exchange d
Ready to Install the Program ‘
The wizard is ready to begin installation. |2

<@

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

17. Click Install to start the installation. When the installation completes, the InstallShield Wizard
Complete window opens.
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Archive Manager for Exchange

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed Archive
Manager for Exchange. Click Finish to exit the wizard.

Launch Post Installation Tasks

18.Select the Launch Post Installation Tasks check box and click Finish. The Post installation Tasks
wizard opens.

Steps to configure the Archive Manager database

1.

m! Post installation

Post installation Tasks

@ Configuration

In order to run the archiving services you will have to configure the database
connections and configure your HSM services. This wizard will help you set up
the database connections as well as create or update the necessary database
objects and the HSM.

Launch configuration tool

@ Start Services
This will start all of the services, allowing for archival and retrieval to begin. Start services

Q Archive Manager for Exchange
Archive Manager for Exchange is the management tocl for configuration and Start EM

maintenance of the entire archiving environment.

_ CIDSB

When the installation completes, the Post installation Tasks wizard opens. You can open the

the Post installation Tasks wizard from C:\Program Files (x86)

\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

the Configuration wizard click Start > Metalogix > Archive Manager Configuration.

. Click Configure. The Database Connection Wizard opens.

. From the feature panel on the left, click Archive Manager and select the Database tab.
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Database configuration

Database Connection Wizard

The Database Connection Wizard will help you to set up your server. It allows you to specify the
database provider and describe the database connection parameters.

Flease selectthe database provideryou wantto use:

f* Microsoft SQL Server

" Oracle

Thefollowing page will letyou specify the database connection parameters.

_  ewosles

. Select either Microsoft SQL Server or Oracle and click Next. The database connection
information window opens for the selected database.

Database configuration

Database Connection Wizard

Set up your Microsoft SQL Server connection.

Flease enter parameters which will be used to create a connection to your Microsoft SQL Server.
Server name: |AM!DE |
Initial catalog: |MAME)<CH |
Schema name: |db0 |
Authentication: | Windows Authentication = |
User name: | |
Password: | |

For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMEXCH which is the default name of
the Archive Manager for Exchange database)

c. Schema name - name of the SQL Schema (e.g. dbo)

d. Authentication — authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

e. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

£. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.
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For Oracle

a. Oracle net name - net service name that describes the network address of the HSM
database in your tnsnames.ora file (eg. AMXDB)

b. Schema - name of the HSM database (e.g. MAMEXCH which is the default name of the
Archive Manager for Exchange database)

¢. Username - database login user name
d. Password - password of the database user

6. Click Next and then click Yes on the confirmation dialog that opens.

Database configuration

@ Database does notexists on the server. Shall we try to create it?

| Yes | | Mo |

7. If the database connection is setup successfully, the confirmation window opens.

Database configuration

Database Connection Wizard

You have successfully finished the Database Connection Wizard!

Click on Finish to save your database connection parameters and update configfiles.

If you have not done so already, vou can execute the database scripts to create the necessary
database objects.

8. Click Finish to close the Database Connection wizard.

Steps to install the Archive Manager database

1. From the feature panel on the left in the Configuration wizard, click Search and select the
Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The
Run Scripts selection window opens.
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Database configuration

Execute scripts

Select scripts to execute.

Flease select SQL scripts you want to execute.

g 01_exchangeTables.sql () Select All
Unselect Al
g 02_exchangeFunctions.sql
g 03_exchangeProcedures.sql
g 04_exchangeStandardvalues.sgl
g 05_exchangelUpdates.sql

g 08_ExchangePostProcessingProcedures.
v

< >

The following page will letyou specify the user underwhich to execute database scripts.

3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.

Database configuration

Execute scripts

Specify the user under which to execute database scripts.

Please specify user under which to execute database scripts. The user must be allowed to create or
maodify tables and procedures inthe database.

Authentication: | Windows Authentication 2

Database user: | |

Password: | |

[ Iwant to see the SQL script before execution (for advanced users)

e

Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

a. User name - database login user name if SQL Server authentication is the selected as the

authentication mode.

b. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

c. (optional) Check the | want to review the SQL Scripts check box to view the scripts.

5. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you
chose to view the Oracle scripts then the View Oracle scripts window opens
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Database configuration

Execute scripts

View SQL scripts.

Here you can see the SQL script that will be executed.

=
MS-SQL scripts for Archive Manager for Exchange
DEVERSION: &.2.0.140
Date: October 2019
Company:  Quest Software Inc.

x
/

IF EXISTS(SELECT TOP 1 1 FROM sys.databases WHERE database_id = DE_ID() and compatibility_level
< 100)
BEGIM

DECLARE @DBNAME NVARCHAR(128);

SET @DBNAME = DB_NAME(Q);

EXEC (ALTER DATABASE ' + @DBMAME +' SET COMPATIBILITY_LEVEL = 1007

IF EXISTS{SELECT TOP 1 1 FROM sys.databases WHERE database_id = DB_ID{) and
compatibility_level < 100)

BEGIM

o £niTi P em s a iemad i Leeenl £k

v

Save Script... Word wrap [v]

Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to
display long lines as multiple lines of text.

Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

Database configuration

Execute scripts

Execute SQL scripts.

Here you can execute the selected SQL scripts to set up the database.

01_exchangeTables,sql 2
0z_exchangeFunctions.sql

03_exchangeProcedures.sql

04_exchangestandardvalues.sgl

05_exchangelpdates.sgl

058_ExchangePostProcessingProcedures.sql

91_exchangeConversionTables.sql

&l e e e e e e e

distListCorr-55L. sl he

Click on Next to execute scripts. 00:00

[ ]

e e

Click Next. When the status changes to Scripts were run successfully, click Finish to close the
scriptinstaller. The Scripts section of the Configuration wizard displays the status and version
of the scripts (the version of the scripts you install may differ from the version shown in the
image below).
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¥ Configuration

Configure Exchange Archive
\ Database
—
— Provider: Microsoft SQL Server
1 Exchange
Archive Server name: AMXDB
Initial catalog: AMXEXCHANGE
Table owner: dbo
User name: (Windows Authentication)
FCFIPLS Em— ]
Datzbaseversion:  8.2.0.140
Scripts version: 8.2.0.140
€4 Your database is up to date.
4 Execute scripks...

8. Close the Configuration wizard.

Steps to configure the User database
1. Openthe Configuration wizard if it is not already open.
2. From the feature panel on the left, click Users and then select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

4, Select either Microsoft SQL Server or Oracle and click Next. The database connection
information window opens for the selected database.

Database configuration

Database Cannection Wizard

Set up your Microsoft SQL Server connection.

Please enter parameters which will be used to create a connection to your Microsoft SQL Server.
Server name: |AM!DE |
Initial catalog: |MAMUSER |
Schema name: |db0 |
Authentication: | Windows Authentication = |
User name: | |
Password: | |

For SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMUSER which is the default name of

the Archive Manager for Exchange database)
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c. Schema name - name of the SQL schema (e.g. dbo)

d. Authentication — authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

e. User name - database login user name if SQL Server authentication is the selected as the
authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

For Oracle

a. Oracle net name - net service name that describes the network address of the database
serverinyour tnsnames.ora file (eg. AMXDB)

b. Schema - name of the Auditing schema (e.g. MAMUSER which is the default name of the
Archive Manager for Exchange database)

c. User name - database login user name

d. Password - password of the database user

Click Next and then click Yes on the confirmation dialog that opens.

If the database connection is setup successfully, the configuration confirmation window
opens.

7. Click Finish to close the Database Connection wizard.

Steps to install the User database

1.

From the feature panel on the left in the Configuration wizard, click Auditing and select the
Database tab.

Verify that the database connection information is as expected. Then click Run Scripts. The
Run Scripts selection window opens.

Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

Click Next. The Run Scripts authentication window opens.

Enter the information as described below:

d.

d.

Authentication - authentication type used for the database. Choose either Windows
authentication or SQL Server authentication

. User name - database login user name if SQL Server authentication is the selected as the

authentication mode.

Password - password of the database user if SQL Server authentication is the selected as
the authentication mode.

(optional) Check the | want to review the SQL Scripts check box to view the scripts.

Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you
chose to view the Oracle scripts then the View Oracle scripts window opens



7. Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to
display long lines as multiple lines of text.

8. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

9. Click Next. When the status changes to Scripts were run successfully, click Finish to close the
script installer. The Scripts section of the Configuration wizard displays the status and version

of the scripts.

T.;’ Configuration

Configure Users

Database ~ SMTP Configuration

!
@ DatabasE CONNECHON e —

Provider: Microsoft SQL Server
- Eninane
[ ] ¥ Arehive Server name: AMXDB

Initial catalog: MAMUSER

Table owner: dbo

User name: (Windows Authentication)

Configure...
au
gﬁ-_-?yj‘ur —

Database version: 8.2.0.30

Scripts version: 8.2.0.30
€4 Your database is up to date.

Execute scripks...

10. Close the Configuration wizard.

Steps to start the Archive Manager for Exchange services

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation

Tasks wizard from C:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to step 2 to start the services. You can also start services with the batch file
available at <Installation folder> > Metalogix > MAMA4Exchange > Tools > Start.bat.

1 | NOTE: To stop the services at any time you can use the batch file available at <Installation
folder> > Metalogix > MAMA4Exchange > Tools > Stop.bat.

Steps to set the Retrieve Server role

Unless you manually change the role, every installation of the Archive Manager for Exchange will
automatically assign the Archive Server role to the installed instance. You must set the Retrieve
Server role for this server.

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation

Tasks wizard from C:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.
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2. Click Start next to step 3 of the the Post installation Tasks wizard to open the AMAC. You can
also open the AMAC from Start > Archive Manager for Exchange. The AMAC opens.

3. From the Tools menu select Options. The Options window opens.

Options

Server Role | PublicFolders  Auditing

Server role

g Server settings Select the server role:
Retrieve Server e
L o .
.:Ir_\, By sELLings Selecting the server role defines which tasks can be performed on the given

server, For example a retrieve server will never run scheduled tasks or
address book synchronization. It is important to note that two archive
'3"_:1 MESEaUER HesEs servers are not allowed in the same location.

!_' UEErHGIES

gply

4. From the Select the server role drop down list, select Retrieve Server.

5. Click OK to set the server role and close the window and restart the server.

Steps to verify the Retrieve Server role

1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

2. Click Start > Archive Manager for Exchange. The AMAC opens.
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Archive Manager for Exchange

PR
Session  View  Teols  Help
FEREXDesboes
Groups HSettings "PublicFoIders HJobs HRetention "Locatiorﬂ
Set filker | | Clear filter |
Group name Alias Property Value
[ | ﬂl Server Role: Retrieve Serverl Loaded FullAccess Manager

On the status bar at the bottom of the AMAC window, verify that the Server Role is set to
Retrive Server.
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7

Application Configuration

In this chapter

e Setup the Address Book

e Publish Archive Manager Forms

Setup up the Address Book

You must import the Microsoft Exchange servers, mailboxes and groups and keep them in synch
to facilitate email archiving. With the Address Book Manager, you can import the servers,
mailboxes and groups and schedule automatic synchronization jobs to keep the Metalogix
Archive Manager for Exchange database up to date and synchronized with the Active Directory.

In this chapter:

e Steps to open the Address Book Manager

About the Address Book Manager

Importing Exchange Servers

Importing Mailboxes

Importing or Creating Groups

Synchronizing Address Book Manager

Steps to open the Address Book Manager

1. Logintothe Metalogix Archive Manager for Exchange console.

2. From the Tools menu, click Address Book Manager.

Archive Manager for Exchange

Session  View | Tools | Help

ﬁ Mailbox rights manager

Check mailboxes...
Create folders...
Export tasks...
Statistics...

. eoer

Address book Manager

Optiens...
Settings...

or, from the toolbar, click Address Book Manager
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Archive Manager for Exchange

Session  View  Teols  Help

FRBERX DG Do gl

3. If no Microsoft Exchange servers, mailboxes or groups are available in the Address Book
Manager, the Address Book Setup wizard opens. Otherwise the Address Book Manager
window opens.

About the Address Book Manager

The Address Book Manager window provides two menu options:

Setup - starts the Address Book Setup wizard that provides a step-by-step guide to add Microsoft
Exchange servers, mailboxes and groups. If no Microsoft Exchange servers, mailboxes or groups
are available in the Address Book Manager, the Address Book Setup wizard opens by default
when you open the Address Book Manager.

Refresh - reloads information about Microsoft Exchange servers, mailboxes and groups based on
the available configuration settings.

The management of Microsoft Exchange servers, mailboxes, groups and synchronization settings
are organized by tabs in the Address Book Manager window.

o Synchronization —for manual or automatic synchronization of mailboxes, groups and
permissions with the Active Directory of available servers.

e Servers —for adding, removing and managing Microsoft Exchange servers.

e Groups —forimporting groups, creating user-defined groups and managing group features.

o Mailboxes —for importing new mailboxes and managing mailboxes.

7 Address book Manager

Setup  Refresh

Address book and settings

Server name Version
o AN 16EXCH 2016 MAPT Yes LDAP: JfCN=AMX 16EXCH,CN. ..

‘vjdemommpany.onmicrcso&.oom Office 365 MAPL ‘Yes LDAP: ffCN=Configuration,C...

—_ Access method Induded  Configuration path
e o¥nchromzation

cj Servers

-:" Eruips

ﬁ FISBORES

7/

2 servers
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Importing Exchange Servers

In this topic:

Options for importing Microsoft Exchange servers

Steps to add on-premise Microsoft Exchange servers

Steps to add online Microsoft Exchange servers

Steps to verify the imported Microsoft Exchange servers

Options for importing Microsoft Exchange servers

Microsoft Exchange Servers can be added to the Address Book Manager in one of two ways:

e Option 1- By using the Address Book Setup Wizard.

1. Open the Address Book Manager.

2. From the Setup menu, click Setup Wizard. The Address book setup wizard opens.

3. Click the Launch server wizard to initiate the import process.

Address book setup 3

Address book setup

O Import Exchange Server

In order to archive e-mails, you have to spedfy which Exchange Servers
should be used. The wizard wil help you locating the Exchange Servers in
yaur erganization and you will be able to impart the Exchange Servers.

Q Import Mailboxes

You have to spedify which maiboxes should be allowed for archiving. If a
mailbox is notimported, it is not possible to archive e-mails from it. The
mailbox import wizard will help you to locate the mailboxes and to import
them.
Launch mailbox wizard

O Import Exchange groups

The Exchange groups (security groups or distribution lists) will help you to
easily manage the settings all over the archive system. The group impert
wizard will help you to locate the groups in Exchange Servers and

additionaly it allows you to create user defined groups.
Launch group wizard

_ CIUSB

e Option 2 - By starting a task from the Servers tab of the Address Book Manager.

1.

2.

Open the Address Book Manager.
Click the Servers tab.

Right-click inside the list view and from the context menu point to Tasks and select Add
Server... to initiate the import process.
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" Address book Manager

Setup  Refresh

Address book and settings

Server name Version Access ... Induded  Configuration path
¢ Synchronization

NG [ Tesks v [ Add server..
g LS
Add/Remove columns... Update Servers
% (HEEoRES Refresh Purge Servers

Properties

1 servers

Whichever method you choose, the Select Exchange Server Type window opens.

Steps to add on-premise Microsoft Exchange servers

1. Inthe Select Exchange Server Type window, select Import Exchange On-Premise.

® Add new Exchange Server wizard

Select Exchange Server Type

@ Import Exchange On-Premise

u (O) Import Exchange Online

2. Click Next. A list of Microsoft Exchange Servers appear that are accessible within your trusted
domain.
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® Add new Exchange Server wizard

Available Exchange Servers

Servers: 1new servers /0 imported servers

Server Name
AMYEXCH

Exchange Version

Exchange 2016

==

Set Exchange Server permissions for Metalogix service account

Set Public Folders permissions for Metalogix service account

Select the servers that contain the mailboxes and folders you want to archive and then select

the check boxes to set the permissions as described below:

a. Set Exchange server permissions for Metalogix service account - grants elevated rights to
the superuser on each of the selected Microsoft Exchange Servers.

b. Set Public Folder permissions for Metalogix service account - grants OWNER permission to

the Publicfolders.

3. Click Next. The Superuser's mailbox SMTP address window opens. In the Superuser's mailbox
SMTP address field, enter the email address of the superuser if not already filled in. You can

change the email from the server Properties window.

™ add new Exchange Server wizard

Superuser's SMTP. address

& Superuser's mailbox SMTP address:

|rr|amadmir1 @democorp.com

in server properties dialog.

e

Same email address will be used for all selected servers. It can be changed

4. Click Next. The Summary window opens that lists the on-premise servers that will be added.
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® Add new Exchange Server wizard

Summary

Summary:

Import the following servers [1] :
- AMX 16EXCH

-QT‘ FInISh Cancel

5. Click Finish to start the import process. The Creating objects window opens. You can click Back

to select more servers to add or remove some of the selected servers.

® Add new Exchange Server wizard

Creating objects

Progress:

Processing started

Importing server: AMX16EXCH

Server imported

Exchange server permissions have been set
Processing finished

6. When the import process has completed, click Close.

Steps to add online Microsoft Exchange servers

1. Inthe Select Exchange Server Type window, select Import Exchange Online.
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® Add new Exchange Server wizard

Select Exchange Server Type

® O Import Exchange On-Premise

u (®) Import Exchange Online

2. Click Next. The Service account for 0365 Exchange server import window opens. Enter the

administrator credentials for the Microsoft Exchange online server.

® Add new Exchange Server wizard

Service account for 0365 Exchangeserve

Username (must be an 0385 admin):

|adminisirator@demommpany‘onmicroscﬂ.oom |

Password:

| EEE |

3. Click Next. The Available Exchange Servers window opens. Select the desired Office 365

instance.
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® Add new Exchange Server wizard

Available Exchange Servers

Servers: 1new servers [ 0 imported servers

Server Name Exchange Version

demacompany.onmicrosoft.com Office 365

Set Exchange Server permissions for administrator @democompany. onmicrosoft.com

Set Public Folders permissions for administrator @democompany. onmicrosoft.com

=

Select the servers that contain the mailboxes and folders you want to archive and then select
the check boxes to set the permissions as described below:

a. Set Exchange server permissions for <Office 365 administrator> - grants elevated rights to
the 0365 administrator on each of the selected Microsoft Exchange Servers.

b. Set Public Folder permissions for <Office 365 administrator> - grants OWNER permission
for the Public folders to the 0365 administrator.

4. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that
will be added.

® Add new Exchange Server wizard

Summary

Summary:

Import the following servers [1] :
-democompany.onmicrosoft.com

L emmes

5. Click Finish to start the import process. The Creating object window opens. You can click Back
to select more servers to add or remove some of the selected servers.
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® Add new Exchange Server wizard

Creating objects

Progress:

Processing started

Importing server: democompany. onmicrosaft. com

Server imported but failed to set Exchange server permissions
Processing finished

6. When the import process has completed, click Close.

Steps to verify the imported Microsoft Exchange

servers
1. Openthe Address Book Manager

2. Click the Servers tab and verify the imported servers in the list view.

7 Address book Manager

Refresh

Setup

Address book and settings

Access method

Server name Version

Hr? AMX 16EXCH 2016 MAPI
» iEmoCompany . onMICrosoTt. com ce
d icrosoft Office 365 MAPI

¢ Synchronzation

@ Servers

'.-'- ST OUPE

% HobREs

Included

Yes
Yes

Configuration path

LDAP: /JCN=AMX 16EXCH,CN. ..
LDAP: f{CN=Configuration,C...

2 servers
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Importing Mailboxes

In this topic:

Options for importing mailboxes

Steps to import mailboxes from on-premise Microsoft Exchange servers

Steps to import mailboxes from online Microsoft Exchange servers

Steps to verify the imported mailboxes

Options for importing mailboxes

Microsoft Exchange server mailboxes can be added to the Address Book Manager in one of two
ways:

e By using the Address Book Setup Wizard.
1. Openthe Address Book Manager.
2. From the Setup menu, click Setup Wizard. The Address book Setup wizard opens.

3. Click the Launch mailbox wizard to initiate the import process.

Address book setup 3

Address book setup

O Import Exchange Server

should be used. The wizard will help you locating the Exchange Servers in

In order to archive e-mails, you have to spedfy which Exchange Servers ‘ ‘%
yaur erganization and you will be able to impart the Exchange Servers. —

@ Import Mailboxes

You have to specify which maiboxes should be allowed for archiving. Ifa
mailbox is notimported, it is not possible to archive e-mails from it. The
mailbox import wizard will help you to locate the mailboxes and to import
them.

Launch mailbox wizard

Q Import Exchange groups
The Exchange groups (security groups or distribution lists) will help you to
easily manage the settings all over the archive system. The group impart
wizard will help you to locate the groups in Exchange Servers and

additionaly it allows you to create user defined groups.
Launch group wizard

_ CIDSB

e By using the Mailboxes tab of the Address Book Manager.

1. Open the Address Book Manager.
2. Click the Mailboxes tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Import
mailbox wizard... to initiate the import process.
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7 Address book Manager

Setup  Refresh

Address book and settings

Display name email address Home server

e oynchromzation

= SETVETS

'..' Frulns |

Tasks L4 Import mailbox wizard...
Mailboxes Add/Remove columns... Activate mailboxes
Refresh list Deactivate mailboxes
Properties Migrate mailbox
Permissions... Purge mailboxes
Synchronize mailbox folder permissions
Update mailboxes

-
W

Whichever method you choose, the Import mailbox wizard window opens.

Steps to import mailboxes from an on-premise
Microsoft Exchange Server

1. Inthe Select Exchange Server Type window, select Import from Exchange On-Premise.

% Import mailbox wizard

Exchange type selection

i (®) Import from Exchange On-Premise

‘ (O) Import from Exchange Online

2. Click Next. The Mailboxes - search and select mailboxes to import window opens.
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¢ Import mailbox wizard

Mailboxes - search and select mailboxes toimport:

Look for Name:

| Search

Display Name Emall Address

Administrator spsadmin @domca meta, test
Miki Portman nikiportman @domca. meta. test
Ishna Mohan ishnamohan @domca. meta. test
Nina Tanaka ninatanaka@domca. meta. test
[] Pablo Neruda pabloneruda @domca. meta. test
[ aman ali amanali@domca. meta. test

[] 3uan Christie juanchristie @domca. meta. test
[ pevika Sharma devikasharma@domca.meta. test
[ karl Jordan karljordan @domca. meta. test
[ Tim ashford timashford @domca.meta. test
[] David webb davidwebb @domca. meta. test

 eacaks

3. Click Search to return the list of all mailboxes across all on-premise servers available to the
Address Book Manager. To reduce the list of mailboxes, you can specify a search term in the
Look for Name search box. Only the initial letters of the mailbox Display Name can be
specified, and wildcards are not supported. The search term is case-insensitive. For example,
if you enter ni as the search term and click Search, the mailboxes that start with the letters ni
will be returned in the search results list.

4. Select one or more mailboxes that you want to import.

1 | NOTE: Mailboxes that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of mailboxes will indicate how many mailboxes
that you select are new, and how many already exist. If you select pre-exisiting
mailboxes, they will be updated during the import process.

5. Click Next. The Summary window opens that lists the mailboxes from the on-premise
Microsoft Exchange servers that will be imported.

i+« Import mailbox wizard

Summary

Summary:

Import the following maiboxes [4] :
- Administrator

- Miki Portman

- Ishna Mohan

- Nina Tanaka

e
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6. Click Finish to start the import process. The Creating Object window opens. You can click Back
to select more mailboxes to add or remove some of the selected mailboxes.

% Import mailbox wizard

Creating objects

Progress:

Processing started

Importing mailbox: Administrator
Mailbox imported

Importing mailbox: Niki Portman
Mailbox imported

Importing mailbox: Ishna Mohan
Mailbox imported

Importing mailbox: Nina Tanaka
Mailbox imported

Processing finished

< Back |— Finish | Close

7. When the import process has completed, click Close.

Steps to import mailboxes from an online Microsoft
Exchange Server

1. Inthe Select Exchange Server Type window, select Import from Exchange Online.

%+ Import mailbox wizard

Exchange type selection

i () Import from Exchange On-Premise

b (® Import from Exchange Online

 ewmemes

2. Click Next. The Exchange Online window opens. Select the desired Office 365 instance.
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% Import mailbox wizard

Exchange Online

Select Office 365 tenants:

Server Mame

democompany. onmicrosoft.com

 emealee

3. Click Next. The Mailboxes - search and select mailboxes to import window opens.

%+ Import mailbox wizard

Mailboxes - search and select mailboxestoumport:

Look for Name:

A Search

4 new mailb: /0 old mailb

Display Name Email Address

Allen Siman allensimon @democompany. onmicrasoft. com
Anton Horvath antonhorvath @democompany. onmicrosoft.com
[] Arnav Sharma arnavsharma @democompany . onmicrosoft. com
[ ashton McGrath ashtonmegrath @democompany. onmicrosoft.com

e

4. Click Search to return the list of all mailboxes across all on-premise servers available to the
Address Book Manager. To reduce the list of mailboxes, you can specify a search termin the
Look for Name search box. Only the initial letters of the mailbox Display Name can be
specified, and wildcards are not supported. The search term is case-insensitive. For example,
if you enter A as the search term and click Search, the mailboxes that start with the letter A
will be returned in the search results list.

5. Select one or more mailboxes that you want to import.

1 | NOTE: Mailboxes that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of mailboxes will indicate how many mailboxes
that you select are new, and how many already exist. If you select pre-exisiting
mailboxes, they will be updated during the import process.

6. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that
will be added.
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% Import mailbox wizard

Summary

Summary:

Import the following maiboxes [2] :
- Allen Simon
- Anton Horvath

-QT‘ FInISh Cance'

7. Click Finish to start the import process. The Creating Object window opens. You can click Back
to select more mailboxes to add or remove some of the selected mailboxes.

i« Import mailbox wizard

Creating objects

Progress:

Processing started

Importing mailbox: Allen Simon
Mailbox imported

Importing mailbox: Anton Horvath
Mailbox imported

Processing finished

8. When the import process has completed, click Close.

Steps to verify the imported mailboxes
1. Open the Address Book Manager

2. Click the Mailboxes tab and verify the imported mailboxes in the list view.
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7 Address book Manager

Setup  Refresh

Address book and settings

L e Synchronmzation

= SETVETS
[ ninatanaka
._"_ Hruing () nikiportman

If:_'; ishnamohan
Mailboxes

[ allensiman
(3 antorhorvath

Display name
Administrator

Nina Tanaka
Niki Portman
Ishna Mohan
Allen Simaon
Anton Horvath

Alias

spsadmin

ninatanaka
nikiportman
ishnamohan
allensimon
antonhorvath

email address

spsadmin@democompany. ...

ninatanaka @democompan...
nikiportman @democompan...
ishnamohan @democompan. ..
allensimon @democompan. ..
antonhorvath @democompan. ..

Home server

AMX 16EXCH

AMY 16EXCH
AMK 16EXCH
AMX 16EXCH
democomp...
democomp...

/ ‘
/ 8 mailboxes

NOTES:

Importing or Creating Groups

Mailboxes with names like public <name-of-Microsoft-Exchange-server>also appear in the
mailboxes list These mailboxes are the public folders from the respective Microsoft
Exchange server because Address Book Manager considers a public folder as a profile. These
mailboxes are always highlighted in blue B, so you can distinguish them faster.

Imported mailboxes must be added to a group in Address Book Manager to enable automatic
archiving with scheduled jobs. If you do not add mailboxes to a group you can archive them
manually. For more information about adding mailboxes to groups see the section “How to
add members to a user defined Archive Manager group”.

Groups enable you to schedule archiving jobs. There must be at least one group (either imported

from Active Directory or a user-defined group) if you plan to schedule archiving jobs. User-

defined groups are not Active Directory groups.

In this topic:

Options forimporting groups

Steps to import groups from on-premise Microsoft Exchange servers

Steps to import groups from online Microsoft Exchange servers

Steps to create user-defined groups
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Steps to verify the imported and user-defined groups

Options for importing groups
Microsoft Exchange server groups can be added to the Address Book Manager in one of two ways:
e By using the Address Book Setup Wizard.

1. Open the Address Book Manager.

2. From the Setup menu, click Setup Wizard. The Address book Setup wizard opens.

3. Click the Launch group wizard to initiate the import process.

Address book setup -3

Address book setup

O Import Exchange Server

In order to archive e-mails, you have to spedfy which Exchange Servers 'ﬁ
should be used. The wizard will help you locating the Exchange Servers in ‘ @
your organization and you will be able to import the Exchange Servers. —

Launch server wizard

G Import Mailboxes

‘You have to spedfy which mailboxes should be allowed for archiving. If a
mailbox is not imported, it is not possible to archive e-mails from it. The
mailbox import wizard will help you to locate the mailboxes and to import
them.

Launch mailbox wizard

Q Import Exchange groups

The Exchange groups {security groups or distribution lists) will help you to
easily manage the settings all over the archive system. The group import
wizard will help you to locate the groups in Exchange Servers and
additionaly it allows you to create user defined groups.

Launch group wizard

_ CIUSE

e By using the Groups tab of the Address Book Manager.

1. Openthe Address Book Manager.
2. Click the Groups tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Add
group wizard... to initiate the import process.
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" Address book Manager

Setup  Refresh

Address book and settings

Display name email address Group
e oynchromzation
= SETVETS
| Tasks 4 H Add group wizard...
o) .
‘—4 [REIEE Add/Remove columns... Purge group
Refresh
Properties

<

0 groups

Whichever method you choose, the Import group wizard window opens.

Steps to import groups from an on-premise
Microsoft Exchange Server

1. Inthe Import group wizard window, select Import Groups.

ik Import group wizard

@ Import Groups

6 6

() Create user defined group

2. Click Next. The Exchange type selection window opens. Select Import form Exchange On-
Premise.
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ik Import group wizard

Exchange type selection

i (® Import from Exchange On-Premise

‘ ' () Import from Exchange Online

 eweeies

3. Click Next. The Groups - search and select groups to import window opens.

ik Import group wizard

Groups - search and select groups toimport:

Look for Name:

|D Search

Groups: 10 new groups [ 0 imported groups

Display Name Security group
|:| Domain Computers True
[] pomain Controllers True
Domain Admins True
Domain Users True
|:| Domain Guests True
["] Denied RODC Password Replication Group True
[] breadmins True
[] breUpdateProxy True
|:| Discovery Management True
[] Delegated setup True

T

4. Click Search to return the list of all groups across all on-premise servers available to the
Address Book Manager. To reduce the list of groups, you can specify a search term in the Look
for Name search box. Only the initial letters of the groups Display Name can be specified, and
wildcards are not supported. The search term is case-insensitive. For example, if you enter D
as the search term and click Search, the groups that start wit the letter D will be returned in
the search results list.

5. Select one or more groups that you want to import.

1 | NOTE: Groups that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of groups will indicate how many groups that
you select are new, and how many already exist. If you select pre-exisitng groups, all new
mailboxes will also be imported.

6. Click Next. The Group settings - default values window opens.
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it Import group wizard

Group settings - default value

The groups will be imported with the following default settings:

Automatically import mailbox members
Advanced import settings
(® Import subgroups along with its members

() Import only mailbox members without subgroups

 eweies

7. Specify the settings which will be applied when the groups are imported now or synchronized
in future with the Address Book Manager automatically or manually. The settings are
described below:

a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.

b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can enable this setting only if you select the Automatically import
mailbox members setting.

c. Import subgroups along with members - check this box to import existing subgroups of
selected groups including its member mailboxes. This is the default setting.

d. Import only mailbox members without subgroups - check this box to import only member
mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.

8. Click Next. The Summary window opens that lists the groups that will be added.

it Import group wizard

Summary

Summary:

Impart the following groups [2] :
-Domain Admins
- Domain Users

e

9. Click Finish to start the import process. The Creating Object window opens.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

N . . 173
Application Configuration



it Import group wizard

Creating objects

Progress:

Processing started
Importing group: Domain Admins
Group imported

- New mailbox members imported =0
- Mew subgroups imported =10

Importing group: Domain Users
Group imported

- New mailbox members imported = 7
- Mew subgroups imported =0

Processing finished

10. When the import process has completed, click Close.

Steps to import groups from an online Microsoft
Exchange Server

1. Inthe Import group wizard window, select Import Groups.

ik Import group wizard

Wizard type selection

a @ Import Groups

() Create user defined group

—m et 2 Cance'

2. Click Next. In the Exchange Type selection window, select Import from Exchange Online.
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it Import group wizard

Exchange type selection

i (O) Import from Exchange On-Premise

“ (®) Import from Exchange Online

3. Click Next. The Exchange Online window opens. Select the desired online Microsoft Exchange
server.

it Import group wizard

Exchange Online

Select Office 365 tenants:

Server Name

[ democompany.onmicrosoft.com

4. Click Next. The Groups - search and select groups to import window opens.

it Import group wizard

Groups - search and select groups tolimpo
Look for Name:
| | | Search |
Groups: 41 new groups [ 0 imported groups
Display Name Security group ~
@ Organization Management True
D Redipient Management True
D View-Only Organization Management True
[+] Help Desk True
D Records Management True
D Discovery Management True
D Hygiene Management True
1 compliance Management True
] UM Management True
] RIM-MailboxAdminsd94a65c903754f 7595332790039 L., True &
< >

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

175
Application Configuration



5. Click Search to return the list of all groups across all online servers available to the Address
Book Manager. To reduce the list of groups, you can specify a search term in the Look for
Name search box. Only the initial letters of the group Display Name can be specified and
wildcards are not supported. The search term is case-insensitive.

1 | NOTE: Groups that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of groups will indicate how many groups that
you select are new, and how many already exist. If you select pre-existing groups, all new
mailboxes in those groups will also be imported.

6. Select the groups that you want to import.

7. Click Next. The Group settings - default values window opens

% Import group wizard

- default values,

The groups will be imported with the following default settings:

Automatically import mailbox members
Advanced import settings
(® Import subgroups along with its members

() Import only mailbox members without subgroups

_ | < Back H Mext = || Cancel |

8. Specify the settings which will be applied when the groups are imported now or synchronized
in future with the Address Book Manager automatically or manually. The settings are
described below:

a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.

b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can enable this setting only if you select the Automatically import
mailbox members setting.

c. Import subgroups along with members - check this box to import existing subgroups of
selected groups including its member mailboxes. This is the default setting.

d. Import only mailbox members without subgroups - check this box to import only member
mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.

9. Click Next. The Summary window opens that lists the groups that will be added.
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it Import group wizard

Summary

Summary:

Impart the following groups [6] :
- Organization Management
-Help Desk

- Compliance Management

- Security Administrator
-Helpdesk Administrator

- Company Administrator

e

10. Click Finish to start the import process. The Creating objects window opens. You can click Back
to select more groups to add or remove some of the selected groups.

it Import group wizard

Creating objects

Progress:

Imparting group: Compliance Management A~
Group imported

- New mailbox members imported =0
- Mew subgroups imported =0

Importing group: Security Administrator
Group imported

- Mew mailbox members imported = 0
- Mew subgroups imported =0

Imparting group: Helpdesk Administratar
Group imported

- Mew mailbox members imported =0

- MNew subgroups imported = 1
Processing finished

W

= Back Finish | Close

11. When the import process has completed, click Close.

Steps to create user-defined groups

1. Inthe Import group wizard window, select Create user defined group. Enter a name for the
group in the Group Name field.

Metalogix Archive Manager for Exchange Advanced Install Guide for MS

o ) ) 177
Application Configuration



ik Import group wizard

Wizard type selection

(@) Create user defined group

a O Import Groups

Group Name:

|Demo Group

_ ; z BaCk d Hext 2 Cance'

. Click Next. The User Defined Group - Add members to group window opens. By default, the
on-premise Microsoft Exchange server is the source for the list of mailboxes and groups that
can be added to the user-defined group. To use 0365 Exchange servers as a source for

mailboxes and groups, select Exchange Online.

it Import group wizard

User Defined Group - Add members o group)
Look for Name:
| Search
Exchange Online
Display Name Email Address Member Type

I

Click Search to return the list of all mailboxes and groups. To reduce the list of mailboxes and
groups, you can specify a search term in the Look for Name search box. Only the initial letters
of the mailbox or group Display Name can be specified and wildcards are not supported. The

search term is case-insensitive.

NOTE: If the Exchange Online check box is checked, only the online Microsoft Exchange
servers will be used as the source. If the Exchange Online check box is unchecked, only

on-premise Microsoft Exchange servers will be used as the source.

Mailboxes and groups that are highlighted indicate that they already exist in the Address
Book Manager. The list summary above the list of groups will indicate how many
mailboxes and groups are available.
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it Import group wizard

Look for Name:

User Defined Group - Add members o group)

[] Exchange Online

Display Name Email Address

] Admini i meta. test
] niki Portman nikiportman @domca.meta. test
] 1shna Mohan ishnamohan@domca. meta. test
Nina Tanaka ninatanaka@domca. meta, test
Pablo Neruda pabloneruda @domca.meta. test
Aman Al amanali@domca.meta. test

] Juan Christie juanchristie @domca.meta. test
[ pevika Sharma devikasharma@domca. meta. test
[ Karl Jordan karljordan @domeca.meta. test
[ Tim Ashfird timashford @dnmea. meta. test
<

Cancel

B e

4. Select one or more mailboxes and groups that want to add to the user-defined group. If you

select one or more groups, all mailboxes in that group will also be add to the user-defined

group during t

5. Click Next. The Summary window opens that indicates the user-defined group that will be

created.

i Import group wizard

Summary

Summary:

he import process.

Creating manual group:
-Demo Group

I

6. Click Finish to start the group creation process. The Creating Object window opens. You can
click Back to revise your selection of mailboxes and groups.
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it Import group wizard

Creating objects

Progress:

Importing Member - Mailbox: Aman Ali
— Mailbox imported successfully

<<« Creating Manual Group: Demo Group >3
—Manual Group created successfully

Processing finished

7. When the import process has completed, click Close.

Steps to verify the imported and user-defined groups
1. Open the Address Book Manager

2. Click the Groups tab and verify that the imported Active Directory and user-defined groups
appear in the list view as expected. User-defined groups are highlighted in green '

™ Address book Manager

Setup  Refresh

Address book and settings

0 RDN Display name Alias emal add... Group type
Synchromeation
S & company Administrator Company Administrator Company Administrator auto

ﬂ Compliance Management Compliance Management Compliance Management auto
| cervers
&, Domain Admins Domain Admins Domain Admins auto
ﬂ Domain Users Domain Users Domain Users auto
s Help Desk Help Desk Help Desk auto
ﬂ Helpdesk Administrator Helpdesk Administrator Helpdesk Administrator auto
ﬂ Organization Management  Organization Management Organization Management auto
a Security Administrator Security Administrator Security Administrator auto

g HaEURES

: £ >
9 groups

3. Select a group and right-click to open the context menu. Click Properties. The Properties
window of the selected group opens.

4. Click the Members tab and verify that the list of mailboxes were imported as expected.
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Synchronizing Address Book Manager

Synchronization with the Microsoft Exchange servers keeps groups and mailboxes up to date so
that emails can be archived without problems. With the Address Book Manager, you can set up
automatic synchronization schedules and initiate manual synchronization of various artifacts.

In this topic:

Steps to perform a manual synchronization

Steps to schedule automatic synchronization

Steps to perform a manual synchronization

1. Open Address Book Manager by clicking the toolbar icon W or clicking Address Book Manager
from the Tools menu.

2. The Synchronization tab opens by default.

7 Address book Manager

Setup  Refresh

Address book and settings

‘, Synchronization

= SETVETS

v:'_ Ernins

& IHEBUHES

74

Exchange Synchronization

Enable Mailbox Update

Enable Group Update

Sync Mow Schedule

Exchange Permissions Synchronization

Enable Exchange Mailbox permission sync
Enable Mailbox Folder permission sync

Enable Public Folder permission sync

Schedule

Select servers:

Server Name

AMYX 16EXCH
democompany.onmicrosoft.com

Apply

3. Select the Microsoft Exchange mailboxes, groups and permissions that you want to

synchronize.

4. Inthe Select servers box, select the Microsoft Exchange servers with which you want to

synchronize the mailboxes, groups and permissions.

5. Click Apply to confirm the settings.

6. Click Sync Now in the Microsoft Exchange Synchronization box to manually initiate the
synchronization of the mailboxes and groups with the selected Microsoft Exchange servers.
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"% Synchronization

Processing Exchange Synchronization’

Processing: .. Server: 22

(

START: 9/1/2019 10:38:19 PM

Processing Server —> AMX16EXCH

Total mailboxes to process = 5

MNumber of mailboxes updated successfully = 5
Number of mailboxes faled to update =0

- Number of deleted mailboxes = 0
Total groups to process = 2

Mumber of groups updated successfully = 2
Mumber of groups failed to update =0

- Number of deleted groups =0

- Number of new mailboxes imported = 6
- Number of new groups imported = 0

Processing Server —-> democompany.onmicrosoft. com

Total mailboxes to process = 1

_

7. Click Stop to halt the synchronization process before it completes. When the process
completes, click the Close button that opens. You can find the results of the synchronization

processin alogfile located at C: \Program Files (x86)\Metalogix\MAM4Microsoft
Exchange\Log\Synchronization <timestamp>.log

8. Click Sync Now in the Microsoft Exchange Permissions Synchronization box to manually initiate
the synchronization of the mailboxes and groups with the selected Microsoft Exchange
servers.

7% Synchronization

Processing Exchange Permissions Synchrofization)

Processing: ... Server: 22
( J

START: 9/1/2019 10:48:19 PM ~

Processing Server —> AMY 16EXCH

—> Synchronizing Mailbox Permissions
Total mailboxes to process = 11

Number of mailboxes updated successfully =0
MNumber of mailboxes failled to update = 11

—= Synchronizing Mailbox Folder Permissions
Total mailboxes to process = 11

MNumber of mailboxes updated successfully = 11
Number of mailboxes faled to update =0

Number of folders updated successfully = 171
Number of folders failed to update =0

—>= Synchronizing Public Folder Permissions

Total public folder mailboxes to process = 1

Number of public folder mailboxes updated successfully = 0 [¥]

_

9. Click Stop to halt the synchronization process before it completes. When the process
completes, click the Close button that opens. You can find the results of the synchronization

processin alogfile locatedat c: \Program Files (x86)\Metalogix\MAM4Microsoft
Exchange\Log\Synchronization <timestamp>.log
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Steps to schedule automatic synchronization

1. Open Address Book Manager by clicking the toolbar icon Wor clicking Address Book Manager
from the Tools menu.

2. The Synchronization tab opens by default.

" Address book Manager

Setup  Refresh

Address book and settings

Synchronization
Exchange Synchronization Exchange Permissions Synchronization

SETVETS

Enable Maibox Update Enable Exchange Malbox permission sync
L LT upE

Enable Mailbox Folder permission sync
Enable Group Update

HabiEES

Enable Public Folder permission sync

Snce Scuci

Select servers:

Server Name

AMYX 16EXCH
democompany.onmicrosoft.com

/’ |

3. Select the Microsoft Exchange mailboxes, groups and permissions that you want to
synchronize.

4. Inthe Select servers box, select the Microsoft Exchange servers with which you want to
synchronize the mailboxes, groups and permissions.

5. Click Schedule in the Microsoft Exchange Synchronization box. The Microsoft Exchange
Synchronization Scheduler dialog opens.

™ Exchange Synchronization scheduler =R
Scheduling

M YTICHTOTIZa L0 STHET (eSS

Use scheduled synchronization
0 [ 12 18

Monday

Tuesday

Wednesday
Thursday
Friday
Saturday
Sunday

Please mark the hours on the weekly plan when the
synchronization should take place

_
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6. Select Use scheduled synchronization to enable the synchronization calendar. Each row
corresponds to a day of the week. Each column corresponds to an hour of the day (24-hour
clock).

7. Tosetup aschedule using the synchronization calendar, click the cell that corresponds to the
day of the week and the hour of day when you want the scheduler to initiate a
synchronization job. For example, in the figure above, the synchronization schedule is set to
start at 18:00 hrs (6 pm) every weekday. The time zone of the computer where the application
is running will be used to determine the time.

i | NOTE: If you select consecutive cells in a single row, synchronization will start
automatically every hour on the hour. It will consume unnecessary processing time and is
not recommended.

8. Click OKto save the schedule or Cancel to discard the setup.

9. You can find the results of the scheduled synchronization process in a log file located at C:
\Program Files (x86)\Metalogix\MAM4Microsoft
Exchange\Log\Synchronization <timestamp>.log

Publish Archive Manager Forms

Archive Manager Forms are a set of custom Outlook forms that are used to display and work with
archived emails. You can choose to publish these custom forms to the Organizational Forms
Library of your on-premise Exchange Server, or publish these forms to the Personal Forms Library
of each user whether they use an on-premise Exchange Server or the online Exchange server
(0365).

This topic describes the steps to use the Forms Installer to publish the Archive Manager Forms
directly to the Organizational Forms Library of your on-premise Exchange server, or prepare the
the Archive Manager Forms for publishing to the Personal Forms Library of each on-premise or
0365 user registered in the domain active directory using the Group Policy Object (GPO).

e Publish Forms to Organizational Forms Library

e Publish Forms to Personal Forms Library

Publish Forms to Organizational Forms Library

In this topic:

e Steps to publish forms to the Organization Forms Library

e Steps to activate Archive Manager forms in mailboxes
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Steps to publish forms to the Organization Forms Library

1 | NOTE: Itis assumed that the Organizational Forms Library exists on the on-premise Exchange
Server. For more information see Setup the Organizational Forms Library.

1. Logintothe server where Archive Manager for Exchange (designated the Archive serveris a
distributed deployment) was installed (eg. AMXSERVER-A) with the credentials of the
superuser (eg. democorp\mamadmin)

2. To open the Outlook Forms Setup wizard do one of the following:

o If the Post installation Tasks wizard is not already open, you can open the the Post
installation Tasks wizard from C:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe and then click
Start next to step 2 to start the installer.

e Start the forms installer directly from Cc:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\Forms\FormsInstaller.exe.

Forms Installer

Outlook Forms Setup

Selectinstallationtype

& Install / repair
@ Install or repair Outlook Forms

" Uninstall

Uninstall Forms

3. Select Install/repair and then click Next. The Outlook Forms Setup - Folder Location window
for the form template opens.
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Forms Installer

Outlook Forms Setup

Locate the folder, whereform templates are stored:

C:\Program Files (x86)\Metalogix\MAM4Exchange{Tools\Forms {Templates | Browse, ..

The default location is displayed. Click Browse to locate the template folder if you have
moved the templates to a different location.
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4. Click Next. The Outlook Forms Setup - Form Selection window open.

Forms Installer

Outlook Forms Setup

Select forms to install or repair

Available forms: Selected forms:

IPM. Appointment.oft
IPM.Contact.oft
IPM.Task.oft

PamMessage. Document. oft
PamMessage . Forwarded. oft
PamMessage. oft
PamMessage . Post.oft
PamMessage. Replied.oft

=

<<

Select all the forms from the Available forms list and move it to the Selected forms list.

5. Click Next. The Outlook Forms Setup - Enable/disable Outlook forms events window opens.

Forms Installer

Outlook Forms Sefup

Enable/disable Qutlook forms events

Leave the following options checked unless you want the Qutlook forms to perform some
specificfunctions. Please consult the installation documentation for more information.

[¥ OnOpen
[¥ OnReply
[¥ OnReply to &ll

[¥ On Forward

Keep the default selections on this page unless you want to change the behavior as described
below:

a. On Open - When checked, this option presents a shortcut that can be clicked to download
the archived email but disables the ability to use the Previous Item and Next Item
functionality in Outlook because archived emails are offline copies and are not aware of
previous or next emails. When unchecked, the archived email cannot be downloaded or
viewed.
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b. OnReply - When checked, the content of the email isincluded in the reply to the sender of

the original email. When unchecked, the shortcut to the archived email is included in the
reply message and can be accessed only by members of the Exchange server.

On Reply to All - When checked, the content of the email is included in the reply to
recipients of the original email. When unchecked, the shortcut to the archived email is
included in the reply message and can be accessed only by members of the Exchange
server.

On Forward - When checked, the content of the email is forwarded to the new recipient(s)
of the original email. When unchecked, the shortcut to the archived email is forwarded to
the new recipient and can be accessed only by members of the Exchange server.

6. Click Next. The Outlook Forms Setup - Retrieve servers identification window opens.

Forms Installer

Outlook Forms Sefup

Please define a primary and secondary Retrieve Server name for each location in your
organization. If you have only one Archive Server, you can provide an alternative name
for the same server. If you have a dedicated Retrieve Server in the arganization, please
make sure that this server is entered as the Primary Retrieve Server. The Secondary
Retrieve Server is used only if the primary is not available.

Location ID | Primary Retrieve Server | Secondary Retrieve Server

1 AMKSERVER-R. AMXSERVER.-A

Specify the information as described below:

a.

Location ID - Each Archive Manager for Exchange server is bound to a single location
identified by the Location Id.

Primary Retrieve Server - If the deployment topology has just one standalone Archive
Manager for Exchange server then enter the NetBIOS name of the standalone server. If the
deployment topology has a dedicated Archive Manager for Exchange server with the
Retrieve role, then specify the NetBIOS name of the Retrieve server (eg. AMXSERVER-R).

Secondary Retrieve Server - For a standalone deployment topology, enter an alternate
identifier (eg. IP address) of the same server. For a dedicated Retrieve server specify the
NetBIOS name of the Archive server.
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Examples:

Topology Primary Retrieve Server Secondary Retrieve Server

Standalone Archive server NetBIOS name of the IP address of the Archive
Archive server (eg. server (eg. 10.20.30.40)
AMXSERVER)

Dedicated Archive and NetBIOS name of the NetBIOS name of the

Retrieve servers Retrieve server (eg. Archive server (eg.
AMXSERVER-R) AMXSERVER-A)

Load-balanced Retrieve NetBIOS name of the load IP Address of the load

servers balancer balancer

7. Click Next. The Outlook Forms Setup - Retrieval settings window opens.

Forms Installer

Outlook Forms Sefup

Retrievalsettings

If you are not sure with these settings, leave this page unchanged or read the
documentation.

[~ Use SSL (https) in server communication

[¥ Openmessage as read-only

The options are as described below:

a. Use SSL (https) in server connection - Select this option only if the Exchange server
communication uses SSL.

b. Open message as read-only - When checked, archived emails are opened in read-only
mode. When this option is unchecked, users are allowed to modify archived emails but
these changes are not updated in the archive. Users with Archive Manager Outlook Addin
installed can modify archived emails by creating new email versions in the archive even if
the Open message as read-only check box is selected.
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8. Click Next. The Outlook Forms Setup - Publishing forms window opens.

Forms Installer

Outlook Forms Setup

Publishing forms

Select the chedk box to publish forms to the Organizational Forms Library. Clear the
check box 50 users can publish forms to their Personal Forms Library.

¥ Publishfarms to the Organizational Forms Library

9. Click Next. The Outlook Forms Setup - Summary window opens.

Forms Installer

Outlook Forms Setup

Summary:

Please make sure that Outlook is started. You have to log on to the mailbox which has A
write permissions in the organizational forms library.
Flease also make sure that Outlook is not in cached mode.

The following forms will be published: (from folder: C:\Program Files (x86)\Metalogix
MaM4ExchangeTools\Forms {Templates)

- IPM. Appointment.oft

- IPM.Contact.oft

- IPM.Task.oft

- PamMessage. Document, oft

- PamMessage . Forwarded. oft

- PamMessage.oft

- PamMessage. Post.oft

- PamMessage.Replied.oft

Enfry #1 W
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Outlook Forms Setup - Install progress window opens.

Forms Installer

Outlook Forms Setup

Install progress:

File copied. Source:
File copied. Source:
File copied. Source:

IPM. Appointment. oft OK
IPM.Contact.oft OK

IPM. Task, oft OK

PamMessage. Document. oft OK
PamMessage. Forwarded. oft QK
PamMessage. oft OK
PamMessage. Post.oft OK
PamMessage.Replied.oft OK

Temporary folder removed

<

'C:\Program Files (x86)\Metalogix\MAMAExchange \Tools\Forms{Templz A
'C:\Program Files (x&6)\Metalogix\MAM4Exchange {Tools\Forms Templz

'C:\Program Files (x86) \MetalogixMAMAExchange \Tools\FormsTemplz

File copied. Source: 'C:\Program Files (x&6)Metalogix\MAM4Exchange {Tools\Forms Templz

Publishing form:
Publishing form:
Publishing form:
Publishing form:
Publishing form:
Publishing form:
Publishing form:
Publishing form:

Zancel

When the forms are published click Finish.

10. Verify the settings or click Back to revise the settings. Click Install to publish the forms. The

11. To verify that the forms were published to the Organizational Forms Library in the Exchange

server, open an Outlook client account connected to the Exchange server. From the Home tab

click New Items > More Items > Choose Form. In the Look In list, click Organizational Forms

Library and view the published forms.

Choose Form

Look In: |§Dlganizatiunal Farms Library

] [ Erowse.. ==

PamMessage
PamMessage
PamMessage
PamMessage
PamMessage.Document
PamMessage.Forwarded
PamMessage.Post
PamMessage.Replied

Message class: IPM. Appointment.PamMessage

Display name: |PEH'IMESSEQE | I Open I
File narme: | | | Cancel |
Description: Appaintment form
Contact: Version: 3.3000.0035
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Steps to activate Archive Manager forms in mailboxes

After publishing the forms, it is recommended to activate any one Archive Manager form for all
users to ensure that the forms are immediately available to the users.

1.

Open Outlook on the Archive Manager server with your administrator or super-user
credentials.

Click the Home tab and navigate to New Items > More Items > Choose Form.
Choose Organizational Forms Library from the Look in drop down.

Select the PamMessage form that has the archived email icon in the Description (to display
the icon click Advanced)

Choose Form *

Look In: | Organizational Forms Library [ Browse...

PamMessage
PamMessage
PamMessage

4|
PamMessage.Document
PamMessage.Forwarded
PamMessage.Post
PamMessage.Replied

Display name: | PamMessage
Cancel
Description: %, Mote form Athancedc<
N
Contact: Version: 3.3000.0035

Message class: IPM.Note.PamMessage

Click and hold the SHIFT-key and double-click to load the form. The form opens like a normal
email.

Send this email to all mailboxes you plan to archive. When users receive the email, the new
set of custom forms in the Organizational Forms Library will be available to the users.

NOTE:

a. If there are multiple languages (multiple organizational form libraries), then you need to
publish the forms using a language specific Outlook and account —one for each language.
b. To replicate the Archive Manager forms in the Public Information Store, use an Archive
Manager form to send an email to your Inbox folder. Then copy or move the email to the
Public Folder you wish to archive. The Archive Manager forms are replicated in the Public
Information Store too.
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Publish Forms to Personal Forms Library

In this topic:

e Steps to prepare forms for publishing

e Stepstoinstall the Forms Publisher to publish forms

e Stepsto use the Forms Publisher to publish forms

e Steps to use the Group Policy Object (GPO) to publish forms

Steps to prepare forms for publishing

1. Loginto the server where Archive Manager for Exchange (designated the Archive serveris a
distributed deployment) was installed (eg. AMXSERVER-A) with the credentials of the
superuser (eg. democorp\mamadmin)

2. To open the Outlook Forms Setup wizard do one of the following:

e If the Post installation Tasks wizard is not already open, you can open the the Post
installation Tasks wizard from C:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe and then click
Start next to step 2 to start the installer.

e Start the forms installer directly from c:\Program Files (x86)
\Metalogix\MAM4Exchange\Tools\Forms\FormsInstaller.exe.

Forms Installer

Outlook Forms Setup

Selectinstallationtype

& Install / repair
@ Install or repair Outlook Forms

" Uninstall

Uninstall Forms
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3. Select Install/repair and then click Next. The Outlook Forms Setup - Folder Location window
opens.

Forms Installer

Outlook Forms

Locate the folder, whereform templates are stored:

C:\Program Files (x86)\Metalogix\MAM4Exchange{Tools\Forms {Templates | Browse, ..

The default location is displayed. Click Browse to locate the template folder if you have
moved the templates to a different location

4. Click Next. The Outlook Forms Setup - Form Selection window opens.

Forms Installer

Outlook Forms

Select forms to install or repair

Available forms: Selected forms:

IPM. Appointment.oft
IPM.Contact.oft
IPM.Task.oft

PamMessage. Document. oft
PamMessage . Forwarded. oft
PamMessage. oft
PamMessage . Post.oft
PamMessage. Replied.oft

=

<<

Select all the forms from the Available forms list and move it to the Selected forms list.
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5. Click Next. The Outlook Forms Setup - Enable/disable Outlook forms events window opens.

Forms Installer

Outlook Forms Setup

Enablefdisable Qutlook forms events

Leave the following options checked unless you want the Qutlook forms to perform some
specificfunctions. Please consult the installation documentation for more information.

[+ On Open
[+ OnReply
[¥ OnReply to &ll

[+ On Forward

Keep the default selections on this page unless you want to change the behavior as described
below:

a. On Open - When checked, this option presents a shortcut that can be clicked to download
the archived email but disables the ability to use the Previous Item and Next Item
functionality in Outlook because archived emails are offline copies and are not aware of
previous or next emails. When unchecked, the archived email cannot be downloaded or
viewed.

b. OnReply - When checked, the content of the email isincluded in the reply to the sender of
the original email. When unchecked, the shortcut to the archived email is included in the
reply message and can be accessed only by members of the Exchange server.

c. OnReply to All - When checked, the content of the email is included in the reply to
recipients of the original email. When unchecked, the shortcut to the archived email is
included in the reply message and can be accessed only by members of the Exchange
server.

d. On Forward - When checked, the content of the email is forwarded to the new recipient(s)
of the original email. When unchecked, the shortcut to the archived email is forwarded to
the new recipient and can be accessed only by members of the Exchange server.
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6. Click Next. The Outlook Forms Setup - Retrieve servers identification window opens.

Forms Installer

Outlook Forms Setup

Please define a primary and secondary Retrieve Server name for each location in vaur
organization. If you have only one Archive Server, you can provide an alternative name
for the same server. If you have a dedicated Retrieve Server in the organization, please
make sure that this server is entered as the Primary Retrieve Server. The Secondary
Retrieve Server is used only if the primary is not available.

Location 10 | Primary Retrieve Server | Secondary Retrieve Server

1 AMASERVER-R. AMXSERVER--A

Specify the information as described below:

a.

Location ID - Each Archive Manager for Exchange server is bound to a single location
identified by the Location Id.

Primary Retrieve Server - If the deployment topology has just one standalone Archive
Manager for Exchange server then enter the NetBIOS name of the standalone server. If the
deployment topology has a dedicated Archive Manager for Exchange server with the
Retrieve role, then specify the NetBIOS name of the Retrieve server (eg. AMXSERVER-R).

Secondary Retrieve Server - For a standalone deployment topology, enter the same
NetBIOS name or IP address of the standalone Archive server. If the deployment topology
has a dedicated Archive Manager for Exchange server with the Archive role then specify the
NetBIOS name of the Archive server.

Examples:
Topology Primary Retrieve Server Secondary Retrieve Server
Standalone Archive server NetBIOS name or IP address | NetBIOS name or IP address
of the Archive server (eg. of the Archive server (eg.
AMXSERVER) AMXSERVER)
Dedicated Archive and NetBIOS name or IP address | NetBIOS name or IP address
Retrieve servers of the Retrieve server (eg. of the Archive server (eg.
AMXSERVER-R) AMXSERVER-A)
Load-balanced Retrieve NetBIOS name or IP address | NetBIOS name or IP Address
servers of the load balancer of the load balancer
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7. Click Next. The Outlook Forms Setup - Retrieval settings window opens.

Forms Installer

Outlook Forms Setup

Retrievalsettings

If you are not sure with these settings, leave this page unchanged or read the
documentation.

[~ Use S5L (https) in server communication

[+ Openmessage as read-only

The options are as described below:

a. Use SSL (https) in server connection - Select this option only if the Exchange server
communication uses SSL.

b. Open message as read-only - When checked, archived emails are opened in read-only
mode. When this option is unchecked, users are allowed to modify archived emails but
these changes are not updated in the archive. Users with Archive Manager Outlook Addin
installed can modify archived emails by creating new email versions in the archive even if
the Open message as read-only check box is selected.

8. Click Next. The Outlook Forms Setup - Publishing forms window opens. Clear the checkbox
Publishing forms to the Organizational Forms Library.

Forms Installer

Outlook Forms Setup

Publishing forms

Select the chedk box to publish forms to the Organizational Forms Library. Clear the
check box 50 users can publish forms to their Personal Forms Library.

[ Publishfarms to the Organizational Forms Library
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9. Click Next. The Outlook Forms Setup - Summary window opens.

Forms Installer

Outlook Forms Setup

Summary:

Please make sure that Outlook is started. You have to log on to the mailbox which has
write permissions in the organizational forms library.
Please also make sure that Outlook is not in cached mode.

The following forms will be published: (from folder: C:\Program Files (x86)Metalogix
WMAM4Exchange Tools\Forms{Templates)

- IPM. Appointment. oft

- IPM.Contact.oft

- IPM. Task.oft

- PamMessage. Document. oft

- PamMessage. Forwarded. oft

- PamMessage. oft

- PamMessage.Post.oft

- PamMessage Replied.oft

Entry £1

~

W

10. Click Install to prepare the forms for publishing. The Outlook Forms Setup - Install progress

window opens.

Forms Installer

Outlook Forms Setup

Install progress:

Installation started

File copied. Source: 'C:\Program Files (x&6)Metalogix\MAM4Exchange {Tools\Forms Templz
File copied. Source: 'C:'\Program Files (x86)Metalogix\MAM4ExchangeTools\Forms\Templz
File copied. Source: 'C:\Program Files (x&6)Metalogix\MAM4Exchange {Tools\Forms Templz
File copied. Source: 'C:'\Program Files (x86)Metalogix\MAM4ExchangeTools\Forms\Templz
File copied. Source: 'C:\Program Files (x&6)Metalogix\MAM4Exchange {Tools\Forms Templz
File copied. Source: 'C:'\Program Files (x86)Metalogix\MAM4ExchangeTools\Forms\Templz
File copied. Source: 'C:\Program Files (x&6)Metalogix\MAM4Exchange {Tools\Forms Templz
File copied. Source: 'C:'\Program Files (x86)Metalogix\MAM4ExchangeTools\Forms\Templz
Temporary folder removed

< >

11. When the forms are prepared for publishing click Finish. When you complete this step, the

Archive Manager forms are ready to be published to the Personal Forms Library.
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Steps to install the Forms Publisher to publish forms

1. Open<Media-folder>\Archive Manager Installation Package\Exchange\Addin
and run the Archive Manager Forms Publisher Setup.msi installer.

ﬁ Metalegix Forms Publisher Installer - InstallShield Wizard >

Welcome to the InstallShield Wizard for
Metalogix Forms Publisher Installer

The Installshield(R) Wizard will allow you to modify, repair, or
remove Metalogix Forms Publisher Installer. To continue, dlick

Mext,

2. Click Next. The Destination Folder window opens.

ﬁ Metalegix Forms Publisher Installer - InstallShield Wizard

Destination Folder
Click Mext to install to this folder, or dick Change to install to a different folder.

Install Metalogix Forms Publisher Installer to:
C:\Program Files (x86)\Metalogix\FormsPublisher change. ..

Installshield
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3. Click Change to revise the location of the installation folder, or click Next to continue. The
Ready to Install the Program window opens.

ﬂ Metalegix Forms Publisher Installer - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield

< Back ] Install ] Cancel

4. Click Install. When the installation completes, the InstallShield Wizard Completed window
opens.

ﬂ Metalegix Forms Publisher Installer - InstallShield Wizard d

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Metalogix
Farms Publisher Installer. Click Finish to exit the wizard.

Launch Forms Publisher

If you wish to publish the forms to the Personal Forms Library immediately, select the
checkbox Launch Forms Publisher and click Finish. Then follow the steps in the next section to
publish the forms. If you clear the checkbox, you can start the Form Publisher form the Start
menu > Metalogix > Form Publisher.
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Steps to use the Forms Publisher to publish forms

1. If the Forms Publisheris not already opened, start the Form Publisher form the Start menu >
Metalogix > Form Publisher. The Forms Publisher window opens.

-?d Forms Publisher — ¥

Download folder for forms

Folder: sftware \Archive Manager'ADDINCACHE \FormCache

Browse

Archive Manager web service settings

Hostname: |AMXSERVER

[] Connect to Archive Manager web service using HTTPS

http://AMXSERVER-¥/exchange PAMWS /Get Form aspx

Cocs

2. Click Install to publish the forms to the Personal Forms Library.

%] Forms Publisher — X

PamMessage . Forwarded .oft downloaded successfully ~
PamMessage Document oft downloaded successfully
PamMessage . Post oft downloaded successfully

IPM_Appointment .oft downloaded successfully

IPM Contact oft downloaded successfully

IPM.Task oft downloaded successfully

PamMessage oft published succesfully

PamMessage . Replied.oft published succesfully

PamMessage Forwarded oft published succesfully

PamMessage. Document .oft published succesfully
PamMessage Post oft published succesfully

IPM.Appoirtment .oftIPM.Contact oftIPM. Task oft

All forms done "

3. Click Close to exit the Forms Publisher.

4. Verify that the custom forms are present in the Personal Forms Library.
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Steps to use the Group Policy Object (GPO) to publish forms
The steps to set up the GPO has three stages:

e Create ashared folder on the domain controller for the Forms Publisherinstaller

e Create aregistry item to store the web service URL that will be invoked by the Forms Publisher

e Create a GPO to distribute the Forms Publisher Setup to intended users

Create a shared folder on the domain controller for the Forms Publisher
installer

1. Logintoyour domain controller and open Server Manager.

2. Create ashared folder called Forms Publisher. Share it with all intended users with the Read
permission. Note the UNC path of the shared folder

Forms Publisher Properties >

General Sharng  Securty Previous Versions  Customize

Metwork File and Folder Sharing

Formms Publisher
Shared

Metwork Path:
WAMXDCForms Publisher

Advanced Sharing

Set custom permigsions, create multiple shares, and set other
advanced sharng options.

E;Ag'u'anced Sharing...

Close Cancel Apply

3. Copy and paste the Archive Manager Forms Publisher Setup.msi installer to your shared

folder. This file is already in your Archive Manager server at this location: <shared-media-
folder>\Archive Manager Installation Package\Exchange\Addin
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'=[ Open

>

« « 4 [ WAMXDC\Forms Publisher

w | @ Search Forms Publisher 2

Organize « Mew folder

_ ~
= Documents & MName

4 Downloads
D Music

=/ Pictures

m Videos
2 Windows (i)

- lemporary Stora
[_} MNetwork

v £

ﬁ! Archive Manager Forms Publisher Setup....

= O @
Date modified Type Size

5/28/2020 10:49 AM  Windows Installer ... 2,519 KB

File name: | Archive Manager Forms Publisher Setup.msi

v| Windows Installer packages (*.r ~

Create aregistry item to store the web service that will be invoked by the

Forms Publisher

The following steps are instructions to modify the registry of the domain controller.
Serious problems might occur if you modify the registry incorrectly by using the Registry

Editor or by using another method.

4. Open the Registry. Expand HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node and create a

new key named Metalogix.

v WOWed32Mode
\ Classes
Clients
Intel
Microsoft
QODBC
Policies
RegisteredApplications
SMIA
WOWed32MNode
e Metalogix
SYSTEM
HEEY_USERS
HEEY_CURREMT_COMFIG

Create a GPO to distribute the Forms Publisher Setup to intended users

5. Click Tools and then click Group Policy Management. The Group Policy Management window

opens.

6. Expand the console tree Forest > Domains > <YourDomain> and click Group Policy Objects.
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2L Group Policy Management
Z File Action View Window Help
e=|2HE G|

(=4 Group Policy Management
~ _ﬁ Forest democorp.com
v |55 Domains

Group Policy Objects in democorp.com
Contents  Delegation

-

v jﬂ democorp.com Name GPO Status WMI Filter Modified
sz Default Domain Policy| | | =] Default Domain Controller..  Enabled None 10/1/2019 1:32:...

2| Domain Controllers =/ Default Domain Policy Enabled None 9/28/201912:1...
4| Microsoft Exchange 5e

= Group Palicy Objects
& WM Filters
]| Starter GPOs

[ Sites

si¥ Group Policy Madeling

¢ Group Policy Results

7. Rightclick inthe Group Policy Object pane, and click New from the context menu. The New
GPO window opens.

Mew GPO *

MName:

Publish Archive Manager Forms

Source Starter GPO:
{none)

Enter the information as described below:

a. Name - enter a unique name to describe the policy. For example, enter Publish Archive
Manager Forms.

b. Source Starter - (none).

Click OK to save the new GPO.

Right click your domain name and then click Link an Existing GPO from the context menu. The
Select GPO window opens.
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2L Group Policy Management
Z File Action View Window Help

= T B EL HRE

-8 X

(=4 Group Policy Management democorp.com

Group Paolicy objects:

™ —é Fn_)re;t: derﬂocorp.com Status  Linked Group Policy Objects  Group Policy Inhertance  Delegation
v [ £5 Domains
~ i democorp.rom . X o
d SYSVOL (DFSR] replication for this d it
= Default Create a GPO in this domain, and Link it here... M { ) replication forthis domain a3
> [Z] Domair Link an Existing GPO...
? ﬂ Microsg Block Inheritance
> L Group F
> ;T WMIFil Group Palicy Modeling Wizard... line domain controller for this domain. Change
> L] Starter ( MNew Organizational Unit
» [ Sites
¥ Group Palicy Iy Search... s demain.
[4 Group Policy R Change Domain Controller... rastructure status from all of the domain controllers
Remove
Active Directory Users and Computers...
View >
Mew Window from Here
Refresh
Properties
Detect Now
< Help
Select an existing GPO and link it to this container
10. Choose the GPO that you created and then click OK.
Select GPO >
Look in this domain:
democorp.com o

Mame

Default Domain Controllers Policy
Default Domain Policy

Publish Archive Manager Forms

Cancel

opens.
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2L Group Policy Management

2 | Domain Controllers
2| Microsoft Exchange 5¢
= Group Policy Objects
& WMI Filters
[ Starter GPOs

@ Sites

st Group Policy Medeling

_ Group Policy Results

- [m] X
Z File Action View Window Help -8
= 5@ 6|
|£, Group Palicy Management Group Policy Objects in democorp.com
~ _ﬁ Forest: der‘nnmrp.cnm Conterts  Delegation
v |55 Domains -
v F2 democorp.com Name GPO Status WMI Fitter Modified Ow
sz Default Domain Policy)| | /=] Defaut Domain Controllers Policy  Enabled None 10/1/20191:32...  Dor
= Distribute Archive Mar) MNane 5/28/201512:1... Dor

efautt Domain Policy
=] Distribute ArchiveMagage
Edit

GPO Status >

Enabled

Back Up...
Restore from Backup...

Import Settings...
Save Report...
Copy

Delete

Rename

Refresh

9/23/2020 2:08:...

12.

Navigate to User Configuration > Policies > Software Settings > Software Installation. Then

right-click Software Installation to open the context menu. Click New and then click Package.

=/ Group Policy Management Editor

File Action View Help

= |0 E= HE

- [m] X

\=[ Distribute Archive Manager Fon
w (& Computer Configuration
| Policies
| Preferences
~ i User Configuration
~ || Policies
~ [] Software Settings
Software instz''-*

Select an item to view its description.

| Distribute Archive Manager Forms [AMXDC.DEMOCORP.COM)] Policy

Mame

i Computer Configuration
i User Configuration

1 Windows Setting; New 4 Package...
| Administrative Te Paste
| Preferences
Refresh
Properties
Help

Extended /( Standard f

13. Browse to the shared folder you created in a step 2 above, and select the Archive Manager

Forms Publisher Setup.msi installer.
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= Open x

t |,_ WAMXDC\Forms Publisher v @ Search Forms Publisher yel
Organize - MNew folder = O @
@ Documents ~ MName Date modified Type Size
¥ Downlcads 5! Archive Manager Forms Publisher Setup.msi  9/25/2020 1234 PM  Windows Installer .. 2,533 KH
J‘! Music
&=/ Pictures
m Videos

im Windows (C)

- Temporary Stora
b Network

LU 4 >

File name: | Archive Manager Forms Publisher Setup.msi V| Windows Installer packages (*.r ~

14. Click Open. The Deploy Software window opens. Select the Advanced option.

Deploy Software =

Select deployment method:

() Published

Select this option to configure the Published or Assigned options.
and to apply modifications to a package.

Cancel

15. Click OK. The Metalogix Forms Publisher Installer Properties window opens. Click the
Deployment tab.
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Metalogix Forms Publisher Installer Properties ? x

General Deploymert  Upgrades Categories Modffications  Security

Deployment type
() Published

(®) Agsigned

Deployment options
Autodnstall this application by file extension activation

[] Uninstall this application when it falls out of the scope of
management

[] Do not display this package in the Add/Remove Programs control
panel

[] Install this application at logon

Installation user inteface options

() Basic
(@) Mapdimum

Advanced...

Cancel

Set the properties as described below:

a. Fromthe Deployment type section, select the Assigned option.

b. From the Deployment options section, select the Install this application at logon options
check box.

16. Click OK to close the Metalogix Forms Publisher Installer Properties window, and verify that
application appears in the Group Policy Management Editor.

\=[ Group Policy Management Editor
File Action View Help

s | mEEdE HE

=/ Publish Archive Manager Forms|| Name - Version Deploymentst.. Source

v i C‘?jr:plu.t.er Configuration E# Metalogix Forms Publisher Installer 2.3 Assigned WAMXDC\Forms Publisher\Archive Manager Forms Publisher Setup.msi
| Policies
| Preferences

v %, User Configuration
w || Policies
~ | Software Settings
Software installat
~| Windows Settings
| Administrative Temp
| Preferences

17. From the Group Policy Management Editor expand Computer Configuration > Preferences >
Windows Settings and then click Registry.
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=/ Group Policy Management Editor - m} x
File Action View Help
e EOlmc: HE B+

(=[ Publish Archive Manager Forms
w (& Computer Configuration
» ] Policies
~w || Preferences
w | Windows Settings Processing £
Environment There are no items to show in this view,
43 Files
(3¢ Folders
Ini Files
> g Registry
k3 Metwork Shares Mew Registry [tem
[#] Shortcuts All Tasks Collection [tem
> (=] Control Panel Setting
~ i User Configuration Refresh
~ [] Policies
~ [] Software Settings Description
[ Software installat No policies selected Arrange lcons
» | Windows Settings
> [ Administrative Temp
» || Preferences Help

Order Action Hive

Registry Wizard

View

Line up lcons

< > Preferences

Add a new registry item

18. Right-click in the items pane to open the context menu. Then select New > Registry Item. The
new Registry Properties window opens.

Mew Registry Properties >
General  Common
Gy
Action: |Ereate V|
Hive: HKEY_LOCAL_MACHINE v
Key Path: | SOFTWARE\WOW6432Nade Metalogix |[=]
Value name
[ oefault | DownloadFormsService |
Value type: |REG_SZ w |
Value data: | http: //AMXSERVER,/ExchangeP AMWS fGetForm. asp |
foC 1| cancel || mpply || Hep

In the new Registry Properties window create a new registry item with the following values:
a. Action - select Create from the drop down.

b. Hive - select HKEY-LOCAL_MACHINE from the drop down.
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c. Key Path - enter SOFTWARE\Wow6432Node\Metalogix
d. Value name - enter DownloadFormsService
e. Value type - select REG_SZ from the drop down.

f. Value data - enter the address to web service which will download forms in the format
http://<Archive-Manager-Server>/ExchangePAMWS/GetForm.aspx

19. Click OK to save the registry item. Verify that the registry item appears in the registry items
list. Then exit the Group Policy Management Editor and the Group Policy Management tool.

1 | NOTE: The user policy will not take effect until a fresh logon occurs after a reboot of the
user's computer.

20. Verify that the GPO publishes the Archive Manager Forms to the Personal Forms Library when
they login to their computers.



8

Installation Verification

When you have completed the installation and configuration as described in this guide, log on to
the Archive server (eg. AMXSERVER-A) as the superuser and open Outlook. Send a couple of
emails, in order to see if you can read them.

Steps to verify your installation

1.

2
3.
4

Open the AMAC.

. Click the View menu on the toolbar and select the Archive view.

In the Look for text field type the name of one of your synchronized mailboxes and click Enter.

. After expanding the mailbox structure you will be able to see the list of emails in the right-

pane of the AMAC.
Right-click any email from a mailbox and choose Archive item from the context menu.

If the archiving process ends with the following dialog you have successfully managed to
archive your first email.

Processing result B’

Processing Finished,
Murber of ikems: 1
Processed items: 1
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Enhancements

Metalogix Archive Manager for Exchange can be extended with optional components to enhance
its capabilities.

Steps to install additional components

1. From yourinstallation media folder, run the MAMiInstaller.exe. The Welcome window
appears.

@ Archive Manager Installation Package X
WELCOME The Industry’s Most Trusted Collaboration Tools Today...
PLANNING
INSTALLATION Archive Migrator Archive Manager StoragePoint
TOOLS P
* ko8 =288
SETUPS e ——
MIGRATE THIRD PARTY EMAIL, FILE & SHAREPOINT STORAGE OPTIMIZATION &
ARCHIVES ARCHIVING PERFORMANCE

Metalogix
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2. From the navigation panel on the left, click SETUPS. The Setups window appears.

'.3 Archive Manager Installation Wizard X

WELCOME Setups Help
PLANNING ) N
Archive Manager Universal Access Setup Version 8.3.0.79

Archive Manager Universal Access Installer

INSTALLATION

TOOLS Archive Manager for Bxchange OVWA Edensions Setup Version 830.79

SETUPS Archive Manager for Exchange OWA Edensions Installer

Archive Manager SMTF Service Setup Version 830.79
Archive Manager SMTP Service Installer

&
D)
&

Archive Manager PST Gatherer Setup Version 8.3.0.79
Archive Manager PST Gatherer Installer

Archive Manager Outlook Addin x86 Setup Version 8.3.0
Archive Manager Outlook Addin helps you archive and restore emails in your Outlook

Archive Manager Outlook Addin <64 Setup Version 8.3.0
Archive Manager Outlook Addin helps you archive and restore emails in your Outloolk

Archive Manager Outlook Addin 201086 Setup Version 8.3.0
Archive Manager Outlook Addin helps you archive and restore emails in your Outloolk

Archive Manager Outlook Addin 201064 Setup Version 8.3.0
Archive Manager Outlook Addin helps you archive and restore emails in your Outloalk

Archive Manager Forms Publisher Setup Version 8.3.0.1
Metalogix Forms Publisher

Metalogix

3. Install one or more optional components. The components are as follows

o Archive Manager Universal Access Setup - allows mobile users, Mac users and Linux users to
work with archived emails. For more information see the Universal Access Install Guide.

¢ Archive Manager for Exchange OWA Extensions Setup - component that is installed on the
Microsoft Exchange Server to provide Outlook Web Access to end-users. For more
information see the OWA Installation Guide.

¢ Archive Manager SMTP Service Setup - enables processing of messages from an external
email server (0365, Gmail, Exchange, etc.). For more information see the SMTP Guide.

o Archive Manager PST Gatherer Setup - automated extension to the PST importer feature.
For more information see the PST Gatherer and Import Guide.

o Archive Manager Outlook Addin <version>Setup - gives authorized users the ability to
archive and restore emails in Outlook 2013 and above (x86 or x64). For more information
see the MS Outlook Addin User Guide.

o Archive Manager Forms Publisher Setup — ensures that custom Outlook forms are used to
display archived messages. For more information see the chapters Publishing Archive
Manager Forms and Publishing Archive Manager Forms for Office 365 in the Advanced
Installation Guide.
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Addendum

e Creating an MS SQL database with a database user

e Organizational Forms Library troubleshooting

e lLicense Activation

Setting up an MS SQL Server database

When planning to install Archive Manager, an empty database(s) and an appropriate database
user must be created before running the setup. This section guides you through the
configuration of SQL Server 2012 and creation of a database with a database user.

To configure your SQL Server 2012:

1. Open the SQL Server Configuration Manager and click the SQL Server Services node. Both
the SQL Server (SERVERNAME) and the SQL Server Browser services have to run.

[ Sql Server Configuration Manager — ] X
File Action View Help
= |#H|d=H
@ SOL Server Configuration Manager (Local) Name State Start Mode
B :Qt :er\rar ;Erwcesk Confi ion (32bit ﬁ S0OL Server Integration Services 13.0 Running Automatic
% SCQ}L Ne't‘fe’ c?tW:;1 DUC” 'gff”amt'_“ ( (3; #550L Full-text Filter Daemon Launcher (MSSQLSERVER) Running Manual
ative Client 11.0 Configuration
= SQL S L. hpad (MSSQLSERVER St d M |
5. S0L Server Network Configuration %SgL ;Ne’ I\EAL:IS:QLpSaER\u(‘ER Q ) R oppe A atnua i
& 5QL Native Client 11.0 Configuration erver { ) unning Htomatic
@ S0OL Server Analysis Services (MS50LSERVER) Stopped Manual
SQL Server Reporting Services (MSSQLSERVER) Running Automatic
ﬁ S0L Server Browser Stopped Other (Boot, Syste..
[Fa) SOL Server Agent (MSSOLSERVER) Stopped Manual
£ 3| € >

2. If the SQL Server Browser service is not started and the Start option available in its
context menu, it means that this service is disabled. To enable the service, right-click it
and from the context menu select Properties.

3. The Properties window opens. Switch over to the Service tab and change the Start Mode
from Disabled to Manual. Conclude by clicking Apply and OK and then try to start the
service again.
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SQL Server Browser Properties ? x
LlogOn Service  Advanced

Bl General
Binary Path “Ch\Program Files (x86)\Microsoft 5
Error Control 1
Exit Code 1077
Host Name AMXDB
Name SOL Server Browser
Process [D 0
SOL Service Type
Start Mode Disabled vl
State Automatic

Disabled
Start Mode
The start mode of this service,
concel || ooy || e

4. Inthe SQL Server Configuration Manager expand the SQL Server Network Configuration

node from the navigation tree. On the Protocols for SQL node you need to enable the
Named Pipes, the Shared Memory and the TCP/IP protocols.

Sql Server Configuration Manager

File Action View Help

= | EE=H

‘@ SQL Server Configuration Manager (Local)
[ sOL Server Services

8 SOL Server Network Configuration (32bit|| .

% SQL Mative Client 11.0 Configuration (32}
W _E_ SQL Server Metwork Configuration
B Protocols for MSSOLSERVER
% SOL Mative Client 11.0 Configuration

< >

Protocol Mame Status

%~ Shared Memory Enabled

‘o Mamed Pipes

HTCP/IP Enabled Enable
Disable

Properties

Help

Enable selected protocol.

5. Instead of enabling the TCP/IP using the context menu, we recommend opening its
Properties window. This window has two tabs, Protocol and IP Addresses. On the Protocol
tab set the Enabled to Yes.
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TCP/IP Properties ? X

Protocol | IP Addresses

B General
Yes -
Keep Alive 30000
Listen All Yes

Enabled
Enable or disable TCP/IP protocol for this server instance

Cancel Apply Help

6. On the IP Addresses tab you will see several sections - one for each network connection
and a local loopback connection indicated by the standard address of 127.0.0.1 For remote
access to the SQL Server Express 2012 instance the loopback connection is of no interest.

For the desired network connection the Active option should say Yes as should the Enabled

option. The IP address will probably be filled in for you (by Windows) and will be different
on your machine.
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IP Addresses

= p1
Active

Mo

TP Dynamic Ports Mo

TCP Port
P2
Active Yes

Enabled Mo

IP Address feSn10ea51afi1bfe:Gadl%12
TCP Dyhamic Pors

TCP Port 1433

P3

Active Yes

Enabled Mo

IP Address 10.16,100.55

TCP Dyhamic Pors

Ti™0 Dt

Enabled
Enable ar disable the IP address

QK | | Zancel | | Apply | | Help

If you wish to enable dynamic ports for your SQL Server Express 2012 instance then the TCP
Dynamic Ports option should be 0. To disable this option and use a fixed port change this
field to a blank value and fill in the port on the TCP Port option. Disabling dynamic ports is
non standard for named instances and should really only be done if you know exactly what
you are doing and why you want to do it.

Conclude by clicking Apply and then OK.
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TCP/IP Properties _
IP Addresses

B p1 -
Active Yes
Enabled Yes
IPAddress 192.165.27.2 =
TCP Dynamic Ports o B
TCP Port
= p2
Active Yes
Enabled Mo
IP Address feSn10ea51afi1bfe:Gadl%12
TCP Dyhamic Pors
TCP Port 1433
= r3
Active Yes
Enabled Mo
IP Address 10.16,100.55
TCP Dyhamic Pors >
T D DAt 1422

TCP Dynamic Ports
Elank, if dynamic ports are not enabled, Ta use dyhamic ports, setto Q.

QK | | Zancel | | Apply | | Help
TCP/IP Properties ? >
Protocol  IP Addresses
B 1pan
TCP Dynamic Ports 0
TCP Part 1433

TCP Port
TCP port

7. Forthe changes to take effect you need to restart both the SQL Server (SERVERNAME) and
SQL Server Browser services have to be restarted switching over to the SQL Server
Services node.

8. Check the Shared Memory, the TCP/IP and the Named Pipes client protocols on the SQL
Native Client Configuration node in the SQL Server Configuration Manager too. They
should all be enabled.
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Sql Server Configuration Manager
File Action View Help

= 2|EC=H

‘@ 50L Server Configuration Manager (Local)
B SOL Server Services
_E SQL Server Metwork Configuration (32bit]
@ SCL Mative Client 11.0 Configuration (324
W _E S0OL Server Metwork Configuration
B~ Protocols for MSSOLSERVER
v g SQOL Mative Client 11.0 Configuration
2L Client Protocols

\% Aliases

Mame Order Enabled
%~ Shared Memory 1 Enabled
WTCRAIP 2 Enabled
%~ Mamed Pipes 3 Enabled

Furthermore you will need to create an empty database and a database user for your Archive

Manager. To do so:

1. Connectto your SQL Server 2012 with the Microsoft SQL Server Management Studio, then
expand its tree and right-click on the Databases node. From the context menu choose to
create a new database.

2. Inthe New Database dialog, give the new database a name (e.g. exchangeDB) and you can
leave the owner to be the <default>. This owner will be changed later on, when you will
create a new login with table owner rights over the database you are creating. You can
also choose to change the default location for the Data file and Log file, if needed. Finish

by clicking OK.
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g New Database == -

Select a page | . .
i Script - Help
2 General ';S G
12 Options
1 Filegroups Databass nane; |EHC|"IEI"IQEDB| |

Owner: |<default> | |:|

Database files:

Logical Mame  File Type  Filegroup Initial Size [MB]  Autogrowth / M axzize
exchangeDB Rows ... FRIMARY By 1 MEB, Unlirmited
exchangeD... Log Mot Applicable 1 By 10 percent, Unlimited
Connection
Server
T0DBZ2
Connection:
FODEMO 2% dministrator
&7 View connection properties
Progress
F‘Ead_',' < m >
Add | Remowe
| QK | | Cancel

3. To create the Table Owner for the exchangeDB database you will need to create a new
login, a new scheme and a new user as well. We will name each of them “srv_exchange”.

To create a new login, expand the tree of the MS SQL Server Management Studio tool and
right-click on the Security tab and choose New/Login.

4. The new dialog opens. Before proceeding further on the General tab decide on the type
of authentication to be used:

Windows authentication - the user (e.g. “srv_exchange”) must already exist in the Active
Directory. Use the Search button to find your desired user in AD. It can be your Archive
Manager super-user as is described in the section “Creating a super-user account”.

SQL authentication —specify the login name (“srv_exchange” in our example). Make sure to
uncheck the Enforce password policy check box.
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5 Login - New = [ = -
S::E;::E?ETQB 6 Seript = [ Help
E"' Server Roles
—'%.4 User Mapping Login name: zrv_exchange Search...
% Securables — L
A Gratus ® Windows authentication
- () SOL Server authentication
() Mapped to certifizate
() Mapped to asymmetric key
Connection [ Map to Credential
Server bapped Credentials Credential Fravider
70DB2
Connection;
FODEMO2%Adminiztrataor
&Y Wiew connection properties
Proagress
Ready Diefault database: | exchangel B h |
Default language: | English Vl
| ak | | Cancel |

As for the Default database, select the EXCHANGEDB database and set the Default language
to be English.

5. Once this is done, you can switch over to the User Mapping tab. Here map to the
exchangeDB database a user (it will be automatically created and named with the same
name as the login) and select also the db_owner and public membership role for the
exchangeDB database.
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Select a paoge

1 General
1 Server Aoles

14 User Mapping
ﬁ Securables

2 Status

Connection

Server
FODB2

Connection:
FODEMOZWAdrinistrator

ﬂ Yiew connection properties

Progress

Ready

g Script IE Help

Uzerz mapped to this login:

___Map Database Jzer

master

rnode]

mzdb

FeportServer
ReportSemerTempl B
tempdb

exchangeDB siv_ewchange

Default Schema

[] Guest accaunt enabled far exchangeDB

[Dratabase role memberzhip for; exchangeDE

[] db_accessadmin
[] db_backupoperatar
[] db_datareader

[] db_datawriter

[] db_ddladmin

[] db_denydatareader
[] db_denydatavriter

.
[] db_securityadmin

[ public

6. Switching over to the Status tab. Make sure that the Permission to connect to database
engine is granted and also that the Login is enabled. Conclude by clicking OK.

Select apage
2 General

12 Server Foles
15 User Mapping
2 Securables
ot

g Script « IB Help

Settings
Permizzion to connect to databaze engine:
®) Grant
) Deny
Lagin:
® Enabled
() Disabled

Status

SOL Server authentication:

[] Login iz lacked out
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7. Nextyou will need to create a schema for your new database login. To do so, expand the
tree on the new created database (exchangeDB) in the Microsoft SQL Server Management
Studio tool down to Security/Schemas. Right-click on Schemas and choose New Schema
from the context menu.

In the New schema dialog just give a name to the schema you want to create (e.g.
srv_exchange) and click the Browse button to select the schema owner. Select the schema
owner to be the previous user you have specified in step 4 (srv_exchange). Click OK.

B Schema - New =[O -
Raicclia/page ; Script - Lj Help
24 General
24 Permissions
A Extended Properties & schema containg database objects, such as tables, views, and stored procedures. & schema owner
- cah be a database uzer, a database rale, or application rale.
Schema name:
| siv_exchange |
Schema owner
| zrv_exchange | | Search... |
Connection
Server
VODBZ
Connection:
FODEMO2\adminiztrator
&7 Wiew connection properties
Progress
Ready
| Ok | | Cancel |

8. Furthermore you will need to assign the new created schema to your new database user.
The new database user (srv_exchange) was automatically created when creating the new
login and mapping a user to the exchangeDB database.

To locate this new user, expand the tree of the exchangeDB database in the MS SQL Server
Management Studio tool down to Security/Users.

By clicking on the Users node you will see the user called srv_exchange on the right pane of
the tool. Double-click on it to open its Properties window.

A new dialog opens on the General tab. Click the browse button next to the Default Schema
text box and select the previously created user “srv_exchange”.



L1l Database User - exchange I;li-

Selecapage ;S Script - u Help
Ej' Owrned Schemasz

12 Membership User type:

(& Securables SOL uger with login

%A Extended Properties

|dzer narme:

| siv_exchange |

Login name;

| srv_exchange |

Diefault schema:

| arv_exchange |

9. Switch to Owned Schemas node where you will see that the one called srv_exchange is
selected. Make sure that the db_owner is selected too.

Now switch to the Membership node and make sure that db_owner is selected here, too.
Save the changes you have made by clicking OK.

L Database User - exchange = | = -

Select a page ; . "
Script - Hel
A General ;S v Lj v
%A Dwned Schemas
B Membership D atabase role membership:

Ej' Securables Role Members
5 Extended Properties 1

b_acceszadmin

db_backupoperator
db_datareader
db_datawriter
db_ddladmin
db_denydatareader
db_denydatawriter
db_owner

OROO0000C

db_securitpadmin

Metalogix makes every effort to perform comprehensive testing but cannot guarantee, due to environmental
differences, that all functions will work in every environment. It is always recommended that testing be
conducted within your own environment to confirm functionality and compatibility.

Organizational Forms Library troubleshooting

Sometimes the Organizational Forms Library may not be accessible in Outlook after Archive
Manager for exchange installation. This error may occur if there are too many mailboxes with full
access permission for the given user and as a result, Public Folders become inaccessible. To
address this error, use the following workaround:

1. Close Outlook.
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In the Exchange server, open Exchange Management Shell.

Run the following command where #USERALIAS is alias for given user and #USEREMAIL is the
email address of the given user:

Get-Mailbox -ResultSize unlimited -Filter { (RecipientTypeDetails -eq
'UserMailbox') -and (Alias -ne '#USERALIAS')} | Remove-MailboxPermission
-User #USEREMAIL -AccessRights fullaccess -InheritanceType all

Open Outlook with the profile of the superuser. Now Organizational Forms Library should be
accessible.

(Optional) Open Exchange Management Shell and run the following command to give full
access permissions to all mailboxes to the superuser

Get-Mailbox -ResultSize unlimited -Filter { (RecipientTypeDetails -eq
'UserMailbox') -and (Alias -ne '#USERALIAS')} | Add-MailboxPermission -
User #USEREMAIL -AccessRights fullaccess -InheritanceType all

License Activation

Online activation

1.

In the Activate License window, enter the license key.
Q‘h Enter license key and select the activation method

License key:
I | | | |

Activation mode:

(@) Online activation {requires online internet connection)

() Offline activation

Set proxy ...

| cbeck [ mews | [ s ]

If you want to activate the license online, select Online Activation, and then click Next.

1 | NOTE: If your computer is behind a firewall, click the Set Proxy link. The Proxy Setup
dialog appears.

Enable proxy

Server name: | Port: D

User name: | |

Password: | |

o
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1. Select Enable Proxy.

2. Inthe Server Name field, enter the name of your proxy server.

3. Inthe Port Number field, enter the port number of the proxy server.

4. Specify the credentials of the user who is authorized to access the proxy server.

5. Click Set to preserve the information, or click Close to return to the License Key
Information dialog.

3. Ifthe license key is validated successfully, the confirmation message appears along with the
license details. Click Finish to close the dialog.

Offline activation

Offline activation is available for customers who want to review the information sent to
Metalogix. You will require an internet connection for this option as well.

1. Inthe Activate License window, enter the license key.

2. select Offline Activation. The License Key Information window displays additional steps that
are required.

3. Step 1: Collect the activation data to the clipboard or to afile

a. Select from the two options described below:

e Ao
@2 Generate Activation Request

To activate your product in offline mode, copy the Activation Request
text or save it to a file, then visit the Metalogix web site and follow the
instructions there to generate the Activation Response. After you got
the Activation Response, dick ™ext”,

Activation Request: Save to file...

+xkovpQyWEZT IUONkuISZHSPHILN 36FwWEX WS 2Gs BYXUESyXsrSY
QMW zm FKDMMNC bzmaP T quabahx +mhxe

+XRcIhToPWzIhEpw iUGekO83fZQvPI400Pe 3VubIPFTankK ttmjhiM 1
4aASvBomGZNS +ZVi2ESxKDe

Activation LIRL:
https:/ [ support.quest.com/offline-activation Go...

=T =

Option 1: Copy Activation Data to Clipboard. The activation data is saved to memory. Use
this option if you plan to follow through with the subsequent steps immediately.

Option 2: Click Save to File. The Windows File dialog appears. Specify a file name for the
activation data file and click Save to save the file to a location of your choice. Use this
option if you plan to activate the license at a later date.

4. Step 2: Submit collected data

a. Click Go. The Metalogix License Activation web page appears.
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b. Follow the instructions to get the Activation Key file (with the file extension DAT) is made
available for download. Save this file to a location of your choice.

5. Step 3: Paste Activation Response

Activate License Key B

% Enter your Activation Response

To activate your product offine mode, paste the Activation Response
or load it from file saved on the Activation web page. If you do not
have the Activation Response go to previous wizard page and follow
the instructions there, Once entered the Activation Response, dick

Mext”

Activation Response: Load from file...
p2Ev
+b 3NYOKpoyX 5528y 961 SABEIXNCGLEgVhAX TMuiH 2WIBpBK 1AtElzE
vHpJIVV 4fxmizEZ /D 24FDsZMdA

+1kyhlzNaBfyw X tarUwn 3¥ FOdAFMEEx Y SsUvDwClUvnG IuMOHQsT
GddkqT +okvgiGX 4 ccThDGP 4 The DowMSNY AN Tw 3f

< Back || MNext = | | Close

a. Click Load from File. The Windows file dialog appears.

b. Locate the activation key file and click Open. The text appears in the Activation Key File
field.

6. Step 4: Activate offline
a. Click Next to complete the activation process.

7. If the license key is validated successfully, the confirmation message appears along with the
license details. Click Finish to close the dialog.
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About Us

Quest creates software solutions that make the benefits of new technology real in an
increasingly complex IT landscape. From database and systems management, to Active Directory
and Office 365 management, and cyber security resilience, Quest helps customers solve their
next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune
500 count on Quest to deliver proactive management and monitoring for the next enterprise
initiative, find the next solution for complex Microsoft challenges and stay ahead of the next
threat. Quest Software. Where next meets now. For more information, visit www.quest.com.

Contacting Quest

For sales or otherinquiries, visit www.quest.com/contact.

Technical Support Resources

Technical support is available to Quest customers with a valid maintenance contract and
customers who have trial versions. You can access the Quest Support Portal at
https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal enables you to:

e Submit and manage a Service Request
e View Knowledge Base articles
e Sign up for product notifications

Download software and technical documentation

View how-to-videos

e Engage in community discussions

Chat with support engineers online

e View services to assist you with your product
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